Sequence Generator Pro
# Table of contents

About Sequence Generator Pro .......................................................... 5
Getting Started ...................................................................................... 6
  Monochrome CCD Cameras ................................................................. 6
  One Shot Color (OSC) and DSLR Cameras .......................................... 20
Control Panel/Equipment ................................................................. 32
  Supported Equipment ........................................................................ 34
  Cameras ......................................................................................... 34
    SBIG Guider CCDs ........................................................................ 42
Filter Wheels ....................................................................................... 43
  Manual Filter Wheel ......................................................................... 47
Focusers ............................................................................................... 47
Auto Guiders ....................................................................................... 50
Plate Solvers ....................................................................................... 52
  Setting Up Elbrus ............................................................................ 54
  Setting up Pinpoint ......................................................................... 55
  Setting up PlateSolve2 ...................................................................... 56
Telescopes / Mounts ........................................................................... 57
  Using EQMOD with SGPro .............................................................. 61
Other Equipment .................................................................................. 65
  Flat Boxes ..................................................................................... 65
    Manual Flat Box .......................................................................... 68
  Rotators .......................................................................................... 68
    Manual Rotator ........................................................................... 70
  Observatories .................................................................................. 70
    Slave Settings ............................................................................... 72
  Safety Monitor ................................................................................ 73
  Environment Devices ....................................................................... 75
Sequencing ............................................................................................ 76
  Description ...................................................................................... 77
  Sequence Options ........................................................................... 78
  Target List and Settings ................................................................... 79
  How the Sequence Selects Work ...................................................... 83
  Target Data / File Naming ............................................................... 85
  Delay and Ordering Options ........................................................... 86
  Sequence Status ............................................................................ 87
  Target Status ................................................................................ 87
  Big Status ..................................................................................... 88
  Events ............................................................................................ 88
  Automatic Camera Rotation ........................................................... 93
  Automatic Target Centering ............................................................ 95
  Automatic Meridian Flip .................................................................. 96
  Starting, Pausing and Aborting ....................................................... 97
  Automatic Frame Restart .................................................................. 98
  Opening and Saving ......................................................................... 99
  Apply Profile to an Existing Sequence ............................................ 100
  Status Area .................................................................................. 100
  Data Stored in the FITS Header ....................................................... 101
Sequence Images ................................. 103
Sequence Recovery .................................... 103
Resetting the Sequence, Targets and Events ...................... 104
Profiles .............................................. 106
  Description ..................................... 107
  Understanding Profiles / FAQ ....................... 108
  Equipment Profile Manager ......................... 109
  New Sequence from Profile ......................... 111
  Apply a Profile to an Existing Sequence .......... 112
  Save Sequence as Profile .......................... 113
  User Profile Manager ............................. 114
Focusing .......................................... 115
  Frame and Focus .................................. 116
    Using Subframes ................................. 117
  Setting Focus and Target Positions ................ 117
  Manual Focusing Reminders ....................... 118
  Auto Focus ...................................... 119
    Understanding Auto Focus ....................... 124
  Auto Adjust Focus Per Filter ..................... 133
  Temperature Compensation ....................... 134
  Limiting Range .................................. 135
Framing ........................................... 135
  Frame and Focus with Nudge ....................... 136
  Auto Center .................................... 136
  Center Here .................................... 141
  Using Goto Target ............................... 143
Images ............................................ 143
  Opening and Moving ............................. 143
  Menu Bar ....................................... 146
  Image Browsing .................................. 146
  Marking an Image Bad ............................ 147
  Calculating HFR ................................ 147
  Inverting ...................................... 149
  Crosshairs ..................................... 150
  Viewing FITS Headers ............................ 151
  Saving Temporary Images ......................... 151
  Zooming and Panning ............................ 152
  Rotating ....................................... 153
  Stretching ...................................... 153
  Plate Solving .................................. 154
  Center Here Action .............................. 156
  Slew Here Action ............................... 156
Modules .......................................... 157
  Camera Temperature Control (TEC) .................. 158
  Environment Data ................................ 158
  Filter Wheel .................................... 159
  Flat Box ....................................... 159
  Focus Control .................................. 159
  Target Markers .................................. 160
  Frame and Focus ................................. 160
Troubleshooting ................................................................. 206
Environment Options ................................................................ 162
Image Statistics ....................................................................... 162
Observatory ............................................................................. 164
Pan and Zoom ......................................................................... 164
PHD2 Graph ............................................................................ 164
Sequence ................................................................................ 166
Scope Centering ...................................................................... 166
Telescope ................................................................................ 166
View Options ........................................................................... 167
Image History .......................................................................... 167
Helpers / Wizards ................................................................. 168
Flats Calibration Wizard .......................................................... 168
Flats Wizard ............................................................................ 171
Image Grader .......................................................................... 172
Temperature Compensation Trainer ........................................ 175
Meridian Flips ......................................................................... 175
Framing and Mosaic Wizard ..................................................... 176
Target Imports ......................................................................... 182
Image History .......................................................................... 185
Notification System ............................................................... 187
SGPro 2.5 Sequence Migration .................................................. 191
Environment Options ............................................................ 192
General Options ....................................................................... 193
Sequence Settings .................................................................... 194
Other Equipment Options ....................................................... 195
Keyboard Shortcuts .................................................................. 196
License Management .............................................................. 197
Management ............................................................................ 197
Trouble Registering SGPro ..................................................... 200
API Documentation ................................................................... 201
JSON Example ......................................................................... 204
Troubleshooting ..................................................................... 206
SGPro Won't Start .................................................................... 206
About Sequence Generator Pro

Our goal is to provide a best-in-class image capture suite for astrophotography. Over the years we have been frustrated by a distinct lack of key features that make life easier under stars. You have a lot of equipment and sometimes it is difficult to get it all working together. We have written software that is capable of executing complex sequences of capture events which will allow you to spend more time looking up and less time fighting with your rig.

We also feel strongly about providing software at down to earth prices. Let's face it, astrophotography is expensive! You should be able to focus on the purchase of equipment without worrying about investing a fortune in software to control it.

With Sequence Generator Pro you can:

- Use and save complex sequencing events (lights, darks, bias flats, filter wheels, binning, etc)
- Create and save equipment profiles to make generation of sequences fast and easy
- Create complex sequences for multiple targets in the same sequence
- Automatically move between targets
- Automate running auto focus routines according to user defined triggers (keeps you in focus as ambient temperature drops)
- Define sequence pause triggers for manual focus (time, intervals, etc)
- Dither between frames with your choice of three auto guiders (PHD, Astroart and MetaGuide)
- Center your ASCOM compliant telescope on any reference frame you can plate solve (even images from the Internet!)
- Center on your own images… makes framing for meridian flips and multi-night imaging sessions a snap!
- Center your ASCOM compliant telescope on any area of the image with a single click of a mouse!
- Easily perform frame and focus routines (with support for subframes high speed cameras)
- Feel at home with our highly customizable user interface (drag, dock and float small modules for almost any function)
- Over a dozen configurable UI modules (PHD graphing, Image Pan and Zoom, TEC control and more)
- User defined TEC cool down and warm up routines (to minimize thermal stress on your camera's sensitive components)
- Between frame temperature compensation (and integrated trainer)
- Easily create a “flats” sequences from your “lights” sequence
- Automatically calibrate your flats exposure lengths per filter
- Perform an automated meridian flip
- Detailed documentation and instructional videos
- Near immediate customer support via email or the Yahoo! group
- Hundreds of other features!

Philosophy

When developing Sequence Generator Pro we adhered to a certain philosophy in order to keep a consistent "feel" and maximize usability.

- During sequence execution you should be able to adjust almost all parameters in real time.
- You should be able to create sequences "off-line". That is to say, you should not need to connect gear in order to create sequences for later use. This is sometimes difficult to execute... For ASCOM based
Getting Started

Monochrome CCD Cameras

Getting Started with Sequence Generator Pro and a Monochrome CCD Camera

Sequence Generator Pro is an extremely powerful image capture suite. It can perform many complex tasks in order to meet your imaging needs. That said, SGPro is also extremely intuitive and easy to use for beginners. In short, SGPro can be as powerful as you want it to be.

This tutorial will cover the basics to start up, create a sequence and run it. We assume that you will be using only a monochrome CCD camera and filter wheel. In addition, we cover some important in-sequence topics like dithering and histogram stretching. While we recommend using other equipment to automate your imaging sessions, we will reserve those tutorials for later.

In order to run through this tutorial in the comfort of your home, we will be using the ASCOM camera and color filter wheel simulators. These are installed when you install ASCOM. When connecting your own gear, you will need to ensure that all required ASCOM drivers are installed prior to starting SGPro.

If you are not familiar with ASCOM, it is an acronym for “Astronomy Common Object Model” and, with it, we are able to provide support for a broad spectrum of gear in a very short period of time. It’s not critical that you understand the details of ASCOM, just that you are able to install it and that you can find ASCOM drivers (like any other driver) for your specific gear (QSI, FLI and SBIG being the exception to this rule).

Let’s get started...

**Step 1:**

*Installing prerequisites:* Sequence Generator Pro is dependent on:

- ASCOM 6 or better. If you have not done so already please install ASCOM ([http://ascom-standards.org/Downloads/Index.htm](http://ascom-standards.org/Downloads/Index.htm))
- While SGPro is not technically dependent on an auto guider, you will almost certainly use one. PHD2 is a free, open source, and community supported auto-guider: [http://openphdguiding.org/](http://openphdguiding.org/)

**Step 2:**

*Open Sequence Generator Pro:* When you start, you will see a large window that contains several configurable modules on the left hand side. We will not discuss all of these modules in this tutorial, but will cover some that are essential to the image capture process. In the middle of the main window, you will see the “Sequencer” (pictured below). It is here that you will do most of the work when defining a sequence. The sequence window can be closed without fear of losing any of your sequence data.
When you close it, you can think of it more as “hiding”. If you close it and need to find it again you can either click the sequencer icon (to the right of the save icon) or hit Ctrl+W.

*Step 3:*

**Understanding the user interface:** Before we dive into things, we should take a moment to discuss the SGPPro interface. The “main” window is where we display “modules” and image data. Modules are small windows that allow you to perform some type of common action. Examples of modules are the histogram module, image pan and zoom module and the frame and focus module. When you start SGPPro for the first time, these modules will be docked to the left side of the screen. You can re-arrange modules to appear in any order you want (they can also be floating). To move a module, simply drag on its title bar and you will see positional arrows appear that will allow for placement above or under other modules. Modules can be docked on either the left or right side of SGPPro. Lastly, you can “nest” modules with each other (on top of each other). This will help save some space and is a good option for modules you don’t use as much. To do this, drag a module and drop it on top of another existing module.

Your images will occupy the majority of the screen. Initially, when they appear, they will occupy the all remaining area on the screen (not occupied by modules). Performing actions that result in multiple images being open simultaneously will create a series of tabs across the top of the images (one for each image). By default, images taken with a camera will replace each other in the same image window. As with modules, you can float windows, nest them or place them side-by-side for comparison.

This is what docking a module to the left or right side looks like... The module will turn into a grey rectangle, just drop it onto the icon and it will snap into place:
This is what rearranging a module looks like... To place this module above Frame and Focus, drop it on the "up icon", to place it below, drop it on the "down icon". Lastly, to "nest" it with Frame and Focus", drop it on the middle "tab" icon.

**Step 4:**

*Connecting your gear:* Before we start we need to select and connect to the ASCOM simulators...

To use these devices, you will need to select them from the upper right hand corner of the sequencer. Go ahead and select the simulators and attempt to connect (using the red connect button).

![Sequence Generator Pro](image)

Choose these drivers:

- "Camera V2 Simulator" for the camera
- "Filter Wheel Simulator [.NET]" for the filter wheel

Note: While we are using simulators, you can check now if your gear shows up on these drop down lists. If your gear does not appear here, you will need to install the appropriate ASCOM drivers and then restart SGPro.
Now that you know how to connect gear, you need to specify the filter configuration for the color filter wheel (CFW). SGPro has only two ways of understanding the placement of filters in the carousel wheel. First you can use SGPro to specify this information or... if your CFW ASCOM driver supports it (and you have used your ASCOM driver to set this up before using SGPro), you can import filter data directly from the driver. When you select an ASCOM filter wheel and have no filters defined, you will be asked if you would like to attempt a filter import. Feel free to select “Yes” if you are set-up for this. If you are not set up for this or you don’t know what this means, simply select “No” and follow the procedure below.

When you select the filter wheel, you will be prompted with this message:

If you select “Yes”, SGPro will import the filter information that is stored in the ASCOM driver. Specifically this (can be accessed by going to the simulator's settings):

If you select “No” (which you should probably do for this tutorial), you will need to add your filters
Sequence Generator Pro

manually (one time). In order to do this, open the Control Panel (Camera Icon or Ctrl+E) and navigate the "Filters" tab. Once here, click the "Define Filter List" button. The dialog presented contains entry rows for up to 12 filters. To add a filter, click the "Use?" checkbox and then enter name of the filter. There is a drop list of common filter names, but you can enter any name you would like (common names like R, RED and LUM are recommended since many astro-application can interpret this information and make your life easier). For this tutorial, go ahead and set up four filters… LUM, RED, GREEN and BLUE. Finally click OK. You will be presented with a warning that all event filters will be reset… we haven’t set any events so just click “Yes” to proceed.

Step 5:

Creating the sequence: When a new sequence is created (a new one was automatically created when you opened SGPro), it will contain a default target in the upper left hand corner named “Target Set 1”. It is named “Target Set”, because it contains a “set” of events to execute (more on this in a moment). Most people will rename this to something more intuitive like “M42”. To modify properties for your target, simply right click on it and select “Target Properties”. There are many fields on this dialog but they are representative of more advanced topics. For this tutorial we will focus only on the “Name” field. Go ahead and enter the name of the target you would like to capture and click “OK” (any name is OK here). You will see now that the target name (in the sequencer’s target list) has been updated to reflect the name of the target you chose.

Click the gear icon next to "Target Set 1" to open the settings dialog:

Target Settings:
So now you have a target... you're not ready to go yet. First we need to decide on and create events and frames for each target (in this case, just one). Occupying the entire bottom area of the sequencer you will find the event table. This is where you will apply all of the minutia that defines your sequence. For example, lets say, using LRGB filters, you want to capture 3 hours of LUM and 1.5 hours of each color. In addition, you would like to limit the exposure time of individual exposures to 10 minutes each. By default SGPro provides five empty events. You can add more by using the button in the lower left hand corner. In addition, SGPro will only execute events that have the "Run" option checked.

So... to get what we want here, go to event 1 (Run will already be checked). In the “Type” column, keep the event type as “Light”. In the “Filter” column select the entry for your “Lum” filter. The “Suffix” field can be anything you want (including blank). When you select a filter, the suffix will auto update to the filter's name, but you can override this if desired. The suffix simply allows you to optionally provide some text that you would like to appear in file names for all images created by this event (described below). Next, set the “Exposure” time. You can use the drop down for a set of common intervals or you can enter the value in by hand. If you enter just a number by itself, this will be interpreted as seconds. The values 5, 600, and 0.01 all represent exposure times in seconds. Alternatively, you can use “m” after any number to force SGPro to interpret your entry as minutes. The value 10m is simply 10 minutes or 600 seconds. Go ahead and enter 10m or 600 here (for this simulation go ahead and substitute seconds for minutes... enter 10s instead of 10m or you will be watching the simulators do nothing all night). Next, choose your “Binning”. SGPro, for most cameras, supports binning from 1x1 to 4x4 and values in-between. For our LUM event, go ahead and keep 1x1 selected. Lastly, fill in the value for repeat. We are after 3 hours of LUM data so we will enter 18 here. That's the gist of creating an event (this one has 18 frames). Go ahead and create three more events, one for each color filter (specify 2x2 binning to get a feel for that). Don't forget to check the “Run” column or these events will be ignored! When you are done you should have four active events (one for each of the LRGB sequence).

Here is what your event table should look like:

![Event Table Screenshot]
A few notes about the event table:

- You can move events by using the up and down arrows on the far left.
- You can delete an event by clicking the “X” icon on the far left.
- You can uncheck the “Run” option to prevent further execution of the event.

**Step 6:**

*Specifying the location of your images:* Now that your camera and color filter wheel (CFW) are connected, we will specify where and how to save your captured image files. To do so, we will set a few parameters in the upper middle area of the sequencer (the section labeled “Target Data”). First, locate the “Directory” field and then click “Browse”. This will allow you to select the base directory for all images taken by SGPro. Now you may be saying to yourself “That’s silly... I don’t want to save all of my SGPro images to the same directory”. You’re right. We don’t want to do that either. Because of this we have introduced a very powerful file naming system. In the “File Name” field directly below “Directory”, you can specify a custom file naming pattern using quite a few options. For instance, if you want your file names to be named using the target name (the one you specified above), then the type (light, dark, etc...), then the binning, then the exposure length, then its frame (series) number, you would enter “%tn_%ft_%bi_%el_%fn” into the “File Name” field. Pretty easy... But what about the single directory issue, you mentioned above? This is also pretty easy... most folks simply modify their existing patterns by prepending “%tn\” to it. This will create a sub-directory under the base directory named after the target.

As an example, suppose you named your target “M42”. The full entry in the “File Name” field is: “%tn\%tn\_ft\_%bi\_%el\_%fn”. Using the LUM event as the basis for this example, the first frame will produce a file named “M42_Light_1x1_600sec_frame1.fit”. Where will it be created? Let’s assume directory you chose is “C:\AstroImages\” (in the directory field). In this case, because you specified “%tn\” as a prefix to your file name, the full path to your new images will be “C:\AstroImages\M42\”. You can also use this method to separate images by type. Instead, if you used “%tn\%ft\%tn\_ft\_%bi\_%el\_%fn”, the path to your “Light” images would be “C:\AstroImages\M42\Light\”.

In SGPro, the example described above, would look like this:

Clicking the “magnifying glass” preview icon, you can see an example of how your data will be saved (using event 1):
Of course, you can create sub-directories using any of the provided pattern tokens. If you forget what options are available to you, just click the “Key” button next to the “File Name” field.

**Note:** To avoid setting these values every time you create a new sequence, you can set them in the Options dialog and they will be auto-populated for new sequences (Tools->Options menu item).

**Step 7:**

**Setting up the auto guider:** SGPro currently supports three different autoguiders (PHD2, AstroArt and MetaGuide). As of now, SGPro does not have its own auto guider so when we say “supports” we mean that we are able to request that the external autoguider perform a dither operation between frames. Dithering is an important part of astrophotography and can help to remove unwanted artifacts when your sub-frames are stacked to form a master frame.

For the purposes of this tutorial, we will be using a special, non-functional auto guider called “Practice Guider”. Please remember not to use this guider outside of simulations like this one… its only purpose in life is to help you learn how to setup and run an autoguider up while indoors (PHD2 is not able to do this very well).

**Note:** Most folks using SGPro use PHD2 so, despite using the “Practice Guider”, we will discuss guiding like we are actually using PHD2.

To set your auto guider, open the Control Panel again and navigate to the “Auto Guide” tab. Use the Guiding Interface drop down to select “Practice Guider” (note that using this when not practicing, this is where you will pick your actual auto guider). Check the “Dither” option and then choose the dither amount. We use “PHD2 speak” for these terms, but in general, use “Very High Dither” or “Extreme Dither” for shorter focal lengths and the smaller dither options as you increase focal length. Finally you need to define the settling options. Settling options allow for the mount to settle after some kind of
Typically this disturbance is invoked by SGPro in the form of a dither. This means that if PHD2 is not reporting that both RA and DEC values are below the settling value for a particular amount of time, SGPro will temporarily pause the sequence until guiding has recovered. The settling value is a whole number that defines the maximum allowable deviation (in pixels) from the center of your guide star. Short focal length scopes can generally get away with settle values of a half-pixel or more. Longer focal length scopes will sometimes require more precise guiding and use settle values of 0.2 pixels or lower. The “Practice Guider” will always return a value of 0 for distance from center so you will not get to see any real deviation while going through this tutorial.

At this point, go ahead and save your sequence. Sequence files in SGPro are saved as “.sgf” files. Click the “disk” icon in the upper left or go to “File->Save Sequence”.

**Note:** Dithering will not work in PHD2 unless you enable the PHD2 server. To do this, open PHD2, go to the “Tools” menu and check “Enable Server”.

**Note:** SGpro contains a PHD2 module that will allow you to view the quality of your guiding without switching applications. To open the PHD2 module simply click the PHD2 icon. Furthermore, you can customize the color or scale of the graph to your taste. To adjust the colors, simply left click on the RA or DEC labels. To adjust the scale (zoom) simply right click on the graph. This module requires you to enable PHD2 logging or it will not function. To do so, open PHD2, go to the “Tools” menu and check “Enable Logging”.

### Step 8:

**Setting the camera’s temperature:** Most monochrome CCD cameras allow for controllable temperatures. You will obviously want to set your camera’s temperature to the desired value before you start capturing. Failure to do so will introduce large amounts of thermal noise and make your images very difficult to process. The easiest way to do this is to open the “TEC Module” by clicking the thermometer icon. This will open a small window named “Temperature”. In it, you can turn your camera’s cooler on or off and easily set the temperature. Go ahead and do this for the simulator camera now. Click the “On” option to turn the cooler on and then enter the temperature you want to set. For instance, if you want to set the cooler to -10C, enter “-10” and click “Set”. There is a field next to the “Set to” field that will allow you to set the temperature of the CCD over time. Using this feature can help to reduce thermal shock to your camera’s sensitive parts. If you want to set your camera’s temperature to -10 C over a 5 minute period, simply change the “0m” to “5m” and click “Set”.

This is what the camera temperature module looks like:

![Camera Temperature Module](image)

**Note:** You can have SGPro automatically cool and warm your camera for you. This is not discussed as part of this tutorial, but, if you are interested, more info can be found here.

### Step 9:

**Focusing your images:** This tutorial does not use a motorized focuser, and, as such, we cannot walk through how SGPro accomplishes “on-target” auto focus (it’s actually quite easy and very powerful). Instead we will focus on two different methods that are available with a normal manual focuser. Both methods depend on use of the “Frame and Focus” module (click the gold star icon to open
Method 1: This method will use a Bahtinov mask and a nearby (to your target) bright star. The object here is to obtain a uniform diffraction pattern (more on this here: http://en.wikipedia.org/wiki/Bahtinov_mask). While not unheard of, it is unlikely that your target will contain a star bright enough to produce this pattern in a reasonable amount of time (a few seconds). This means that you will have to perform off-target focus (moving the mount back and forth between the target and a bright star every time you want to focus). When performing initial focus, you will be using the “Frame and Focus” module. This can be opened by clicking the “Gold Star” icon. This will allow you to place the camera into state where it continually captures images for display purposes only. None of these images are saved to the disk. So... to get started, place the Bahtinov mask over the aperture of your scope (or pretend to since we are simulating... you get the point). Next, specify binning for these frames. In general, for frame and focus with a Bahtinov mask, you should specify the highest binning available (in most cases, this will be 4x4). This will help with both download times and sensitivity. For this simulation, leave binning at 1x1 because the simulator image is quite small already. Asking the simulator for a 4x4 image will work, but the image will be very tiny. Next, specify the exposure time... for this, a value between 1 and 5 seconds should be appropriate (depending on brightness of the star and binning). Finally, open the Histogram module (Colored Bars icon) and ensure that “Auto Stretch” is checked. If you don’t do this, all of your images will just appear as empty black squares. That’s it! Click “Start” and the camera will begin taking a continuous stream of images you can use to adjust your focuser. When you have achieved proper focus, click “Stop”.

Method 2: This method will use the built-in “Image History” module. This is arguably simpler, but may be a bit less precise depending on the star field you choose (typically the same as the target). The primary advantage of this method is that you don’t need to move off your target to focus (huge time saver). To use this method, click the “Graph” icon to open the “Image History” module. Optionally, go to “Tools->Image History” to open a larger and more detailed representation of the module. Once this is done, start Frame and Focus (same as method 1). This time, in the Image History module, you will need to ensure that the “Enable image history” option is checked. Once enabled, the image history graphs will begin to plot “whole image half-flux radius (HFR)” (a focus metric) and star counts. A binning of 2x2 will normally work best here. Now adjust your focuser to get the lowest possible HFR value. Before you start paying attention to any numbers, make sure to obtain a rough focus (seeing any semblance of stars should be sufficient). The objective here is to spot a “V” pattern on the graph. The closer you move to focus, the lower your HFR value will be. As you move the focuser toward focus, the HFR value will decrease and then, at some point, start to increase. This is an indication that you have passed focus and should go back one increment. When you are done, click “Stop”.

![Image History Module](image.png)
Note: Before starting frame and focus, ensure that you open the “Histograms” module and check the “Auto Stretch” option. If you don't do this, all of your images will just appear as empty black squares. See the image below...

![Histograms Module](image)

**Step 10:**

**Framing your target:** Pointing the scope in the exact center of your (intended) target can be a daunting task. In this tutorial, we did not connect an ASCOM compatible mount so our framing options are quite limited. Though it is beyond the scope of this tutorial, SGPro offers several, easy-to-use, automatic centering options that can get you within a few pixels of your target in under two minutes. Definitely worth checking out, but we want to stick to basics here...

In this example, we might use a spotting scope, finder or external planetary program to slew the mount near our target. Unless your mount's alignment (sync), polar alignment and gears are perfect, you will likely not be pointing where you want. To correct this, you will use the “Frame and Focus” module (as described in the “Focusing” section) to start streaming a series of temporary images. A binning of 4x4 is best for the framing process. Exposure time will vary depending on target brightness. To complete framing, click “Start” on frame and focus and then, using the hand controller for your mount, slowly move the telescope to the desired position and you're done. You may also be required to rotate the orientation of the camera (most CCD chips are not square). When you are done, click “Stop” on frame and focus.

Note: This process is pretty simple if you are imaging at short focal lengths, but grows increasingly more difficult as your focal length increases. At long focal lengths you will almost certainly need to move to more advanced framing methods.

Note: Before starting the framing process, ensure that you open the “Histograms” module and check the “Auto Stretch” option. If you don't do this, all of your images will just appear as empty black squares.

**Step 11:**

**Running the sequence:** OK… we've done a lot and it's time to review. So far we have found and connected the camera and filter wheel to SGPro, defined our filter list, created a target, defined events for that target, specified where and how to save images, set up your auto guider, learned a few methods for manual focus and finally and learned how to manually frame your target. That's a lot of stuff and, at the end of this tutorial, we will talk briefly about how to minimize the setup time for future sequences.
Next up, we need to consider the order of the sequence. On the sequencer window, below the equipment area, you will find several options that dictate the order in which the events you defined will be executed. For this tutorial, we will focus only on the “Finish event first” and “Rotate” options. When taking images with multiple filters, most imagers prefer to finish entire events first because it reduces the amount of time you need to wait for filter wheel changes. In our example, choosing this option will result in the capture of all LUM frames first (event 1), then each of the color filters will be captured as discrete events (events 2-4). A rotating capture is exactly what it seems. SGPro will capture one LUM frame (from event 1) and then move onto the next color filter (next event) and then onto the next and so on... This is a good option if you would like to get an even distribution of data over a given period of time.

For this tutorial, yours should look like this:

Lastly, you will be responsible for starting PHD2 guiding before you start the sequence. This means you need to connect your gear to PHD2, calibrate and start guiding while you are pointed at your target (obviously not necessary with the “Practice Guider”).

We’re ready! Don’t forget to save your sequence (sequences are saved as “.sgf” files). Click the big “Run Sequence” button in the lower right hand corner.

Step 12:

Checking your images: So now you are cranking out images and life is good. Many folks like to inspect their handiwork as the sequence progresses. First off, ensure that, using the “Histogram” module, you have the auto-stretch option checked so that you can actually see details in your images. You have several options for inspecting images...

In the currently displayed image you can zoom or pan to any location on the image. To zoom, right click on the image and then select the zoom factor. By default all images will be resized (for display purposes only) to fit in the image display area. You may want to zoom to 100% in order to check out the quality of your stars. Other ways to zoom an image include the “magnifying glass icons” on the image toolbar (located directly above each image) and the zoom drop down box to the right of the image toolbar buttons. Finally, you can use the “Pan and Zoom” module. On this module you will find a zoom slider that will let you adjust zoom up to 400%.

Here is a portion of the context menu (right click):
When an image is larger than the display area you can easily move to other areas of the image by dragging on the image and “pushing” it in the desired direction. Alternatively, you can use the “Pan and Zoom” module to drag the small red box to the area of interest. The main image display area will now be representative of this part of the image. Here is what the Pan and Zoom module looks like for images that are larger than the display area:

Lastly, SGPro, will by default, replace the current camera image window data with the latest data from the camera. This means that if you are taking 10 frames as part of an event and you are on event 9, only frame 8 will be shown. All other frames are on disk, but not displayed. If you haven’t been out to check on your images for a while you may be interested in inspecting images that are no longer displayed. To help alleviate the user from having to go open older images through a file selection dialog, we use an “image browser”. The browser uses forward and back arrows just like an Internet browser. If you have frame 8 shown and want to see frame 6, simply click the back arrow twice. Alternatively, you can right-click on either the back or forward arrows and get a menu that shows the last 25 images.

**Step 13:**

*Pausing and aborting:* During the course of the sequence you may have need to pause or abort the sequence. There are any number of reasons to do this…you’re done for the night, clouds roll in, pausing for emergency focus, hurricane, etc.

To pause the sequence, you simply click the same button you used to start it (located in the lower right hand corner). When the sequence is running, this button actually changes to read “Pause Sequence”. When you click it, you will be presented with another small dialog that allows you to choose how you want to pause the sequence. You can pause after the current frame is completed and downloaded or you can choose to abort immediately. If you choose to abort immediately, SGPro will not download data from the camera (it will be lost).

Here, you can see that the "Run Sequence" button has changed into a "Pause Sequence" button:
**Final thoughts:** This tutorial does not cover many of the most powerful aspects of SGPro. It is intended as a primer to get you up and going quickly with just the basics. Below are some notes and thoughts that will help you figure out where to go from here (when you are comfortable moving on):

**Save as profile:** You just spent a lot of time setting your gear up and tweaking settings. Almost any setting you make in a sequence can be saved to any number of **custom equipment profiles**. Once you have a profile, you can create new sequences using them and all of your settings will be applied and ready to go with the click of a few buttons. All you need to do at this point is define your events and you'll be ready to go. More details on profiles can be found [here](#).

**Focusing reminders:** This tutorial discusses a couple of options for manual focusing. If you are interested in pausing the sequence based on user defined triggers like time, temperature, frame count, etc, you can find more [here](#). Once this is set, and a trigger is hit, SGPro will automatically pause the sequence and inform you that it's time to focus. When you are done, simply resume the sequence.

**Playing around:** Almost all equipment types have simulators. Hook them up and play around! You can try to use almost any feature in SGPro just with simulators (Auto meridian flips are one exception to this).

**Auto Focus:** SGPro can provide you with ability to stay in focus all night. Temperature and gravity will try to destroy your images, but SGPro, simply by connecting an ASCOM compatible (absolute) focuser will be able to automatically focus based on a number of user defined triggers (time, frames, temperature, etc). More information on this can be found [here](#).

**Easier framing:** In this tutorial we discussed a very manual and time intensive method for framing. One of the most powerful features found in SGPro is the ability to find your target and start imaging in minutes. In order to do this, you must install one of three **plate solvers** (Pinpoint, Elbrus or Astrometry.NET). Once this is done SGPro will interface with your plate solver in order to move the mount, with high accuracy, to your intended target. In addition to this, you can easily recenter on one of your images from a previous night or find an image on astrobin.com or flickr.com that you would like to use for framing your own image. More on this can be found [here](#).

**Step 15:**

**Getting more help:** SGPro contains a fairly extensive help file (this document is also included in there). When in SGPro, you can get to the help file by going to “Help->Help File”. SGPro also offers tooltips on almost every single button and control available. To access these, just ensure that you click on a
control and then hover over it with the mouse. Finally, feel free to post on our Yahoo! group (http://groups.yahoo.com/group/mainsequencesoftware)... we will be happy to see if we can help.

One Shot Color (OSC) and DSLR Cameras

Getting Started with Sequence Generator Pro and a One Shot Color Camera (or DSLR)

Sequence Generator Pro is an extremely powerful image capture suite. It can perform many complex tasks in order to meet your imaging needs. That said, SGPro is also extremely intuitive and easy to use for beginners. In short, SGPro can be as powerful as you want it to be.

This tutorial will cover the basics to start up, create a sequence and run it. We assume that you will be using only a one shot color (OSC) or DSLR camera. In addition, we cover some important in-sequence topics like dithering and histogram stretching. While we recommend using other equipment to automate your imaging sessions, we will reserve those tutorials for later.

In order to run through this tutorial in the comfort of your home, we will be using the ASCOM camera and color filter wheel simulators. These are installed when you install ASCOM. When connecting your own gear, you will need to ensure that all required ASCOM drivers are installed prior to starting SGPro.

If you are not familiar with ASCOM, it is an acronym for “Astronomy Common Object Model” and, with it, we are able to provide support for a broad spectrum of gear in a very short period of time. It's not critical that you understand the details of ASCOM, just that you are able to install it and that you can find ASCOM drivers (like any other driver) for your specific gear (QSI, FLI and SBIG being the exception to this rule).

One note about this tutorial: This is a combined lesson on both One Shot Color (OSC) CCDs and DSLRs. The primary difference between these is that CCDs support "binning" (convincing to camera to consider a larger group as pixels as a single pixel) and DSLRs support ISO (sensitivity) values. We do our best to call these differences out, but you must keep in mind that there is no DSLR simulator. This means that even if you are using a DSLR camera, you will need to use the OSC simulator for this tutorial.

Let's get started...

Step 1:

Installing prerequisites: Sequence Generator Pro is dependent on:

- ASCOM 6 or better. If you have not done so already please install ASCOM (http://ascom-standards.org/Downloads/Index.htm)
- While SGPro is not technically dependent on an auto guider, you will almost certainly use one. PHD2 is a free, open source, and community supported auto-guider: http://openphdguiding.org/

Step 2:

Open Sequence Generator Pro: When you start, you will see a large window that contains several configurable modules on the left hand side. We will not discuss all of these modules in this tutorial, but will cover some that are essential to the image capture process. In the middle of the main window, you will see the “Sequencer” (pictured below). It is here that you will do most of the work when defining a
sequence. The sequence window can be closed without fear of losing any of your sequence data. When you close it, you can think of it more as "hiding". If you close it and need to find it again you can either click the sequencer icon (to the right of the save icon) or hit Ctrl+W.

![Sequence Generator Pro interface](image)

**Step 3:**

**Understanding the user interface:** Before we dive into things, we should take a moment to discuss the SGPro interface. The "main" window is where we display "modules" and image data. Modules are small windows that allow you to perform some type of common action. Examples of modules are the histogram module, image pan and zoom module and the frame and focus module. When you start SGPro for the first time, these modules will be docked to the left side of the screen. You can re-arrange modules to appear in any order you want (they can also be floating). To move a module, simply drag on its title bar and you will see positional arrows appear that will allow for placement above or under other modules. Modules can be docked on either the left or right side of SGPro. Lastly, you can "nest" modules with each other (on top of each other). This will help save some space and is a good option for modules you don't use as much. To do this, drag a module and drop it on top of another existing module.

Your images will occupy the majority of the screen. Initially, when they appear, they will occupy the all remaining area on the screen (not occupied by modules). Performing actions that result in multiple images being open simultaneously will create a series of tabs across the top of the images (one for each image). By default, images taken with a camera will replace each other in the same image window. As with modules, you can float windows, nest them or place them side-by-side for comparison.

This is what docking a module to the left or right side looks like... The module will turn into a grey rectangle, just drop it onto the icon and it will snap into place:
Step 4:

Connecting your gear: Before we start we need to select and connect to the ASCOM simulators...

To use these devices, you will need to select them from the upper right hand corner of the sequencer. Go ahead and select the camera simulator and attempt to connect (using the red connect button).

Note: While we are using simulators, you can check now if your gear shows up on these drop down lists. If your gear does not appear here, you will need to install the appropriate ASCOM drivers and then restart SGPro. If you are using a Canon or Nikon camera, there is no need to install ASCOM drivers.

Step 5:

Creating the sequence: When a new sequence is created (a new one was automatically created when...
you opened SGPro, it will contain a default target in the upper left hand corner named “Target Set 1”. It is named “Target Set”, because it contains a “set” of events to execute (more on this in a moment). Most people will rename this to something more intuitive like “M42”. To modify properties for your target, simply right click on it and select “Target Properties”. There are many fields on this dialog but they are representative of more advanced topics. For this tutorial we will focus only on the “Name” field. Go ahead and enter the name of the target you would like to capture and click “OK” (any name is OK here). You will see now that the target name (in the sequencer’s target list) has been updated to reflect the name of the target you chose.

Click the gear icon next to "Target Set 1" to open the settings dialog:

![Settings Dialog](image)

**Target Settings:**

So now you have a target… you’re not ready to go yet. First we need to decide on and create events and frames for each target (in this case, just one). Occupying the entire bottom area of the sequencer you will find the event table. This is where you will apply all of the minutia that defines your sequence. For example, lets say you want to capture 3 hours of data for your target. In addition, you would like to limit the exposure time of individual exposures to 10 minutes each. By default SGPro provides five empty events. You can add more by using the button in the lower left hand corner. In addition, SGPro will only execute events that have the “Run” option checked.

So… to get what we want here, go to event 1 (Run will already be checked). In the “Type” column, keep the event type as “Light”. In the “Filter” column, leave this a “None”. The “Suffix” field can be anything you want (including blank). The suffix simply allows you to optionally provide some text that you would like to appear in file names for all images created by this event (described below). Next, set the “Exposure” time. You can use the drop down for a set of common intervals or you can enter the value in by hand. If you enter just a number by itself, this will be interpreted as seconds. The values 5, 600,
and 0.01 all represent exposure times in seconds. Alternatively, you can use “m” after any number to force SGPro to interpret your entry as minutes. The value 10m is simply 10 minutes or 600 seconds. Go ahead and enter 10m or 600 here (for this simulation go ahead and substitute seconds for minutes… enter 10s instead of 10m or you will be watching the simulators do nothing all night).

For OSC CCDs:

Next, choose your “Binning”. SGPro, for most cameras, supports binning from 1x1 to 4x4 and values in-between. For our event, go ahead and keep 1x1 selected. Lastly, fill in the value for repeat. We are after 3 hours of data so we will enter 18 here. That’s the gist of creating an event (this one has 18 frames).

Here is what your event table should look like:

<table>
<thead>
<tr>
<th>Event</th>
<th>Run</th>
<th>Type</th>
<th>Filter</th>
<th>Suffix</th>
<th>Exposure</th>
<th>Bin</th>
<th>Repeat</th>
<th>Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>10 s</td>
<td>1x1</td>
<td>18</td>
<td>0/18</td>
</tr>
<tr>
<td>2</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>0.00</td>
<td>1x1</td>
<td>1</td>
<td>0/1</td>
</tr>
<tr>
<td>3</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>0.00</td>
<td>1x1</td>
<td>1</td>
<td>0/1</td>
</tr>
<tr>
<td>4</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>0.00</td>
<td>1x1</td>
<td>1</td>
<td>0/1</td>
</tr>
<tr>
<td>5</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>0.00</td>
<td>1x1</td>
<td>1</td>
<td>0/1</td>
</tr>
</tbody>
</table>

For DSLRs:

Next, choose your “ISO”. SGPro, when it connects to your camera, will query it for available ISO values. For our event, go ahead and select an ISO value of 800. Lastly, fill in the value for repeat. We are after 3 hours of data so we will enter 18 here. That’s the gist of creating an event (this one has 18 frames). Note, that there is currently no DSLR simulator, so you will need to proceed as though you are using an OSC CCD.

Here is what your event table should look like (use the one above for the rest of this tutorial though):

<table>
<thead>
<tr>
<th>Event</th>
<th>Run</th>
<th>Type</th>
<th>Filter</th>
<th>Suffix</th>
<th>Exposure</th>
<th>ISO</th>
<th>Repeat</th>
<th>Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>10 s</td>
<td>800</td>
<td>18</td>
<td>0/18</td>
</tr>
<tr>
<td>2</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>0.00</td>
<td>100</td>
<td>1</td>
<td>0/1</td>
</tr>
<tr>
<td>3</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>0.00</td>
<td>100</td>
<td>1</td>
<td>0/1</td>
</tr>
<tr>
<td>4</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>0.00</td>
<td>100</td>
<td>1</td>
<td>0/1</td>
</tr>
<tr>
<td>5</td>
<td>□</td>
<td>Light</td>
<td>None</td>
<td></td>
<td>0.00</td>
<td>100</td>
<td>1</td>
<td>0/1</td>
</tr>
</tbody>
</table>

A few notes about the event table:

- You can move events by using the up and down arrows on the far left
- You can delete an event by clicking the “X” icon on the far left
- You can uncheck the “Run” option to prevent further execution of the event

**Step 6:**

**Specifying the location of your images:** Now that your camera is connected, we will specify where and how to save your captured image files. To do so, we will set a few parameters in the upper middle area of the sequencer (the section labeled “Target Data”). First, locate the “Directory” field and then click “Browse”. This will allow you to select the base directory for all images taken by SGPro. Now you may be saying to yourself “That’s silly… I don’t want to save all of my SGPro images to the same directory”. You’re right. We don’t want to do that either. Because of this we have introduced a very powerful file
naming system. In the “File Name” field directly below “Directory”, you can specify a custom file naming pattern using quite a few options. For instance, if you want your file names to be named using the target name (the one you specified above), then the type (light, dark, etc...), then the binning, then the exposure length, then its frame (series) number, you would enter “%tn_%ft_%bi_%el_%fn” into the “File Name” field. Pretty easy... But what about the single directory issue, you mentioned above? This is also pretty easy... most folks simply modify their existing patterns by prepending “%tn” to it. This will create a sub-directory under the base directory named after the target.

As an example, suppose you named your target “M42”. The full entry in the “File Name” field is: “%tn%tn_%ft_%bi_%el_%fn”. Using the LUM event as the basis for this example, the first frame will produce a file named “M42_Light_1x1_600sec_frame1.fit”. Where will it be created? Let’s assume directory you chose is “C:\AstroImages” (in the directory field). In this case, because you specified “%tn” as a prefix to your file name, the full path to your new images will be “C:\AstroImages\M42”. You can also use this method to separate images by type. Instead, if you used “%tn%ft%tn_%ft_%bi_%el_%fn”, the path to your “Light” images would be “C:\AstroImages\M42\Light”.

In SGPro, the example described above, would look like this:

<table>
<thead>
<tr>
<th>Target Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected: Target Set 1</td>
</tr>
<tr>
<td>Running: None</td>
</tr>
<tr>
<td>Directory: C:\AstroImages</td>
</tr>
<tr>
<td>File Name: %tn%tn_%ft%bi%el_%fn</td>
</tr>
</tbody>
</table>

Clicking the "magnifying glass" preview icon, you can see an example of how your data will be saved (using event 1):

```
Path Preview

Sample Event
This path preview uses "Event 1" from your sequence.
Preview:
C:\AstroImages\Target Set \Light\Target Set
1_Light_1x1_10sec_frame1.<ext>
```

Of course, you can create sub-directories using any of the provided pattern tokens. If you forget what options are available to you, just click the “Key” button next to the “File Name” field.

**Note:** DSLR cameras that use ISO can insert this value into the file name using the "%is" token.

**Note:** To avoid setting these values every time you create a new sequence, you can set them in the Options dialog and they will be auto-populated for new sequences (Tools->Options menu item).

**Step 7:**

**Setting up the auto guider:** SGPro currently supports three different autoguiders (PHD2, AstroArt and MetaGuide). As of now, SGPro does not have its own auto guider so when we say “supports” we mean that we are able to request that the external autoguider perform a dither operation between frames.
Dithering is an important part of astrophotography and can help to remove unwanted artifacts when your sub-frames are stacked to form a master frame.

For the purposes of this tutorial, we will be using a special, non-functional auto guider called “Practice Guider”. Please remember not to use this guider outside of simulations like this one… its only purpose in life is to help you learn how to setup and run an autoguider up while indoors (PHD2 is not able to do this very well).

Note: Most folks using SGPro use PHD2 so, despite using the “Practice Guider”, we will discuss guiding like we are actually using PHD2.

To set your auto guider, open the Control Panel again and navigate to the “Auto Guide” tab. Use the Guiding Interface drop down to select “Practice Guider” (note that using this when not practicing, this is where you will pick your actual auto guider). Check the “Dither” option and then choose the dither amount. We use “PHD2 speak” for these terms, but in general, use “Very High Dither” or “Extreme Dither” for shorter focal lengths and the smaller dither options as you increase focal length. Finally you need to define the settling options. Settling options allow for the mount to settle after some kind of disturbance. Typically this disturbance is invoked by SGPro in the form of a dither. This means that if PHD2 is not reporting that both RA and DEC values are below the settling value for a particular amount of time, SGPro will temporarily pause the sequence until guiding has recovered. The settling value is a whole number that defines the maximum allowable deviation (in pixels) from the center of your guide star. Short focal length scopes can generally get away with settle values of a half-pixel or more. Longer focal length scopes will sometimes require more precise guiding and use settle values of 0.2 pixels or lower. The “Practice Guider” will always return a value of 0 for distance from center so you will not get to see any real deviation while going through this tutorial.

At this point, go ahead and save your sequence. Sequence files in SGPro are saved as “.sgf” files. Click the “disk” icon in the upper left or go to “File->Save Sequence”.

Note: Dithering will not work in PHD2 unless you enable the PHD2 server. To do this, open PHD2, go to the “Tools” menu and check “Enable Server”.

Note: SGpro contains a PHD2 module that will allow you to view the quality of your guiding without switching applications. To open the PHD2 module simply click the PHD2 icon. Furthermore, you can customize the color or scale of the graph to your taste. To adjust the colors, simply left click on the RA or DEC labels. To adjust the scale (zoom) simply right click on the graph. This module requires you to enable PHD2 logging or it will not function. To do so, open PHD2, go to the “Tools” menu and check “Enable Logging”.

**Step 8:**

**Setting the camera’s temperature:** Most CCD cameras allow for controllable temperatures. As of now,
there are no DSLR cameras will controllable coolers, so if you intend to use this type of camera, you can skip to next section. You will obviously want to set your camera's temperature to the desired value before you start capturing. Failure to do so will introduce large amounts of thermal noise and make your images very difficult to process. The easiest way to do this is to open the “TEC Module” by clicking the thermometer icon. This will open a small window named “Temperature”. In it, you can turn your camera's cooler on or off and easily set the temperature. Go ahead and do this for the simulator camera now. Click the “On” option to turn the cooler on and then enter the temperature you want to set.

For instance, if you want to set the cooler to -10C, enter “-10” and click “Set”. There is a field next to the “Set to” field that will allow you to set the temperature of the CCD over time. Using this feature can help to reduce thermal shock to your camera's sensitive parts. If you want to set your camera’s temperature to -10 C over a 5 minute period, simply change the “0m” to “5m” and click “Set”.

This is what the camera temperature module looks like:

![Camera Temperature Module]

Note: You can have SGPro automatically cool and warm your camera for you. This is not discussed as part of this tutorial, but, if you are interested, more info can be found here.

**Step 9:**

*Focusing your images:* This tutorial does not use a motorized focuser, and, as such, we cannot walk through how SGPro accomplishes “on-target” auto focus (it's actually quite easy and very powerful). Instead we will focus on two different methods that are available with a normal manual focuser. Both methods depend on use of the “Frame and Focus” module (click the gold star icon to open and position).

**Method 1:** This method will use a Bahtinov mask and a nearby (to your target) bright star. The object here is to obtain a uniform diffraction pattern (more on this here: [http://en.wikipedia.org/wiki/Bahtinov_mask](http://en.wikipedia.org/wiki/Bahtinov_mask)). While not unheard of, it is unlikely that your target will contain a star bright enough to produce this pattern in a reasonable amount of time (a few seconds). This means that you will have to perform off-target focus (moving the mount back and forth between the target and a bright star every time you want to focus). When performing initial focus, you will be using the “Frame and Focus” module. This can be opened by clicking the “Gold Star” icon. This will allow you to place the camera into state where it continually captures images for display purposes only. None of these images are saved to the disk. So… to get started, place the Bahtinov mask over the aperture of your scope (or pretend to since we are simulating… you get the point). Next, specify binning for these frames. In general, for frame and focus with a Bahtinov mask, you should specify the highest binning available (in most cases, this will be 4x4; for DSLRs you will want to use a higher ISO… 800 or 1600 should be fine). This will help with both download times and sensitivity. For this simulation, leave binning at 1x1 because the simulator image
is quite small already. Asking the simulator for a 4x4 image will work, but the image will be very tiny. Next, specify the exposure time... for this, a value between 1 and 5 seconds should be appropriate (depending on brightness of the star and binning). Finally, open the Histogram module (Colored Bars icon) and ensure that “Auto Stretch” is checked. If you don’t do this, all of your images will just appear as empty black squares. That’s it! Click “Start” and the camera will begin taking a continuous stream of images you can use to adjust your focuser. When you have achieved proper focus, click “Stop”.

**Method 2**: This method will use the built-in “Image History” module. This is arguably simpler, but may be a bit less precise depending on the star field you choose (typically the same as the target). The primary advantage of this method is that you don’t need to move off your target to focus (huge time saver). To use this method, click the “Graph” icon to open the “Image History” module. Optionally, go to “Tools->Image History” to open a larger and more detailed representation of the module. Once this is done, start Frame and Focus (same as method 1). This time, in the Image History module, you will need to ensure that the “Enable image history” option is checked. Once enabled, the image history graphs will begin to plot “whole image half-flux radius (HFR)” (a focus metric) and star counts. A binning of 2x2 will normally work best here (again DSLRs can use an ISO value of 800 or 1600 here). Now adjust your focuser to get the lowest possible HFR value. Before you start paying attention to any numbers, make sure to obtain a rough focus (seeing any semblance of stars should be sufficient). The objective here is to spot a “V” pattern on the graph. The closer you move to focus, the lower your HFR value will be. As you move the focuser toward focus, the HFR value will decrease and then, at some point, start to increase. This is an indication that you have passed focus and should go back one increment. When you are done, click “Stop”.

**Note**: Before starting frame and focus, ensure that you open the “Histograms” module and check the “Auto Stretch” option. If you don’t do this, all of your images will just appear as empty black squares. See the image below...
Step 10:

**Framing your target:** Pointing the scope in the exact center of your (intended) target can be a daunting task. In this tutorial, we did not connect an ASCOM compatible mount so our framing options are quite limited. Though it is beyond the scope of this tutorial, SGPro offers several, easy-to-use, automatic centering options that can get you within a few pixels of your target in under two minutes. Definitely worth checking out, but we want to stick to basics here...

In this example, we might use a spotting scope, finder or external planetary program to slew the mount near our target. Unless your mount's alignment (sync), polar alignment and gears are perfect, you will likely not be pointing where you want. To correct this, you will use the “Frame and Focus” module (as described in the “Focusing” section) to start streaming a series of temporary images. A binning of 4x4 is best for the framing process (again, higher ISO values for a DSLR will be better here). Exposure time will vary depending on target brightness. To complete framing, click “Start” on frame and focus and then, using the hand controller for your mount, slowly move the telescope to the desired position and you're done. You may also be required to rotate the orientation of the camera (most CCD chips are not square). When you are done, click “Stop” on frame and focus.

*Note:* This process is pretty simple if you are imaging at short focal lengths, but grows increasingly more difficult as your focal length increases. At long focal lengths you will almost certainly need to move to more advanced framing methods.

*Note:* Before starting the framing process, ensure that you open the “Histograms” module and check the “Auto Stretch” option. If you don't do this, all of your images will just appear as empty black squares.

Step 11:

**Running the sequence:** OK… we've done a lot and it's time to review. So far we have found and connected the camera, created a target, defined events for that target, specified where and how to save images, set up your auto guider, learned a few methods for manual focus and finally learned how to manually frame your target. That's a lot of stuff and, at the end of this tutorial, we will talk briefly about how to minimize the setup time for future sequences.

Next up, we need to consider the order of the sequence. On the sequencer window, below the equipment area, you will find several options that dictate the order in which the events you defined will be executed. For this tutorial, we will focus only on the “Finish event first” and “Rotate” options. Even though we created only one event here, there are many scenarios in which you would create more. If we had created multiple events, choosing “Finish entire events first” will result in the capture of all frames for the first event (event 1), then each of the other events will be captured as discrete events. A rotating capture is exactly what it seems. SGPro will capture one frame (from event 1) and then move onto the next next event and then onto the next and so on… This is a good option if you would like to get an even distribution of data over a given period of time.

For this tutorial, yours should look like this:

<table>
<thead>
<tr>
<th>Delay and Ordering Options</th>
<th>Event order:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay:</td>
<td>Rotate through events</td>
</tr>
<tr>
<td>Delay first: 0</td>
<td>Finish entire events first</td>
</tr>
<tr>
<td>Delay between: 0</td>
<td></td>
</tr>
</tbody>
</table>

Lastly, you will be responsible for starting PHD2 guiding before you start the sequence. This means you need to connect your gear to PHD2, calibrate and start guiding while you are pointed at your target (obviously not necessary with the “Practice Guider”).

We're ready! Don’t forget to save your sequence (sequences are saved as “.sgf” files). Click the big
“Run Sequence” button in the lower right hand corner.

**Step 12:**

**Checking your images:** So now you are cranking out images and life is good. Many folks like to inspect their handiwork as the sequence progresses. First off, ensure that, using the “Histogram” module, you have the auto-stretch option checked so that you can actually see details in your images. You have several options for inspecting images…

In the currently displayed image you can zoom or pan to any location on the image. To zoom, right click on the image and then select the zoom factor. By default all images will be resized (for display purposes only) to fit in the image display area. You may want to zoom to 100% in order to check out the quality of your stars. Other ways to zoom an image include the “magnifying glass icons” on the image toolbar (located directly above each image) and the zoom drop down box to the right of the image toolbar buttons. Finally, you can use the “Pan and Zoom” module. On this module you will find a zoom slider that will let you adjust zoom up to 400%.

Here is a portion of the context menu (right click):

When an image is larger than the display area you can easily move to other areas of the image by dragging on the image and “pushing” it in the desired direction. Alternatively, you can use the “Pan and Zoom” module to drag the small red box to the area of interest. The main image display area will now be representative of this part of the image. Here is what the Pan and Zoom module looks like for images that are larger than the display area:
Lastly, SGPro, will by default, replace the current camera image window data with the latest data from the camera. This means that if you are taking 10 frames as part of an event and you are on event 9, only frame 8 will be shown. All other frames are on disk, but not displayed. If you haven't been out to check on your images for a while you may be interested in inspecting images that are no longer displayed. To help alleviate the user from having to go open older images through a file selection dialog, we use an “image browser”. The browser uses forward and back arrows just like an Internet browser. If you have frame 8 shown and want to see frame 6, simply click the back arrow twice. Alternatively, you can right-click on either the back or forward arrows and get a menu that shows the last 25 images.

**Step 13:**

*Pausing and aborting:* During the course of the sequence you may have need to pause or abort the sequence. There are any number of reasons to do this… you’re done for the night, clouds roll in, pausing for emergency focus, hurricane, etc.

To pause the sequence, you simply click the same button you used to start it (located in the lower right hand corner). When the sequence is running, this button actually changes to read “Pause Sequence”. When you click it, you will be presented with another small dialog that allows you to choose how you want to pause the sequence. You can pause after the current frame is completed and downloaded or you can choose to abort immediately. If you choose to abort immediately, SGPro will not download data from the camera (it will be lost).

Here, you can see that the "Run Sequence" button has changed into a "Pause Sequence" button:

Clicking it presents you with these choices (as described above):

**Step 14:**

*Final thoughts:* This tutorial does not cover many of the most powerful aspects of SGPro. It is intended as a primer to get you up and going quickly with just the basics. Below are some notes and thoughts that will help you figure out where to go from here (when you are comfortable moving on):

*Save as profile:* You just spent a lot of time setting your gear up and tweaking settings. Almost any setting you make in a sequence can be saved to any number of custom equipment profiles. Once you have a profile, you can create new sequences using them and all of your settings will be applied and ready to go with the click of a few buttons. All you need to do at this point is define your events and you'll be ready to go. More details on profiles can be found [here](#).

*Focusing reminders:* This tutorial discusses a couple of options for manual focusing. If you are interested in pausing the sequence based on user defined triggers like time, temperature, frame count, etc, you can find more [here](#). Once this is set, and a trigger is hit, SGPro will automatically pause the
sequence and inform you that it's time to focus. When you are done, simply resume the sequence.

**Playing around**: Almost all equipment types have simulators. Hook them up and play around! You can try to use almost any feature in SGPro just with simulators (Auto meridian flips are one exception to this).

**Auto Focus**: SGPro can provide you with the ability to stay in focus all night. Temperature and gravity will try to destroy your images, but SGPro, simply by connecting an ASCOM compatible (absolute) focuser will be able to automatically focus based on a number of user defined triggers (time, frames, temperature, etc). More information on this can be found here.

**Easier framing**: In this tutorial we discussed a very manual and time intensive method for framing. One of the most powerful features found in SGPro is the ability to find your target and start imaging in minutes. In order to do this, you must install one of three plate solvers (Pinpoint, Elbrus or Astrometry.NET). Once this is done SGPro will interface with your plate solver in order to move the mount, with high accuracy, to your intended target. In addition to this, you can easily recenter on one of your images from a previous night or find an image on astrobin.com or flickr.com that you would like to use for framing your own image. More on this can be found here.

**Step 15:**

**Getting more help**: SGPro contains a fairly extensive help file (this document is also included in there). When in SGPro, you can get to the help file by going to “Help->Help File”. SGPro also offers tooltips on almost every single button and control available. To access these, just ensure that you click on a control and then hover over it with the mouse. Finally, feel free to post on our Yahoo! group (http://groups.yahoo.com/group/mainsequencesoftware)… we will be happy to see if we can help.
Cameras
- ASCOM
- Canon EOS (Digic III and up)
- QSI
- SBIG
- FLI

Filter Wheels
- ASCOM
- SBIG
- FLI

Focusers
- ASCOM

Telescopes
- ASCOM

Plate Solvers
- Elbrus
- Pinpoint
- Astrometry.NET
- Local Astrometry.NET server (ANSVR)
- PlateSolve2 by PlaneWave

Auto Guiders
- PHD2
- AstroArt
- MetaGuide
**Flat Boxes**
- Alnitak Flat Box
- Manual Flat Box

---

**Supported Equipment**

**Cameras**
- ASCOM Cameras (any camera that provides an ASCOM compliant driver).
- QSI Cameras. Sequence Generator Pro supports the full QSI line through the QSI600 series.
- SBIG Cameras. Sequence Generator Pro provides support for all SBIG cameras.
- FLI Cameras. Sequence Generator Pro provides support for all known FLI cameras.
- Canon EOS DSLR Cameras (Digic III and better).
- Nikon DSLR cameras (D7200, D7100, D7000, D5200, D5100, D5000, D800/D800E, D700, D600, D300S, D300, D90, D4, D3X, D3S, D3)

**Filter Wheels**
- ASCOM Filter Wheels (any filter wheel that provides an ASCOM compliant driver).

**Focusers**
- ASCOM Focusers (any focuser that provides an ASCOM compliant driver).

**Telescopes / Mounts**
- ASCOM Telescopes (any telescope that provides an ASCOM compliant driver).

**Rotators**
- ASCOM Rotators (any rotator that provides an ASCOM compliant driver).

**Observatories**
- ASCOM Observatories (any observatory that provides an ASCOM compliant driver). We support both Dome and Roll Off Roof styles.

**Flat Boxes**
- Alnitak Flat boxes

**Safety Devices**
- ASCOM switch devices that allow SGPro to determine if it is safe to image

*Note:* Note that Sequence Generator Pro interacts with ASCOM devices as set forth in the official ASCOM developer documentation and we cannot vouch for the quality or level of conformance for individual drivers.
Cameras are selected and connected on the **Sequence Window** in the equipment group box.

Options can be set when the camera is in a disconnected state by clicking the [ ] icon. These options will vary by manufacturer. For ASCOM cameras this will bring up the ASCOM properties dialog for the selected camera.

To connect the camera click on the connection icon [ ]. Once connected the icon will change [ ], click this icon to disconnect.

**Hardware Specific Information**
- QSI Cameras
- SBIG Cameras
- FLI Cameras
- Canon EOS Cameras
- Nikon Cameras

**Camera Control Panel:**

*Description:* Sequence Generator Pro can use many cameras natively and any ASCOM supported camera. The camera is controlled through the Camera tab on the Control Panel. Depending on the hardware attributes of the camera different options will be available when connected. However there are two distinct types of cameras that can be connected which are CCDs and DSLRs.

**CCD Camera**

*Description:* CCD (Charge-coupled Device) cameras are becoming increasingly popular for astrophotography. In general they are more sensitive than DLSRs and offer benefits such as deep cooling and the ability to take mono images (sharper images because there is no bayer matrix).
Controls (These values can also be preset by using a profile or by opening a sequence.):

- **Camera Cooler:** If equipped, allows the cooler to be turned on and regulation temperature set. If no cooler is present these options will be grayed out. If a cooler is present, but does not provide temperature regulation then only the "on and off" controls will be enabled. These controls allow your cooler to be manually turned on:
  - **Cooler On/Off:** Turns the cooler on or off.
  - **Set Temperature to:** Sets the regulation temperature of the cooler. These values are not used in conjunction with "Warm Up / Cool Down".
  - **Change over:** Allows you to specify a time period over which the temperature will be slowly dropped to the set temperature mentioned above.
  - **Set:** initiates the changes mentioned above.
  - **Abort:** stops the "Set" mentioned above. This button is also used to abort cooler warm up and cool down.

- **Warm Up / Cool Down:** These options control how and when the cooler is automatically turned on and off:
  - **Cool down to X in Y:** Similar to the controls above this will cool down the to the specified temperature in the specified amount of time. These values are used in conjunction with the "Cool down when camera connects" option.
  - **Warm up to X in Y:** This warms up the camera to the ambient temperature in the specified amount of time. *(Note: The camera is not able to warm above ambient so this value should be fairly representative of the ambient temperature).*
  - **Cool down when camera connects:** Checking this option will run the above "Cool down to X in Y" method to automatically start cooling down your camera when it is connected. This alleviates the need to remember to turn on your cooler when you first connect your camera.
  - **Cool down when sequence starts:** Checking this will keep the camera at ambient temperature until the sequence starts. This means that the camera will automatically cool and then start the sequence when the TEC is within 3 degrees of the target temperature. If your sequence has a delayed start, the camera will not cool until the expected start time has passed.
  - **Warm up when sequence completes:** When checked your camera will warm back up to the specified temperature (or ambient) within close to the specified amount of time. Unfortunately most camera drivers only allow the Temperature to be set and not the power, so without knowing the ambient temperature there is no way that warm up can be completely accurate.
Upon successful warm up the camera’s TEC will be turned off.

- **Gain:** These controls allow you to change the Gain values of your camera for multiple binning levels. If your camera does not support these options these will be grayed out:
  - **Gain:** This sets the gain for the camera given the binning level.

Special notes for ASCOM cameras that support gain:
- SGPro cannot tell if an ASCOM camera supports setting gain until it is connected. Prior to connection, the gain drop box control will simply read: "Link Cam". Once the camera is connected (linked), SGPro will either disable these controls (gain not supported) or populate allowable values for camera gain (gain is supported).
- If gain is supported, **it must be set** for each binning mode or the first gain entry in the list will be used for all images (probably not desired).
- These notes are also true when defining equipment profiles. A camera’s gain should not be defined in the profile unless the camera is connected.

By clicking the "arrow button", you can reveal an area designed to store the gain for your camera in terms of e-/ADU. These values are optional and can be used in conjunction with the "readout noise" value below to calculate ideal exposure time.

- **Settings and Specs:**
  - **Angle:** This field is used to tell SGPro the current angle of the camera. If a successful plate solve returns the camera angle this field will be updated with the actual angle of the camera.
  - **Scale:** This field is used to store the scale of the camera / telescope (arcsec / px @ 1x1 binning). If a successful plate solve returns the camera angle this field will be updated with the actual scale.
  - **Pixels:** Store the number of physical pixels for your camera here (i.e. pixels at 1x1 binning).
  - **Readout Noise:** This optional value, if present, will be used to calculate the **ideal exposure time** (http://www.hiddenloft.com/notes/SubExposures.pdf).
  - **Camera Gain:** These values are optional are are also used to calculate the ideal exposure time (above). These value must come from the camera manufacturer and will likely vary by binning level.
  - **Download Times:** These values will help SGpro present more realistic "Time Remaining" estimates. Please note that, even with these fields filled out properly, SGPro is not able to estimate times for auto focus, meridian flips, plate solving, centering routines, etc.
  - **Use high speed download:** This option will allow your camera to use a high speed download for most temporary frames (frame and focus, auto focus and plate solve). Sequence and plate solve images are not affected by this setting (in order to reduce noise). **Note that if you check this and your camera or driver does not support it, it will be ignored.**

*Note: The current version of ASCOM 6SP2 does not implement Offset. Gain is available but VERY few cameras support setting Gain via ASCOM so for the time being all ASCOM cameras do not have access to*
these controls. For ASCOM cameras the gain and offset should be set via the cameras driver which can be accessed via the Main Window by using the settings button.

**Canon EOS**

*Description:* DSLR (Digital Single-Lens Reflex) cameras are an excellent avenue into astro-photography. Many people already own a DSLR so the cost of entry can be minimized in many cases.

*Options:* Sequence Generator Pro has the ability to save DSLR images in several different formats. No one format is preferred as they all contain RAW data. These options are available in the camera setup dialog which can be accessed via the Camera Settings button mentioned above. When the settings are opened and "Canon EOS" is selected for the camera the following dialog will be shown:

![Canon Options dialog](image)

- **Save Formats:**
  - Single Image (CFA FITS): Stores the CFA (Canon Filter Array) data in a 2 dimension FITS file. The data remains Bayered.
  - RAW Image (CR2/CRW): Stores the native Canon Raw format
  - RAW + FITS: Stores both of the formats above

- **Mirror Settle Time:** Designates the amount of time (seconds) that will elapse between pulling the mirror up and opening the shutter. **This option must also be enabled in the camera.** Generally used to reduce vibration during shooting. To disable set to 0, to enable set to any non-zero value.

- **AF Binning:** DSLR cameras can sometimes have difficulty determining star centroid on AF frames (due to the bayer matrix). If you are having difficulty obtaining a "V" curve with AF, try experimenting with different software binning levels.

*Note:* RAW Images will not contain meta data found in the FITS format.

Below is an image of the Control Panel with a DSLR connected.

*Note:* All of the controls are disabled.
Canon Cameras - There are many features in Sequence Generator Pro that are unique to Canon Cameras and require special consideration when using Sequence Generator Pro. Such as:

- LiveView - Cameras that support LiveView will have the option to turn on LiveView in the Frame and Focus Module.
- Bulb vs Manual Mode - If your camera has a dedicated "Bulb" mode on the Mode Dial then you should use this mode for any exposure over 1 second. Also exposures under 1 second are not reliable when using Bulb mode so if you require reliably timed short exposures then you should switch the camera to Manual. For cameras that DO NOT have a Bulb option on the Mode Dial these options do not apply.
- If your camera supports "Auto Rotate", you should turn this off while you are using the camera for astro-imaging (the mount will hold the camera in all sorts of odd positions and possibly create images that are difficult to stack without manual manipulation).

Nikon Cameras

When connecting a Nikon camera, it is normally as simple as connecting the camera via USB and, if needed, with a Nikon shoestring adapter. When only one camera is connected you may simply click the "Connect" button on the sequence form. If multiple Nikon cameras are connected, use the options dialog (below) to tell SGPro to which camera you would like to connect.
Some Nikon cameras require a shoestring DSUSB adapter to exposures longer than 30 seconds. Other, newer, Nikon cameras can take long exposures without an adapter (via direct USB connection).

Long exposure ready (bulb mode) cameras: D810, D810A, D800, D750, D800E, D7100, D7200, D5200, D600, D610, D5, D500, D5300, D5500, D4, D4S, Df

If your Nikon camera is not in the list above, you will require a DSUSB adapter.

- **Image Data Formats:**
  - Single Image (CFA FITS): Stores the CFA (Nikon Filter Array) data in a 2 dimension FITS file. The data remains Bayered (mosaiced).
  - RAW Image (NEF): Stores the native Nikon Raw format
  - RAW + FITS: Stores both of the formats above

- **AF Binning:** DSLR cameras can sometimes have difficulty determining star centroid on AF frames (due to the bayer matrix). If you are having difficulty obtaining a "V" curve with AF, try experimenting with different software binning levels.

  *Note:* RAW Images will not contain meta data found in the FITS format.

**SBIG Cameras:**

- SBIG Cameras - SBIG's have their own Settings dialog for the connection type and can be changed between USB, Ethernet and LPT ports. This dialog is accessed when selecting an SBIG camera and clicking the Connect Icon (See Connecting and Settings Options)
Guide Chip: Used to select the guide chip that will be used in conjunction with the SGP API Guider Camera.

Disable Fan with TEC: Turns the fan off when the TEC is turned off. Whenever the TEC is turned on the fan will always be turned on regardless of this setting.

Connection type: SBIG Cameras can connect via USB, Ethernet or LPTs 1 through 3. If you connect via USB or Ethernet and multiple SBIG cameras are detected you will be presented with a dialog prompting you to choose the appropriate camera.

**FLI Cameras:**

- FLI Cameras - FLI's have their own Settings dialog for the connection type and can be changed between USB, Ethernet and LPT ports. This dialog is accessed when selecting an SBIG camera and clicking the Connect Icon (See **Connecting and Settings Options**).
Readout Speed: Each FLI camera has unique readout speeds. SGPro only considers two... normal and fast. Your camera may have several more than this, but you will need to tell SGPro (one time) what speed you want to use for normal and fast readouts. Normal will be used for all collected data and auto-focus and high-speed readout will be used for frame and focus, plate solving and for other "throw-away" data. Please note that switching from fast speed to normal speed takes about 20 seconds each time you do it...

High quality flush count: This setting has no effect for modern FLI cameras. For cameras manufactured prior to 2005, this setting is used to determine the pre-exposure buffer flush for sequence data (i.e. frames you would want to keep). This value should be at a nominal level (please contact FLI for appropriate settings here)

Low quality flush count: This setting has no effect for modern FLI cameras. For cameras manufactured prior to 2005, this setting is used to determine the pre-exposure buffer flush for temporary data like plate solve frame focus frames. This can be a low value (1 or 2 is fine, the lower the better).

RBI Mitigation: Not currently operational (coming soon).

QSI Cameras:

- QSI Cameras - QSI camera have a special settings dialog that control behavior within SGPro. The main QSI settings dialog can also be accessed from here.

Driver version: This will show the installed driver version. If no value is present in this field, the QSI drivers have not been installed in this machine.

Fan Speed: QSI cameras support three different fan modes:
  - Full: Keeps the fan at full speed even when the camera is at the desired temperature
  - Quiet: Fan speed will vary based on need (i.e. can be at full speed when the camera is cooling)
  - Off: The fan can also be turned off, but this is not recommended

Disable fan with TEC: Checking this option will turn the fan off when the TEC is turned off.

SBIG Guider CCDs

Because the SBIG driver architecture only allows for one application to have control of the camera, we have created a special ASCOM driver that will allow any other guiding application that connects to an ASCOM driver to use the SBIG onboard guiding CCD while SGPro is using the main CCD.

This special ASCOM driver utilizes the SGPro API (Application Programming Interface... you don't need to be a developer to use this). It is made to be used in conjunction with cameras that provide an internal or external guider (most notably SBIG cameras). The main camera is connected to Sequence Generator Pro, then through the SGP API, a connection can be made to access the guide camera using the SGP API.
Guider ASCOM Camera.

To setup the communication you must follow these steps:

- **In Sequence Generator Pro**
  - Select the SBIG Camera form the camera list and click the "Settings" button
  - Select your guider connection method (Internal or Remote Guide Head)
  - Exit the settings dialog and connect to the camera

- **In your guiding application (PHD2 will be used as an example)**
  - Choose the “SGP API Guider” camera and click connect.
  - If all goes well you should be able to loop exposures.

You can turn on logging by going to the SGP API Guider ASCOM settings in your guiding application. The log is somewhat verbose and will grow fairly quickly. It is only recommended to be on for troubleshooting issues.

You may guide through Pulse Guiding by using an ASCOM connected mount in your guiding application, or by using a ST4 connection and choosing the "On Camera" option.

It should be noted that using the SGPro API Guider will result in some additional latency in guide corrections because of the round trip time from the camera to the autoguiding application. An additional time penalty will also be incurred if the correction is through ST4 as the correction will have to go back through the API. We highly recommend using subframes when guiding with the SGP Api Guider to decrease this latency as much as possible. This latency has been roughly measured at 0.6 second when using full frame images for guiding.

**Filter Wheels**

**Connecting and Setting Options:**

Filter wheels are selected and connected on the **Sequence Window** in the equipment group box.

Options can be set when the filter wheel is in a disconnected state by clicking the icon. These options will vary by manufacturer. For ASCOM filter wheels this will bring up the ASCOM properties dialog for the selected filter wheel. This properties dialog is generally where the COM port is specified as well as other device dependent information.

To connect the filter wheel click on the connection icon. Once connected the icon will change, click this icon to disconnect.

**Hardware Specific Information**

- **SBIG Filter Wheel**

**Filter Wheel Control Panel:**

*Description:* The Control Panel provides control of the Filter Wheel. Many of these controls are also duplicated in the **Filter Wheel Module**. These values can also be preset by using a **profile** or by opening a **sequence**.
The active (set) filter is displayed with bold text (and has a corresponding image of that filter for rapid identification)

Controls:

- Set filter position: Allows the filter position to be changed. However these filters must first be setup using the "Define Filter List" (if the filter list is empty or missing some filters).
- Filter change delay: Amount of additional time to wait after the filter wheel has indicated that it has completed changing the filter.
- Define Filter List: This will bring up the "Filter Setup" dialog where the filters and offsets can be specified.
- Set "No filter" Flats Data: Allows you to setup flats exposure and flat box settings when not using a filter wheel.

Filter Setup Dialog
- **Use?**: Sets the filter position to on or off. Unchecked filters will not be available for use.
- **Filter Name**: Allows a meaningful name to be set for the filter, for example "Red" rather than "2".
- **AF Exposure**: The amount of exposure time that should be used for *auto focus* when the filter is set.
- **Focus with Filter**: This option allows you to select a filter to use when the auto focus routine is performed while using this filter. In the example above, all of the broadband filters will focus using themselves, but the broadband filters will use the clear (LUM) filter in order to save time. There are two methods by which the focus filter can be overridden. This method, if set, has priority. If you leave this option set to "default", auto focus, when using this filter will either do nothing (if no *override filter is selected for the sequence*) or will use the *sequence's default override filter* (assuming one is set).
- **Focus pt**: Used to specify a starting point as well as to specify the offsets for adjusting *focus on filter* change when using an absolute *focuser* when *Auto adjust focus per filter* is enabled. Because of the way in which "focus on filter" works it is recommended that you set the focus position of your filters near the same ambient temperature.
- **Flats**: Brings up the Flats dialog which stores values for creating flats sequences for each filter. These values are used as part of the *Create Flats Sequence* tool.
- **Import**: If your filter wheel supports it, Sequence Generator Pro can import filter data (this will overwrite any existing data). This function will use the currently selected filter wheel (from the sequencing window). Note: If you are defining filters for a profile, the import will use the filter you have selected in the profile manager (not the sequencer).

**Flats Dialog**
• **Exposure (s):** sets the amount of time needed for a flat at the specified binning

• **Flat Box Brightness:** Sets the brightness to use for the flat box. When using an automatic flat box this value will be set when taking the flats. When using a Manual Flat Box you will be prompted with a dialog to set your flat box to this value.

• **Number of flats in a "flats event":** Sets the number of flats to be used when creating a flats event with the specified filter.

For Canon cameras this dialog will allow for entering exposure length and flat box brightness per ISO setting:

![Flats dialog for Canon cameras](image)

Note: You can automatically calculate and populate the exposure length data (per profile) here by using the flats calibration wizard.

**Hardware Specific Information**

• **SBIG Filter Wheel - like the SBIG Camera** there is a special dialog which is used to connect the SBIG Filter Wheel. This is accessed by selecting the "SBIG Filter Wheel" and clicking the settings button.

![SBIG Filter Wheel dialog](image)
**Filter wheel type:** specifies the filter wheel being connected to, generally using Auto Detect is adequate.

**Using RS-232 model:** selected if the filter wheel is connected through a COM port rather than through the camera.

---

**Manual Filter Wheel**

**Description:** The "Manual Filter Wheel" is used if you have a filter wheel that is not computer controlled, but still want to have the benefit of the sequencing, file naming, and FITs headers found within Sequence Generator Pro.

You can select the "Manual Filter Wheel" from the Filter Wheel drop down of the sequencing window.

You may setup the "Manual Filter Wheel" just like a normal filter wheel in the Filter Setup dialog.

Whenever a filter change is requested a dialog box will pop up asking you to manually set the filter:

This dialog will pause the sequence and any other actions currently taking place until "OK" has been clicked.

---

**Focusers**

**Connecting and Setting Options:**
Focusers are selected and connected on the Sequence Window in the equipment group box.

Options can be set when the focuser is in a disconnected state by clicking the icon. These options will vary by manufacturer. For ASCOM focusers this will bring up the ASCOM properties dialog for the selected focuser. This properties dialog is generally where the COM port is specified as well as other device dependent information.

To connect the focuser click on the connection icon. Once connected the icon will change , click this icon to disconnect.

**Focus Control Panel:**

*Description:* The Control Panel provides control of the Focuser. Many of these controls are also duplicated in the Focus Control Module. These values can also be preset by using a profile or by opening a sequence.

**Controls:**

- **Focus Travel (In / Out slider):** This is for display purposes only and shows where your focuser lies within it's range of travel.
- **Focus Information:** Displays information about the focuser
  - Current position: The position of the focuser in steps.
  - Temperature: The current temperature the focuser (NA if the focus controller is not equipped with a temperature sensor).
  - Last Focus Temp: The temperature at which the last focus run occurred.
  - Last Focus Time: The time at which the last focus run occurred.
- **Focus Control:** Contains options pertaining to manually moving the focuser.
  - In (Fine/Course Buttons): Allows the focuser to be moved inward by the number of steps specified below the button.
  - Out (Fine/Course Buttons): Allows the focuser to be moved outward by the number of steps specified above the button.
  - Steps: The number of steps that the In/Out buttons will move the focuser.
- Zero: Moves the focuser to the 0 position, you will be prompted to verify this move.
- Go To: Allows a position to be set and the focuser to be moved to that position.
- Stop: Stops any motion of the focuser.

- Focus Options:
  - Reverse focuser direction: Reverses what is considered In and Out movements
  - Focus Reminder: See Manual Focusing Reminders
  - Use auto focus: See Auto Focus
  - Auto adjust focus per filter: See Auto Adjust Focus Per Filter
  - Temperature compensation: See Temperature Compensation
  - Focus Point Settings:
    - Focus: Moves the focuser to the specified focus point (per filter).
    - Set Focus: This will set the focus point of the currently active filter to the current position of the focuser. Alternatively, you can set focus points for filters in the Filter Setup Dialog.

- Frame and Focus: Allows for taking a loop or a single image that is not saved. Useful when focusing or framing your target. This is also accessible via the Frame and Focus Module. Also see Manual Frame and Focus
  - Bin/ISO: Sets the binning or ISO of the image.
  - Exposure: Sets the time in seconds for the image.
  - Start: Starts an imaging loop.
  - Take One: Takes a single frame.

The Other button brings up a special menu seen below:

<table>
<thead>
<tr>
<th>Focuser Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set absolute focus position for first filter use</td>
</tr>
<tr>
<td>Override maximum steps: 1</td>
</tr>
<tr>
<td>Focuser backlash compensation:</td>
</tr>
<tr>
<td>Compensation direction: IN</td>
</tr>
<tr>
<td>Compensation step size: 500</td>
</tr>
<tr>
<td>Use environment device for temperature input</td>
</tr>
</tbody>
</table>

Controls:
- **Set absolute focus position for first filter use**: Checking this option will cause the focuser to move to the absolute focus position set for that filter. The filter change can be for anything (the first event, AF override filter, Plate Solve override filter, etc.). Whatever filter is set first will cause the absolute position of that filter to be set. This is most often used with the "adjust focus per filter" option and it is important to note that the first (and only first) filter change will not behave in the way that all subsequent filter changes will behave. Normally, the focuser only moves by an amount equal to the difference between the old and new filters focus positions (the delta). Checking this option will not use any delta, but set an absolute position. This is useful if your first filter change will be for AF override and it will move the focuser to a point (regardless of temperature) where AF can succeed.
- **Override maximum step**: Allows the maximum step of your focuser to be set lower that the driver specifies. This is useful if you use the same controller on multiple motors and one has a lower range than the other. By setting the maximum step here you don't need to change it in the driver and the focus range appears correct.
- **Focuser backlash Compensation**: Allows you to specify a direction and number of steps for the focuser to end on. For instance if you specify "IN" and 100 then any move that is "OUT" will invoke the compensation which will move the focuser "OUT" by an additional 100 steps and then "IN" by 100 steps.
to remove the backlash.

  o *Compensation direction:* The direction that the backlash will be removed.
  
  o *Compensation step size:* The number of steps to move to remove the backlash. This number does not need to be precise. If anything it needs to be larger than the total backlash in the focuser, so overshoot.

- Use environment device for temperature input: If you have an *Environment Device* device connected, you can use it to provide *focus trigger* input. If your connected focuser has a temperature probe, it will be ignored.

---

**Auto Guiders**

*Description:* Auto guiders are used to keep the telescope centered on an object over a long period of time. The primary use of auto guiders in *Sequence Generator Pro* is for "dithering" between frames in order to give your software a better chance of removing camera defects like hot pixels and bad columns.

*Sequence Generator Pro* does not have a built in auto guider. Rather it uses the following 3rd party auto guiding software:

- **AstroArt** - [Website](#)
- **MetaGuid** - [Website](#)
- **PHD2 (aka Open PHD Guiding)** - [Website](#). PHD2 guiding graph is also available in the [PHD Graph Module](#).
- **Practice** - This is useful only when performing indoor simulations with the guider as part of your setup

---

**Controls:**

- **Guiding Interface:** Where the guiding interface is chosen.
- **Dithering Options:** (Not available on all interfaces)
  
  o **Dither Checkbox:** Enables dithering between frames when checked.
  
  o **Every X Frames:** Dithers on a set interval rather than every single frame. The "count" is only reset on new sequences and when sequence reset is used. For instance if you set this value to "5" and had 2 targets each with 4 frames the first target would not dither, but the second target would dither after the first frame. The "frame count" is global.
Note: SGPro will not dither on the first frame in a sequence (it will ensure that guiding is "settled" though).

**Settling Options:**
- **Settle at < X pixels For Y seconds (assuming the "For" checkbox is checked):** Guiding error amount in pixels that much be reached before a new image will be started. Once guiding is below the pixel amount, it must be maintained for Y seconds in order for the sequence to resume. This prevents the guiding from settling for a split second and then becoming unsettled. Settling will be run:
  - After a dithering operation
  - After guiding resumes from "pause guiding during auto focus"
- If the "For" checkbox is not checked, the auto-guider will resume (considered "settled") as soon as the guider reports its error as under the user defined pixel tolerance above (even if the very next reading is above the error limit).

**Control Options (Not available on all interfaces):**
- **Pause:** Pauses auto guiding
- **Resume:** Un-pauses auto guiding
- **Flip Calibration Data:** Allows you to manually flip the calibration data of your auto guider. Generally used after a meridian flip.
- **Stop:** Stops auto guiding

**Other options (Not available on all interfaces):**
- **Settings:** While it is possible for all auto guiders to have additional settings, this feature is currently only available for PHD2. See below for more details.
- **Stop when sequence completes:** stops the auto guider when all events in a sequence have been completed.
- **Pause guiding during image download:** Pauses auto-guiding between images. Useful if your guide camera data connection is "noisy" and causes issues with your imaging camera. This options is also pretty much mandatory if you are using an on-board SBIG guide chip. This option currently only works on SBIG cameras.
- **Pause guiding during auto focus:** Pauses auto-guiding when auto focus is running. Useful if you use an OAG for guiding and running the Auto Focus routine (guide stars will be out of focus for a couple minutes).
- **Pause guiding during backlash comp (OAG):** Use this option to pause guiding when your focuser is using backlash compensation. Backlash compensation can move far enough out that your guide camera's star will essentially disappear and cause PHD2 to send "star lost" messages. Using this option will help to prevent that.
- **Settle auto guider before auto focus frames:** Check this box if you need to ensure guiding is stable during the autofocus routine (as the guide star changes position and shape). This is normally reserved for long focal length, OAG and SCT combinations. Those of you who use an SCT stock focuser (either with the Feathertouch/Microtouch combo, Robofocus or the Rigel Systems motor) have to deal with image shift when the focuser moves. Each time the focuser moves in for the next AF exposure, the guide star is nuded a few arc seconds off center because of SCT image shift. The guider will then pull it back in during each AF exposure - and the mirror also settles back into its "rest position" - but not always at the same speed. So this throws off the HFR calculations.
- **Restart current frame when guider distance > X pixels:** Allows your current frame to be canceled and reattempted if you get a guiding error greater than X pixels. Note that you can turn this option off at any time, but turning when turning it on, the option will not take effect until the next light frame starts.
- **Recalibrate auto guider when target changes:** This option should seldom be used. If you use an ASCOM connection from PHD2 to your mount, PHD2 will automatically adjust the current calibration to accommodate for changes in declination. If, for some reason, you are still using an ST-4 interface for guiding, this option may prove useful if switching targets causes a meridian flip or a large change in declination.
PHD2 Settings

In an effort to become more tightly integrated with the PHD2 auto guider, SGPro implements some settings that are specific to this relationship. In order to access them, choose "PHD2" as the auto guider from the drop down list, then click the settings button. If this is the first time you have done this, a warning dialog will appear indicating that SGPro does not know where you have installed PHD2. To correct this, click the "Browse..." button and find your PHD2 install folder. Once chosen, you will not need to do so again. In addition to this, clicking the "Settings" button in the future will actually open PHD2 for you in order to complete the rest of the settings. The PHD2 settings dialog looks like this (note that you can set this for the current sequence via the control panel or you can set this per equipment profile via the equipment profile manager):

![PHD2 Connection Settings](image)

The install path (described above) is a global setting and applies to all sequences and profiles. The other settings here can be set per equipment profile. SGPro will query PHD2 for a list of PHD2 profiles you have created. Here, you can match a PHD2 equipment profile with a particular set of gear (the gear in the corresponding SGPro profile).

- **Open and connect gear to PHD2 when the sequence starts (using the profile above)**
- **Disconnect gear from PHD2 when the sequence is done**

It is also possible to connect / disconnect your PHD2 gear by clicking the "Connect" or "Disconnect" button. For convenience, these buttons are also located on the PHD2 docking module.

---

Plate Solvers

**Description:** While not technically equipment, the Plate Solver is a fundamental piece of the Sequence Generator Pro experience. Plate solving adds the ability to find the exact center of your image (down to sub arcsecond accuracy). It also enables the Center Here and Auto Center features. The plate solving actions (not settings) are also available in the Scope Centering Module.

In general, this tab is used to house settings and action that allow you to automatically center on a reference frame (see below). This comes in quite handy when you need to image the same target over multiple nights or when re-centering after a meridian flip. Once your plate solving setup is complete it is literally as simply as clicking a single button to get your target back in near exact position.
Sequence Generator Pro uses the following 3rd party software for plate solving:

- **Elbrus**: See [Setting Up Elbrus](#) - Manufacturer's Website
- **Pinpoint**: See [Setting Up Pinpoint](#) - Manufacturer's Website
- **PlateSolve2**: See [Setting up PlateSolve2](#)
- **Local Astrometry.NET Install** ([ANSVR](#))
- **Astrometry.NET**: You can use either a local or remote instance of the Astrometry.NET plate solver as your primary plate solver.

Controls:

- **Plate Solving Interface**: see [Setting Up Elbrus](#) or [Setting Up Pinpoint](#) for more information.
  - **Blind Settings**: Brings up a settings dialog that will allow you to choose the remote (default) or local install ([ANSVR](#)) of Astrometry.NET. These settings will be used whenever you explicitly run a blind solve or when your primary solver fails and blind solve is invoke automatically (assuming you have the option below selected).
- **Scope Frame & Center Here**: this information is used to solve images captured with your camera. The data entered here is also used to populate FITS headers in saved images:
  - **Search**:
    - Elbrus: Specifies how large of a region should be used when attempting to plate solve. See [Elbrus Search Options](#) for more info.
    - Pinpoint: Specified the magnitude of the stars to use for plate solving. Magnitude 20 starts is the default and is sufficient for most applications. Extreme widefield setups will require the use of higher magnitude stars.
    - PlateSolve2: Set the maximum number of regions to search before giving up.
  - **Bin/ISO**: Specifies the binning or ISO at which plate solve frames should be acquired.
  - **Exposure**: Time in seconds to expose the image at the designated binning.
  - **Solve And Sync**: Captures and then plate solves an image. If the solve is successful the telescope is synced to the solved location. The following confirmation dialog will show up asking if you would like to set the solved position as your reference for a given target. This is useful if you have your target framed exactly as you would like.
  - **Solve and Sync Blind**: Same as "Solve and Sync" above but uses the Astrometry.NET Web API to do a blind solve of your current position. This is useful to get your scope back on track for remote operation when you can't center a known star. However this method does require Internet access. Upon a successful solve the dialog box above will also appear and allow you
to set the coordinates for one of your targets if you would like.

- **Scope Centering:** This section contains options which relate to centering the telescope when using plate solving. Such activities include **Meridian Flip** and **Auto Center**.
  - **Center on selected target reference:** Invokes **Auto Center** for the selected target.
  - **Attempt to center X times until error is less than Y pixels:** Setting the "times" and "pixel" values here specifies how the Auto Center and Meridian Flip behave when attempting to get the scope back on target. You can set a higher attempt count if your mount has some slack in the gears. Also depending on your setup you may want higher or lower accuracy and to change that you can set the "pixels" variable.
  - **Rotator error:** The **centering process** can also attempt to rotate your camera until a particular sky angle (east of north) is achieved. If you wish for your sky angle to be 90 degrees east of north, you can set a tolerance for rotational error here. If your specified error is 2 degrees SGPro will allow 88 - 92 degrees. If you wish to have the SGPro automatically rotate your camera, you will need a **mechanical rotator**. Even if you don't have a mechanical rotator, you can still use the "manual rotator" to get your camera oriented the way you want. To make sure rotation occurs during centering, go to the **target settings** dialog and check the "Rotate to" option.
  - **Use Filter:** This will use the selected filter for each plate solve image that is acquired. If you want to use the current filter use this value unchecked.
  - **Blind Failover:** This option will allow the Astrometry.NET blind solver to function as a backup plate solver to the primary solver (Pinpoint or Elbrus). Since the local (primary) solvers can fail under a variety of circumstances, it is ideal to have this option checked so you can keep a sequence on tack (especially if you rely on unattended meridian flips or auto centering routines). **You must have an Internet connection to use this feature!**
1. Download the Elbrus Installer from our site here: [http://www.mainsequencesoftware.com/Releases](http://www.mainsequencesoftware.com/Releases)

2. When you download the Elbrus installer, you will get a zip file that contains 3 files. **DO NOT try to run the Elbrus installer from within the zip container.** Extract all three files to somewhere on your machine.

3. To run the ElbrusInstaller, find the "exe" file you just extracted, right click and select "Run as administrator".

4. In the "install location" field, choose where you want to install Elbrus. **Note: DO NOT install Elbrus into a protected directory like "Program Files" or "Program Files (x86)".** This will only cause errors later. The best place to install Elbrus is to create a folder named "Elbrus" in the root of a drive (i.e. C:\Elbrus) or in your Documents or My Documents folder and then select it as the install location.

5. Click start. This process may take up to 30 minutes depending on your connection speed. When it is complete, you should be able to use Elbrus as your plate solver from within SGPro.

Screenshot of the Elbrus Installer:

---

**Setting up Pinpoint**

**Requirements**

Pinpoint Setup is fairly straightforward, to use Pinpoint as your plate solver you will need:

- A fully licensed version of Pinpoint (not the LE version)
- One of the following catalogs:
  - GSC11
  - USNO A2.0
  - UCAC4
Setup

Select "Pinpoint" as the Plate Solving Interface on the Control Panel

Click the "Settings" button.

When the "Pinpoint Options" dialog opens enter the location of your GSC catalog.

Click "OK". Pinpoint setup is complete.

Setting up PlateSolve2

Requirements

PlateSolve2 Setup is fairly straightforward, to use PlateSolve2 as your plate solver you will need one (or both) of the following catalogs:

- APM
- UCAC3

You can download both of them from the PlaneWave website here.

Once you have your catalog(s) installed, you will need to tell SGPro where they are.

Note: You should not install the actual PlateSolve2 software. SGPro distributes its own version... downloading your own copy for use outside of SGPro is possible, but keep in mind it will have a separate configuration than the one SGPro uses.

Select "PlateSolve2" as the Plate Solving Interface on the Control Panel.
Click "Settings". You will be presented with the PlateSolve2 application:

Click "File"->"Configure Catalog Directories":

At least one catalog must be set in order to PlateSolve2 to function. That's all. Once configured, you should not need to do this again.

---

Telescopes / Mounts
Connecting and Setting Options:

Telescopes are selected and connected on the Sequence Window in the equipment group box.

Options can be set when the telescope is in a disconnected state by clicking the icon. These options will vary by manufacturer. For ASCOM telescopes this will bring up the ASCOM properties dialog for the selected telescope. This properties dialog is generally where the COM port is specified as well as other device dependent information.

To connect the telescope click on the connection icon. Once connected the icon will change, click this icon to disconnect.

Telescope Control Panel:

Description: The Control Panel provides control of the Telescope / Mount. Many of these controls are also duplicated in the Telescope Control Module and the Focus Target Module. These values can also be preset by using a profile or by opening a sequence.

Controls:

- **Current Position**: Displays where the telescope is pointed in Right Ascension and Declination.
- **Time to (this field will read “Meridian” if you are not using automatic pier flipping or “Pier Flip” if you are)**
  - **Meridian**: displays amount of time until the scope will be at the meridian given the scopes current position.
  - **Pier Flip**: displays the amount of time until a pier flip will occur if using "Use Auto Meridian Flip". This is only given for the active target.
- **Telescope Nudge**: Allows the telescope to be moved in each axis. Vertical buttons are for Declination, Horizontal are for Right Ascension.
  - **Note**: If the telescope is connected to SGPro and these buttons remain disabled, it is likely that your Telescope ASCOM driver does not support nudge outside of its own
software (meaning it does not allow for 3rd party software like SGPro to nudge).

- **Note:** Mounts only support a few ranges of movement speeds. If you ask for a selected rate and it appears to suddenly change to a new value, Sequence Generator is attempting to match your value with the closest value that your mount supports. If your mount is not connected when these values are set, then the rate match will occur when the mount connects.
- **Hi/Lo Speeds:** Changes the slew speed in degrees per second.
- **Reverse N/S & Reverse E/W:** When enabled the N/S buttons will be changed to S/N. Same for East/West.

- **Telescope Park / Unpark:** Allows you to park or unpark the mount (depending on current state)
- **Set Park:** Clicking this button allows you to set the park position of the telescope to its current position (assuming it is supported by the driver). If a dome is connected, SGPro will optionally allow you to set the park for the dome at the same time.
- **Target Markers:** Used for manually focusing when the target frame doesn't contain a sufficient star for focusing use. Here you can define a focus target and your imaging target. Using the "Go" button, you can easily navigate between the two (think of them as bookmarks). See Frame and Focus with Nudge and Setting Focus and Target Positions.
  - **Set Focus/Target Position:** Used to get the current position from the telescope and set that as the Focus or Target location. For instance to set the Focus position slew to the focus star and then click "Set". Now when you need to focus click "Go" to get back to that same location.

- **Telescope Options**
  - **Park when sequence completes:** When checked, this option will disable your autoguiding and send a park command to your mount when all events in the sequence are complete. Selecting this will de-select "Stop tracking when sequence completes".
  - **Stop tracking when sequence completes:** When checked, this option will stop the mount "in-place" when the sequence terminates. Selecting this will de-select "Park when sequence completes".
  - **Allow external control of telescope:** When checked, this option will allow for external control of the telescope via applications like Sky Safari (for the iPhone and iPad). When running, the text will indicate the IP address and port number to use as part of the settings. See the section below for more information on how to use and configure Sky Safari.
  - **Use Auto Meridian Flip:** Checking this will allow you to perform a meridian flip during a sequence based on a set of criteria which can be found in the Meridian Flip Options dialog by clicking the "Set" button:

![Meridian Flip Options](image)

- **Minutes Past Meridian to Flip:** Input the number of minutes past or before (negative values) the meridian to invoke a meridian flip during a sequence (one degree is traversed in 4 minutes). Not all telescopes allow for setting of SideOfPier. For these telescopes it is best to always use a positive value. Also, as a general note, if you are flipping after the meridian (a non-zero positive value is in this field), you are responsible for ensuring two things:
  1. Your gear will not collide with a tripod or pier if it tracks to this position
2. Your ASCOM driver will allow the mount to track this far past the meridian (if it will not, then this trigger will never fire and a flip will never occur). Each ASCOM driver is unique in the way they allow or set meridian limits. Please consult your driver's author or driver's group for more specific information on this.

- **Wait For Meridian**: Used to pause the next frame if a meridian flip would occur during that frame. This will ensure that the meridian flip happens when the "Degrees Past Meridian to Flip" is hit. For mounts that have a very narrow area that they can reach from both sides of the pier this setting is highly useful. For instance if a meridian flip would occur in 5 minutes and your next frame is 10 minutes, then this will cause the sequence to wait and not start another frame until after the meridian flip.

- **Pause Before Meridian Flip**: Will pop up a dialog before the meridian flip is executed.

- **Auto Center After Meridian Flip**: When checked, the meridian flip process will run Auto Center using a pre-flip image as the reference to get you accurately centered. The Scope Centering parameters can be setup in the [Plate Solve](#) tab.
  - **Pause Before/After Auto Center**: Pops up a dialog box after Auto Center is complete and waits on the user to continue. This is useful if you need to move counterweights after a meridian flip.

- **Rotate camera**: If this option is checked, the camera rotator will rotate the camera 180 degrees during an automated meridian flip. It should be noted that, when the telescope is on the west side of the mount, the actual angle entered that target's settings will be used. When the telescope is on the east side, the target's angle + 180 degrees will be used. This means that if you choose to simply perform a rotate option (not associated with a flip) and the mount is on the east, the camera will rotate to the target's angle + 180 degrees. **If you use this option, be you must be careful to specify an an angle in the target's settings, this option will not rotate the camera 180 degrees from the current position (before the flip).**

- **Auto meridian flip auto-close delay**: Sets the time in seconds for the Auto Meridian Flip dialog to stay open after a successful meridian flip.
  - **Sync Behavior**: Specifies how syncs will be sent to the telescope
    - **Sync**: Syncs the mount whenever a sync is requested. This is the default value and should be used for the majority of mounts.
    - **None**: Mount will not be synced under any condition.

  - **Mount settling time**: The time it takes your telescope to settle after a slew has completed. This value is currently only used during the "Auto Center" and "Center Here" processes (this will essentially be the delay between slewing and taking next image).
  - **Scope Focal Length**: This is an optional field. If you enter a value here, the FITS header "FOCALLEN" will be written to your sequence images

**Using Sky Safari (for iPhone, iPod, iPad and Android):**

In order to control a telescope connected to Sequence Generator Pro via Ski Safari, open telescope settings and enter the following configuration parameters (iPad pictured below):

- **IP Address**: The IP address of your machine (this is displayed in the telescope tab when the listener is enabled). See screen shot above.
- **Port Number**: The Port number for the listener (this is displayed after the ":" in the IP address (above).
- **Set Time & Location**: Recommended to set to OFF. Setting this to ON will update your scopes time and coordinates what that of your device's. If you already have a pointing model setup this may cause it to reset or to be skewed.
- **Readout Rate**: Reduce this number if Sky Safari seems too sluggish when connected.
- **Scope Type**: Regardless of the scope you are using, this should be set to "Meade LX-200 GPS"
Using EQMOD with SGPro

While SGPro can theoretically work with any ASCOM compliant mount. EQMOD, however, presents some difficulties in terms of its own internal complexities. This section of the help file is intended to get users into a state where they can successfully use SGPro's automatic centering and flipping features with an EQMOD driven mount.

Note: As of this writing, the only version of EQMOD currently supported by SGPro is version 1.28m. This version of EQMOD is not officially supported by the EQMOD group (still in a beta state) and must be downloaded in the files section of the Yahoo! group (you must be a member of the group).

Note: These screen shots and instructions are taken using the EQMOD simulator. While your experience will likely be nearly identical, you will need to choose the appropriate "non-simulator" option in the SGPro drop-down menu.

So... here are the steps...

EQMOD setup:

Prior to connecting, select EQMOD in the SGPro telescope drop down menu and then click the "settings" button next to it (Note, do not select the simulator... we have selected here for illustrative purposes only):
First, set "SideOfPier" to "Pointing":

In the "General Options" section, ensure that "Allow Auto Meridian Flip" is not checked.
That's it for setup. Now go ahead and connect the mount by clicking the green connect button in SGPro.

When the EQMOD "connected" dialog appears, click the "wrench icon":

Next, clear / disable any pointing models:
Clear out any point data the mount may have collected. To do this **click the button with the red “X” on it** and ensure the “Point Count” is “0”. Last, clear any “Sync Data” by **clicking the “Dx” button with the “X”:**

Next, set the User Interface to “Dialog Based”:

Now it’s time to make your mount is safe, but still allows SGPro to perform a flip. In SGPro you will be setting your “Flip When” value to some value on the west side of the meridian. You will then need to make sure that EQMOD actually allows the mount to track that far (with some amount of error) AND also keep your gear safe (prevent it from colliding with a pier or tripod). In order to accomplish this:

In SGPro, go to the Control Panel, then the Telescope tab. **Click the “Set” button**, next to “Use Auto Meridian Flip”: 
In the "Minutes Past Meridian to Flip" field, enter a low positive value (like 4 minutes for 1 degree or 8 minutes for 2 degrees past). Once this is set, it's time to make sure EQMOD will allow the mount to track to the SGPro trigger point. To do this, find the "Mount Limits" section, check the "Enable Limits" option, then click the "Wrench Icon".

Setting the new limits for EQMOD is a process of actually slewing the mount to the eastern and western limits (past the SGPro trigger). You will want to temporarily disable any EQMOD limits in order to do this, then remember to re-apply them. This video here does an excellent job of explaining how to set "extended limits" in EQMOD:

EQASCOM Video detailing modification of mount limits

It is good to watch the entire video. That said, the part that applies to this help file starts at 3:40 (3 minutes and 40 seconds into the video).

Once you are done with this, you should be in pretty good condition to attempt your first automated meridian flip. More information from the SGPro side is here.
Flat Boxes are selected and connected on the Sequence Window in the equipment group box.

Flat Boxes are in the "Extended" equipment list and as such you will need to click the down arrow below the telescope to access the Flat Box connection settings.

Options can be set when the flat box is in a disconnected state by clicking the icon. These options will vary by manufacturer. This properties dialog is generally where the COM port is specified as well as other device dependent information.

To connect the flat box click on the connection icon. Once connected the icon will change , click this icon to disconnect.

**Flat Box Control Panel:**

*Description:* The Control Panel provides control of the Flat Box. These values can also be preset by using a profile or by opening a sequence.

- **Brightness Slider:** Allows you to manually set the brightness of the flat box
- **Shutter Control:** Allows you to manually open and close the flat box (on supported models)
- **Prompt to place flat box:** If this option is checked, SGPro will pause the sequence and prompt you to place your flatbox before commencing with flats.
- **Adjust flat box settings per filter:** This part of the control panel allows you to manually manipulate your flatbox settings. It does not adjust how your flatbox behaves during a sequence. In order to adjust those parameters, click this link. You will then be presented with the standard filter wheel setup dialog. Find the filter you would like to adjust and click the "Flats" button:
When you click the "Flats" button you will see a dialog like this:

From here, you can enter the flat box's brightness for that filter at a particular binning. These are the settings that will be used by the sequence when it is running. For example, if you are having the sequence capture flats for the red filter at 2x2, both the exposure length and flatbox brightness need to be set in this dialog for that filter. Keep in mind that once you have this data, you should save it into an equipment profile so that you do not continually need to fill these forms out prior to a sequence.

Other Information:
- For flat boxes that implement a shutter (i.e. the Alnitak Flip Flat) the flat box will be automatically
Sequence Generator Pro

closed and powered on for sequences that contain flats and have been through the Flats Calibration Wizard. In addition, these types of flatboxes will automatically close their shutter when a sequence ends.

- Selecting "Manual Flat Box" will prompt you to install/remove the flat box for sequences which contain flats. Also if you have previously used the Flats Calibration Wizard you can also store brightness values for your flat box.

Manual Flat Box

Description: The "Manual Flat Box" is used if you have a flat box that is not computer controlled, but still want to have the benefit of the sequencing, file naming, and FITs headers found within Sequence Generator Pro.

You can select the "Manual Flat Box" from the Flat Box drop down of the sequencing window.

![Manual Flat Box Dialog]

You may setup the "Manual Flat Box" just like a normal flat box in the Filter Setup dialog.

Whenever a brightness change is requested a dialog box will pop up asking you to manually set the brightness the the value you've entered:

![Set Flat Box Brightness to 1]

This dialog will pause the sequence and any other actions currently taking place until "OK" has been clicked.

Rotators

Connecting and Setting Options:
Rotators are selected and connected on the Sequence Window in the equipment group box.

Rotators are in the "Extended" equipment list and as such you will need to click the down arrow below the telescope to access the connection settings.

Options can be set when the rotator is in a disconnected state by clicking the icon. These options will vary by manufacturer. This properties dialog is generally where the COM port is specified as well as other device dependent information.

To connect the rotator click on the connection icon . Once connected the icon will change , click this icon to disconnect.

A camera rotator can be especially handy when using the Framing & Mosaic Wizard. This add on can require your camera to be at almost any angle to get your image framed properly. In addition to actual mechanical camera rotators, you can use a Manual Camera Rotator which takes advantage of plate solvers and give you iterative adjustment instructions until your camera is properly positioned.

**Rotator Control Panel:**

- Position: The angle (positional angle) of the rotator (Note that image angle in SGPro are standardized on east of north / counter-clockwise of north. Because angle can be given from any relative orientation in other apps, we recommend that you use angles only from plate solves conducted in SGPro).
- Set Position: Sets the position of the rotator (between 0 and 360)
- Zero: Returns the rotator to the "Zero" or "Home" position.
- Manual Sync: Override the reported position with an actual position:
- Stop: Will stop any current rotator movement.
- Reverse corrections for Manual Rotator: Checking this will reverse the direction the Manual Rotator asks to move your camera. This is required is your gear combination creates a "flipped" image.

Manual Rotator

Description: The manual rotator is used to ensure your camera is properly positioned before capturing data on a target. In the target settings dialog you can specify that a target's camera angle should be verified prior to starting. If this box is checked and you have selected the "Manual Rotator", you will receive a series of prompts that help you to properly position your camera. It should be noted that you must have a plate solver set up and in use for the Manual Rotator to function properly.

For instance, if your current camera angle is 15 degrees and your target requires 30 degrees, you will be prompted with a dialog similar to:

Note: If the direction you are prompted to move is opposite the actual movement required, be sure to check the "Reverse corrections for Manual Rotator" on the Rotator Control Panel.

Note: For more information on how to use rotators with your sequence, see the Automatic Camera Rotation section.

Observatories

Connecting and Setting Options:
Observatories are selected and connected on the **Sequence Window** in the equipment group box.

Observatories are in the "Extended" equipment list and as such you will need to click the down arrow below the telescope to access the connection settings.

Options can be set when the observatory is in a disconnected state by clicking the ![icon](image). These options will vary by manufacturer. This properties dialog is generally where the COM port is specified as well as other device dependent information.

To connect the observatory click on the connection icon ![icon](image). Once connected the icon will change ![icon](image), click this icon to disconnect.

**Observatory Control Panel:**

- **Azimuth:** The current azimuth that the dome shutter is located at. If your observatory is a roll off roof or does not provide the ability to slew in azimuth this value will be "NA"
- **Shutter:** The current state of the shutter or roof
- **Left & Right Arrows:** If your observatory can slew in azimuth these arrows will be available. The center number is the amount of degrees to slew in one click.
- **Close Shutter:** Closes the shutter or roof
- **Open Shutter:** Opens the shutter or roof
- **Goto:** If your observatory can slew in azimuth this option will be enabled and will bring up the dialog below in which you can slew the azimuth to a specific angle:
Sequence Generator Pro

- **Sync**: If your observatory can slew in azimuth this option will be enabled and will bring up the dialog below in which you can sync the dome azimuth to a specific angle:

![Dome Sync dialog](image)

- **Stop**: Issues a command to the dome to stop all movement immediately. Depending on your dome's implementation this functionality may vary.
- **Slave to telescope**: When checked, the dome will be moved to keep the telescope looking through the slit of the dome. This needs to be setup using the Slave Settings dialog.
- **At Home to Open / Close**: Because some domes only provide power to the shutter while in the home position, the observatory can be instructed to attempt shutter open / close operations only while in this position.

---

**Slave Settings**

Description: The Observatory Settings (Slave Settings) dialog is used to define how the observatory will be slaved the telescope position. It defines parking as well as settings to slave the dome slit to the telescope.

- **Observatory Type** - Defines the type of observatory. Options are "Dome" and "Roll Off Roof". When "Roll Off Roof" is selected the "Dome Geometry" section will not be accessible.
- **Dome Geometry** - These settings are used to provide positional information when slaving the dome. The units are not important provided that all measurements use the same type of units:
  - Diameter at Equator - The diameter of your dome at the equator. This should be measured from where your slit opening is. For example if your dome is skinned on the outside you would measure from the outside diameter. If it is skinned on the inside you would measure the inside diameter.
  - North Offset - The offset from the center of intersection of the Right Ascension and Declination axis to the center of the dome. If the RA/Dec intersection is north of the dome center this value is positive. If the RA/Dec intersection is south of this location the value should be negative.
  - East Offset - The offset from the center of the intersection of the Right Ascension and Declination
axis to the center of the dome. If the RA/Dec intersection is east of the dome center this value is positive. If the RA/Dec intersection is west of this location the value should be negative.

- **Vertical Offset** - The offset from the center of the intersection of the Right Ascension and Declination axis to the center of the dome. If the RA/Dec intersection is above the dome center this value is positive. If the RA/Dec intersection is below this location the value should be negative.

- **GEM Offset** - The distance from the center of the Right Ascension axis to the center of the telescope. This value can vary depending on how your scopes are setup on your mount. It is best to use some trial and error here. If the top of your scope is being eclipsed by your dome increase this value. If the bottom of your scope is being eclipsed decrease this value.

- **Update Frequency** - Number of seconds to wait between slew commands. This also will depend on your Allowable Error (below).

- **Allowable Error** - Number of degrees from where the dome azimuth can be from the calculated ideal position. This will depend on the width of your slit as well as position in the sky.

- **Slaving Options** - These options control special events with respect to parking and unparking of the mount.
  - **Slave on Sequence Start** - This will cause the dome to automatically slave itself to the telescope (follow the telescope) when the sequence starts. This is equivelent to clicking the "Slave to telescope" box in the control panel.
  - **Park Observatory With Mount** - This will cause the observatory to park and unpark when the mount parks and unparks. The Park and Unpark must come from Sequence Generator Pro to be captured. If the park status of the mount changes outside of Sequence Generator Pro the observatory park status will not be updated.
  - **Mount Unpark Opens Shutter** - When the mount is unparked the shutter or roof will be opened
    - **Open Shutter First** - This will cause the shutter/roof to open prior to unparking the telescope. Useful for Roll Off Roof designs where the telescope needs to be horizontal to allow for roof clearance. *WARNING - Using this option to open your roof prior to unparking your mount is very risky! It is highly recommended to have other fail safe mechanisms in place that will prevent your roof from coming into contact with your telescope. Main Sequence Software will not be held liable for any equipment damage.*
  - **Mount Park Closes Shutter** - When the mount is parked the shutter or roof will be opened
    - **Park Mount First** - This is used to park the mount before parking the observatory. *WARNING - Using this option to park your mount before closing your roof is very risky! It is highly recommended to have other fail safe mechanisms in place that will prevent your roof from coming into contact with your telescope. Main Sequence Software will not be held liable for any equipment damage.*

It should be noted that when a slew is issued through Sequence Generator Pro that the slaving code will attempt to make an educated guess about what side of the meridian the scope will end up on. Unfortunately there is no way of knowing which side of the meridian the scope will actually end up on for items that are very close to the meridian. Sequence Generator Pro always assumes that the mount will end up on the opposite side of the pier from where it is pointing. For instance if the object is West of the meridian the scope will be assumed to be on the east of the meridian. However if this guess is incorrect the dome will be properly adjusted when the next update as it will use the side of pier obtained from the mount. For this reason it is beneficial to set your mount driver to disallow slewing to the same side of the meridian that the scope is currently on.
Safety monitors are selected and connected on the **Sequence Window** in the equipment group box.

Most Safety Monitors give you an idea of imaging safety by continuously analyzing the weather. That said, a safety monitor can technically analyze anything (weather or other) and provide data to SGPro that indicates if it is unsafe to continue imaging.

Safety Monitors are in the “Extended” equipment list and as such you will need to click the down arrow below the telescope to access the connection settings.

Options can be set when the safety monitor is in a disconnected state by clicking the icon. These options will vary by manufacturer. This properties dialog is generally where the COM port is specified as well as other device dependent information.

To connect the Safety Monitor click on the connection icon. Once connected the icon will change , click this icon to disconnect.

**Safe/Unsafe Status:**

The current Safety Monitor implementation relies on the ASCOM "Safety Device" which supports a single status of Safe or Unsafe. When the device is reporting Safe everything operates as normal. When the device reports Unsafe the End of Sequence options are executed. **This is true even if the sequence is not running.**

The "End of Sequence" options are set on different devices. For instance when the sequence ends due to an unsafe condition you may want to:

- Warm up your camera (turn off the TEC)
- Park your telescope
- Close your observatory.

These settings can be found in each of the device options in the Control Panel. **You should note that the observatory must be slaved to the mount to close as the observatory open/close is tied to the mount unpark/park event** and can be setup in the **Slave Settings** for the observatory. Likewise you must also select to have the mount **park when sequence completes.**

**Viewing Status:**

The safety status can be seen in the bottom right notification area of Sequence Generator Pro.
Unsafe:

Note: The safety monitor will not truly be active until the first frame from the first target begins. If there is a period where SGPro is idle prior to sequence start, SGPro will ignore any unsafe events until the first target's start time passes.

Environment Devices

SGPro supports input from several environment monitoring devices (you can only use one at a time). The data collected from these devices is mostly used as direct input to the user (meaning that not much of the input will affect the way in which SGPro operates). To select a device in a sequence, you will need to extend the device area in the sequencing window and locate the drop down box labeled "Environment".

Options can be set when the environment device is in a disconnected state by clicking the icon. These options will vary by manufacturer. For ASCOM devices, this will bring up the ASCOM properties dialog for the selected environment device.

To connect the device click on the connection icon . Once connected the icon will change , click this icon to disconnect.

Currently, SGPro only supports ASCOM 6.2 "Observing Conditions" compliant devices. TEMPerHUM, an exception to this statement, is also found in this drop down menu, but is not officially supported in any capacity.

When you select and connect to a device, you will be able to see data it reports on in the "Environment Data" docking module. You can click the "cloud" icon to view this docking window. More information can be found here.

With respect to auto focus, SGPro supports "temperature based triggers" (meaning you can choose to auto focus if the temperature drops by 1 degree). Many users simply use the temperature reported by their actual focus controller to control this trigger. Others do not have a focus controller that reports on temperature or simply wish to use input from the environment device because placement of their focus controller might affect its ability to report correctly on temperature change (like if it's stored in a warm power box or
something similar).

In order to use the environment device's temperature to control auto focus triggers, you need to open the control panel, navigate to the "Focus" tab and then click the "Other" button.

![Focus panel](image)

Then is the dialog presented, ensure the proper checkbox is selected:

![Focus settings](image)

Of course, this can all be setup in you equipment profiles so you don't need to worry about it for your new sequences.

Lastly, if you use the notification system, the environment device will alert you when (a sequence must be running or no notification will be issued):

- The temperature is within 4 degrees of freezing
- Dew is about to start forming (the dew point is within 6 degrees of the dew point with a downward trend or if you are within 2 degrees of the dew point, regardless of trend)

---

Created with the Standard Edition of HelpNDoc: [Free iPhone documentation generator](http://www.helpndoc.com)

**Sequencing**

Sequencing plays a large part in Sequence Generator Pro (it gets part of it's name from it!) The ability to quickly setup sequences using profiles and have all your stored settings right where you need them makes starting an imaging session extremely easy. Plus you can create sequences ahead of time and load them when you're under the stars and ready to begin your imaging for the night.
The sequencing of complex capture events is one of the most powerful aspects of Sequence Generator Pro. With it, you are capable of stringing together a variety of events ranging from capture of light frames all the way to "in-sequence" park events. Additionally you are able to save sequences for use later (meaning you can think about and create your capture events the night before and then when you are in the field, simply
open your sequence and begin). Specifically the sequencer will allow you to:

- Save, open and edit sequence files
- Design complex file naming patterns to suit your needs
- Design a sequence for multiple targets
- Allow for pre-sequence or between frame delays
- Run events in a rotation or until they are complete
- Allow for the creation of image capture events (light, dark, bias, flats). You can specify:
  - Specify filter
  - Exposure count
  - Exposure duration
  - Naming suffix
  - Binning (or ISO)
- Additionally, you can define events that will perform in-sequence parking of the mount or pausing

Sequence Options

SGPro offers some sequence that are unique to the entire sequence (meaning they do not apply to a single target, event or frame). The options can usually be found in the options dialog, but for convenience, some can be found here:

- Run non-light subs even if sequence fails: This will capture flat, dark and bias frames even if the sequence fails to complete. More detail about this option can be found here.
- Global end sequence time: If this option is checked it will force the sequence to end at that time. This end time takes precedence over any start or end times set at the target level. No date is required for the end time. This means that you are not required to update the date when using the sequence over multiple nights. This also means that SGPro must infer a date based on the time you entered. The inference system is fairly simple... sequences run in what is referred to as a "sequence day"... a period of 24 hours that spans from 0900 to 0900. The dates attached to those time will either be yesterday and today or today and tomorrow. This decision is made based on when you click the "Run Sequence" button. The end time also has a helpful indicator after that time that will read either "yesterday, today or tomorrow". This is to be interpreted as: The sequence end time will be at 06:01 tomorrow if you click the "Run Sequence" button right now. Examples:
  - For a target that ends at 22:00, starting the sequence at 22:15 will skip this target, the sequence day will be 0900 today through 0900 tomorrow and the end time at 22:00 will be in the past. Conversely, starting at 21:45 would place the 22:00 end time in the future. Starting
the sequence at this time will produce the same "sequence day".

- For a target with an end time at 05:00, starting the sequence at 16:45 (more than 12 hours before the intended end time), the sequence day will be 0900 today to 0900 tomorrow and the end time of 05:00 will be in the future (this is the same example as above really... just illustrating that it still works when you are more than 12 hours away from the intended end time.

- For a target with an end time at 22:00, starting the sequence at 01:00 will create a "sequence day" from 0900 yesterday to 0900 today. The end time of 22:00 will be assigned to the only 22:00 that occurs in this sequence day (yesterday), and will be skipped.

Target List and Settings

The Target List shows all targets for the current sequence (it will scroll when you have more than 5).

Icons

- **Pause Icon**: The target is not currently running, but has uncompleted work.
- **Play Icon**: The target is currently running.
- **Check Icon**: The target is complete.
- **Gear Icon**: Accesses the target's settings (see below).

Action Buttons

- **Adding a New Target**: To add a new target simply click the "+" button and a new target will appear.
- **Deleting a Target**: To delete a target, click on a target, then click the "x" button.
- **Moving a Target**: To Move a target, first select it and then click the up or down arrow.
- **Settings**: To get to the target's settings, click the gear icon to the right of each target name.

Sequence Notifications

SGPro has many notification messages that take place outside the context of an "event". These notifications are similar to event level notifications, but they are representative of all sequence notifications. This notification area will collect and aggregate messages from all events and, in addition to this, show messages for actions that are outside the context of an event (like issues with auto focus, centering or meridian flips). When the icon is "gray" (pictured below) it means that there are either no sequence notifications or that there are no new sequence notifications (since the last time you looked). If the icon is "solid" it means you have new notifications to look at. Notifications are saved with the sequence... they will be present if the sequence is closed and re-opened.
Clicking on the icon presents a window that shows the notification messages. Optionally, you can clear this list if you'd like.

Target Actions

There are several actions that can be performed on targets by right clicking on them.

- **Select All Targets**: Checks (selects) all targets in the list.
- **Deselect All Targets**: Unchecks (deselects) all targets in the list.
- **Move Up/Down**: These actions are identical to the arrow buttons (Moving a Target) described above (they alter the target order).
- **Duplicate Target**: Create another target with settings and events identical to the selected target.
- **Delete Target**: This action is identical to the "X" button (Deleting a target) described above.
- **Reset Progress**: This will reset the progress of all events in the target and mark the target as incomplete (if it was previously complete).
- **Clear Completed Status**: When a target stops (for any reason) and moves onto the next target, it is considered "done". If you want to add more events to a "done" target and then make it eligible for execution again, you will need to clear its "done" status. See sequencing for more information.
- **Center on Target**: This will perform a precision centering of the telescope on the target's location (see below). For more information on centering, click here.
- **Slew to Target**: This will perform a low precision, standard telescope slew to the position defined in the location section.
- **Rotate Camera**: This will rotate the camera to the angle specified in the "On start, rotate to" field (see below)
- **Center Target & Rotate Camera**: This will simultaneously perform these two operations (see above)
- **Copy Events From**: This will allow you to copy all of the events from another target to this target.
- **Copy Events To**: This will allow you to all of the events from this target to many other targets. This is very useful in situations where many targets have the same general composition of events (like when the mosaic wizard creates a sequence)

**Target Settings**

Settings can be accessed by clicking the gear icon or by right clicking a target and then clicking "Target Settings".

Each target has settings that will alter the behavior of the sequence. In addition, you will find several manual actions here (like slewing and centering).
**Name:** This is the name of the target and is what will be displayed in the Target List. This is also the name that will be used when %tn is defined as part of the target name. Note that, within a sequence, target names must be unique.

**Center on when target starts:** If this option is checked, the sequence will automatically attempt to center the image on the defined location. In order to use this feature, you must have a plate solver and telescope connected. If you are guiding with PHD2, the sequence will attempt to stop and restart guiding automatically (on the new target). For more information on auto centering, click here.

**Slew to when target starts:** It is possible to simply slew to the target's location without going through a centering routine. Due to imprecise polar alignment, bad modeling data or mechanical imprecision, this will likely not get you pointing to where you want to be at for imaging. Using this can very easily yield a series of frames unsuitable for stacking.

**Location:** This is the exact location of the target's center. It is required if "Center On" or "Slew To" is checked. You can use the "Solver" tools to help populate this data (plate solving images, getting location data from the Internet, etc.). These fields are "free text" and will accept quite a large variety of formats (e.g. "20h58m54s +43°51'46" or "20:58:54 -43:51:46" or even decimal forms like 20.92). You can also paste text containing both RA and DEC into the RA field and it will properly populate both fields (most of the time... currently copying and pasting target data from Cartes du Ciel and Stellarium are known to be working, just copy the buffer into the "RA" field and SGPro will try to sort it out for you).

- **Populate from web link:** Click this to auto populate the location fields with data from Astrobin or Flickr.

**Slew Now:** This will perform a low precision, standard telescope slew to the position defined in the location section.

**Center Now:** This will perform a precision centering of the telescope on the target's location. For more information on centering, click here.

**Start Capturing:** When this is checked, the target will not commence capture until the time constraint is met. This means that the sequence may sit idle for a bit (mount will still track). No date is required for the start time. This means that you are not required to update the date when using the sequence over multiple nights. This also means that SGPro must infer a date based on the time you entered. The inference system is fairly simply... sequences run in what is referred to as a "sequence day"... a period of 24 hours that spans from 0900 to 0900. The dates attached to those time will either be yesterday and today or today and tomorrow. This decision is made based on when you click the "Run Sequence" button. The start time also has a helpful indicator after that time that will read either "yesterday, today or tomorrow". This is to be interpreted as: The target start time will be at 07:24 today if you click the "Run Sequence" button right now. See the end sequence docs below for a couple examples of how time works within the bounds of a "sequence day".

**End Capturing:** When this is checked, the sequence will quit capturing frames for this target at the specified time (regardless of work remaining). At this point the next target in the sequence will run. No date is required for the end time. This means that you are not required to update the date when using the sequence over multiple nights. This also means that SGPro must infer a date based on the time you entered. The inference system is fairly simply... sequences run in what is referred to as a "sequence day"... a period of 24 hours that spans from 0900 to 0900. The dates attached to those time will either be yesterday and today or today and tomorrow. This decision is made based on when you click the "Run Sequence" button. The end time also has a helpful indicator after that time that will read either "yesterday, today or tomorrow". This is to be interpreted as: The target end time will be at 23:46 today if you click the "Run Sequence" button right now. Examples:

- For a target that ends at 22:00, starting the sequence at 22:15 will skip this target, the sequence day will be 0900 today through 0900 tomorrow and the end time at 22:00 will be in the past. Conversely, starting at 21:45 would place the 22:00 end time in the future. Starting the sequence at this time will produce the same "sequence day".

- For a target with an end time at 05:00, starting the sequence at 16:45 (more than 12 hours before the intended end time), the sequence day will be 0900 today to 0900 tomorrow and the end time of 05:00 will be in the future (this is the same example as above really... just illustrating that it still works when you are more than 12 hours away from the intended end time.

- For a target with an end time at 22:00, starting the sequence at 21:00 will create a "sequence day" from 0900 yesterday to 0900 today. The end time of 22:00 will be assigned to the only 22:00 that occurs in this sequence day (yesterday), and will be skipped.
• **Automatic camera rotation:** This option will force the sequence to alter the angle of the camera prior to starting the target. More information on this can be found [here](#). A target angle can have two different meanings. The default is "+- 180 degrees". This means that if you enter 15 degrees for the target, either 15 or 195 degrees is OK. Switching sides of the meridian will also experience no change in camera rotation. This is just fine for most folks as processing software will take of the stacking and, even better, you will only need one set of flats. The other option is "Always". This means that the sequence will keep the camera angle at the angle you entered no matter what. So, if you flip, the camera will actually rotate 180 degrees to maintain that exact angle. This can be useful to keep the same guide star (OAG) in the CCD’s FoV, but will require 2 sets of flats.

---

**How the Sequence Selects Work**

This section is intended to clarify how Sequence Generator Pro selects work during sequence execution:

### Parts of a Sequence

A sequence consists of three hierarchical components:

- **Targets**: These are at the highest level. A sequence may contain many targets.
- **Events**: Each target can contain many events. An event characterizes how a target is captured. An example of an event is "Light frame using the red filter at 2x2 binning".
- **Frames**: Each event can contain many frames. A frame is best characterized as an individual image that contains properties as set forth in its parent event.

### Selecting Work

Execution of a multi-target sequence can be straightforward if it remain static during data capture. When you decide you want to alter the ordering of targets or events in real time, you might observe unexpected behavior if you are not familiar with the sequencing rules.

#### Basic Rules

The simplest multi-target sequence will function as follows:

- Work is selected based on the order of the targets, from top to bottom (unchecked targets are considered inactive and will not be selected for work).
- A target consists of N events. Each event in the target will be executed in order (depending on event ordering options).
- When a target's events are completed, that target is marked as such (with a checkmark icon) and the sequencer will move to the next active target in the list. It is important to note that a target can be marked complete with remaining frames to capture... typically when a target reaches its user defined end time. Once this happens, this target will never be selected to run until the sequence is reset or its "completed" status is cleared.

This basic set of rules gets a bit more complex when you decide to alter the sequence in real-time. Here are some rules that are good to understand:

- **Moving targets**: In general, targets operate using the "sticky target" principle. This means that once a target starts, it will generally finish before moving on to another target. This includes targets that are moved above the currently running target. Suppose you have two targets (target 1 and target 2) and target 1 is running. If you then decide to alter the order of the targets and place target 2 above target 1, target 1 will continue to run until it is finished, then it will run target 2. If you wish to run target 2 immediately, you can either reset the sequence or uncheck target 1 (abort the sequence if you want to do this immediately). Unchecking target 1 will cause the sequence to look for other work and target 2 will be selected (it is now ahead of target 1).
- **Completed targets**: When a target completes all of its events, it will be marked as completed. Being
marked as completed is temporary and applies only to the current run. Completed targets may be modified, but will not be considered for work during this run. This means that if you add two new frames to a completed target, the sequence will be “complete” even though it has not attempted to capture the new frames. Completed targets have a checkmark icon to the left of the target name.

Typical use cases:

- A sequence with two targets: Simply add one additional target and use each target's settings to provide a unique name. Select each target and provide events as appropriate. When you run the sequence, the top-most event will run until completion. When it finishes, the next event will run and then the sequence will be complete.

- A sequence with two targets and an early end time for target 1: This is useful if target 1 sets early and, instead of figuring out in advance, how much time you have available, you can just ask the sequence to capture as much data as possible for that target until a specified end time (found in the target's settings). This is essentially the same process as described above, except that target 1 will use an end time.

- A sequence with two targets and an early end time for target 1 and a delayed start for target 2: This is the same as the scenario directly above, except that when target 1 ends early, target 2 will delay start until the specified start time.

Special use cases:

- Forcing a moved target to run immediately: As mentioned above, targets operate using the "sticky target" principle (see Moving Targets above). There may be times where you don't want the currently running target to finish before moving to the target you just re-ordered (above the currently running target). In order to do this, you can either reset the sequence or perform the following operations:
  - If you want to run the reordered target immediately, abort the sequence (otherwise skip this step and the new target will run after the current frame completes)
  - Move the desired target to the top of the list
  - Uncheck / deactivate the currently running target (now below the reordered target)
  - If you aborted the sequence, run it.
  - The sequence will now select new work from the top of the list.
  - After the new target is selected, you can optionally re-check the original target if you want the sequence to revisit that work later.

Example: A sequence contains targets for Horsehead, M42 and the Rosette nebula (in that order). You start the sequence and then realize you wanted to start with M42 first. Unfortunately, the Horsehead target has already started and, as a result of this, it is "sticky". This means that any attempt to simply re-order the targets (even if you pause and restart) will result in the Horsehead target running to completion. In order to force M42 to run, you will want to abort the sequence, move M42 above Horsehead, un-check Horsehead (this will remove the "sticky"), restart the sequence and then finally re-check Horsehead so it will be picked up after M42 completes. Of course, this is only an example to illustrate how to do this, if you haven't really gotten too far into a sequence, the best option would likely be to reset the sequence.

- Forcing modified completed targets to run: As mentioned above, completed targets are no longer considered for selecting work. There may be times where you want to modify a completed target and force it to run. It should be noted that resetting a sequence will automatically make any new work valid for selection. When faced with this situation, you can open the target's setting and check the box labeled "Clear completed status". After clicking ok, that target will no longer be in a completed status and will be eligible for work.

Example: A sequence contains targets for Horsehead, M42 and the Rosette nebula (in that order). Horsehead runs until completion and the sequence moves on to M42. During acquisition of M42, you realize you want to capture some more frames for Horsehead. You move to the Horsehead target add a few more frames, but the target is still marked as complete. Under normal circumstances, you can't add more work to completed targets. But... if you really want to force the sequence to consider the new
work for this target, you will need to open the settings for Horsehead and check the "Clear completed status" option. After clicking "OK", the target's icon will change from the completed check-mark icon to the pause icon. After M42 completes, the sequence will actually go back to Horsehead and finish your new frames (any target options like "center on when target starts" are applicable in this case).

When the sequence begins capture of a target it will continue its execution until it is done. That is to say that the sequencer will not select work between targets during execution. If you are using an event rotation option in a sequence that has multiple targets, the sequence will not rotate through all events in the sequence, but rather rotate through all events in the target and then move to the next target.

The sequencer selects works in a hierarchical manner. That is to say that it will always consider events on the target in the highest (top-most) position first. If you have defined multiple targets, the sequence will start executing events from the "top-most" target and finish with events in the "bottom-most" target. This logic will always remain true, even if you reorder the targets. For example, if you have three targets and run half of the events in the top-most target, pause, move target 2 to the top-most position, target 2 will start up when the sequence is resumed and the next available event for target 2 will begin to run. Targets can be re-ordered in real time and the same rules will apply (in this case the current event will always finish). If you pause and resume the sequence in such a way that does not cause the current / next target to change (i.e. run pause / resume with no target reordering), then the sequence will resume where it left off (i.e. same target, next event).

Targets and events that are not "checked" will not be considered for work.

Resetting the Sequence

There are several ways you can alter the state and progress of a sequence. See here for more details.

Target Data / File Naming

The data options block allows you to specify the way in which you expect your image data to be saved to disc.

Selected: Indicates the currently selected target. You can select a target from the target list to the left.

Running: Indicates the running target. If the sequence is stopped, this will indicate "None"

Directory: Specify the location where you would like your data saved. The file pattern will be applied at this location.

File Name: This is a pattern based approach to naming files. The options (below) can be found by clicking the "Key" button and you can preview how your file names will look by clicking the magnifying glass icon.

Expanding the Target Data Area

Clicking the small button with the down arrow will expand the Target Data area and reveal more options:
**User Profile:** The user profile to use with this sequence. User profiles contain information about users and location and the sequence will, when saving images, ensure that this information is entered into the FITS header. A user profile is not required.

**Pattern Notes (see "File Name" above)**

When creating a pattern there are three important things to remember:

- You can use the "\" separator to create sub-directories under the specified Directory field (above). In the screen shot above, the "Frame Type" (%ft) is used to create a sub-directory like "Light" underneath "Z:\Pictures\AP\sgest".
- You can use any characters that are legal for naming files. This means that if you specify a string of characters that are not a valid pattern match then they will be included in every file name in a static way. For instance if you take the pattern specified in the screen shot and the string "_TSP" to the end you image file names would appear as something like "M51_600_1x1_L_Frame1_TSP.fit"
- The target name (%tn) is defined in the target options dialog.

**Key**

- %tn = Target name (as is)
- %ca = Camera Name (as is)
- %ct = Camera temperature (inserted as #.##C)
- %ft = Frame type (Light, Dark, etc...)
- %el = Exposure length (as NNNN/sec)
- %es = Exposure seconds (as NNNN)
- %bi = Binning (as is, i.e. 1x1)
- %is = ISO (as ISOXXX; DSLRs only)
- %fl = Filter number (as filterN)
- %en = Event number (eventN)
- %fn = Frame number (as frameN)
- %fz = Frame number (as frameNNNN, padded 0's)
- %su = Suffix (as is)
- %dt = Date (as MM-DD-YYYY)
- %d2 = Date - 12 hrs (as MM-DD-YYYY)
- %yy = Year (inserted as YYYY)
- %mm = month (inserted as MM)
- %dd = day (inserted as DD)
- %dy = day - 12 hrs (inserted as DD)
- %tm = time (inserted as HHMMSS)
- %ps = pier side (as sop-east or sop-west)

Note: Directories can be inserted as part of the pattern (i.e. %ft\%bn\%bn\_%su\_es\_%fn)

---

**Delay and Ordering Options**
These options apply individually to each target (i.e. each target can specify their own order or delay).

**Delay Options:**

*Delay first:* Specify the delay, in seconds, prior to executing the first event in the target

*Delay between:* Specify the delay, in seconds, that should be honored between every frame in the running target

**Event order:**

*Rotate through events:* Selecting this option means that the sequence will rotate through event until complete. If you have multiple targets, this option will rotate through events only in the current target.

(Example: Events 1, 2 and 3 are active and each requires 3 frames to complete. The frame order will be 1,2,3 - 1,2,3 - 1,2,3.)

*Finish entire events first:* Selecting this option means that the sequence will complete entire events prior to moving to the next.

(Example: Events 1, 2 and 3 are active and each requires 3 frames to complete. The frame order will be 1,1,1 - 2,2,2 - 3,3,3.)

**Notes:**

1. This ordering affects only events within a target. See [this section](#) on how Sequence Generator Pro selects work for more information.
2. This section applies to the sequence (i.e. different targets cannot have different ordering or delay options).

---

### Sequence Status

<table>
<thead>
<tr>
<th>Sequence Status</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Remaining time:</td>
<td>00:00:00</td>
</tr>
<tr>
<td>Elapsed time:</td>
<td>00:00:06</td>
</tr>
</tbody>
</table>

The sequence status will provide insight into the total event progress across all targets. It provides:

- **Remaining time:** This is an estimate of time remaining (It should be noted that this time does not account for overhead accrued by download time, pausing, running auto focus or any other activity that it outside the context of image integration time)

- **Elapsed time:** The time that elapsed since starting the sequence run

---

### Target Status

---

87 / 209
The target status will provide insight into the event progress for a given target. It provides:

- **Total events complete**: Of the "active" events, what fraction have been completed
- **Total frames complete**: This is a sum of all frames from all "active" events and shows the total fraction completed
- **Remaining time**: This is an estimate of time remaining (It should be noted that this time does not account for overhead accrued by download time, pausing, running auto focus or any other activity that it outside the context of image integration time)

The "Big Status" does not provide any new or insightful information... it just makes it a lot bigger. Similar information is displayed in the Sequence Status and Sequence Module.
Events are the heart of Sequence Generator Pro. They define what type of frames you are after and many other attributes to fit your needs (explained below).

**Common Event Attributes**

<table>
<thead>
<tr>
<th>Event</th>
<th>Run</th>
<th>Type</th>
<th>Filter</th>
<th>Suffix</th>
<th>Exposure</th>
<th>Bin</th>
<th>Repeat</th>
<th>Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0/6</td>
</tr>
</tbody>
</table>

- **Run**: If this box is checked, the sequencer will run the event, otherwise it will be ignored (the sequence will be considered complete without running it)
- **Type**: The event type (described below). All event types that are saved to disk will add the event type as a header. See [this section](#) for more details.
- **Filter**: The filter used in the event. (Note: If the filter list says only "None", it means that your filter list for this sequence has not been defined. Please [see this page](#) for help with that).
- **Suffix**: If defined as part of the file naming pattern, this value will be added to the file's name when it is saved to disc. It is a free form text entry field. SGPPro will remember past entries from other events.
- **Exposure**: The length, in seconds, of the exposure. Acceptable input is either a number like 600 (which will be interpreted as 600 seconds) or 10m which will be interpreted as the same.
- **Binning**: The binning level for the event (usually 1x1 through 4x4). It is possible that you can select a unsupported binning level when the camera is not connected and when the camera connects it will automatically select (and notify) that the closest available binning value has been selected.
- **ISO**: The ISO level for the image (For Canon camera only)
- **Repeat**: The number of time the event should be repeated (frames).

**Adding a New Event**

- To add a new event, navigate to the bottom left corner of the sequencer and click "Add New Event"
- Optionally, you can click the small arrow on the right and add a new event that is a copy of another existing event

**Event Icons and Actions**

- **Delete Event ("X" Icon)**: Clicking this button will permanently delete the event. You cannot delete an event that belongs to a target that is currently running.
- **Reorder Event (Arrow Icons)**: Use these arrows to reorder events in a target (affects execution order). You cannot reorder an event that belongs to a target that is currently running.
- **Pause Indicator (Pause Icon)**: This indicator will be "lit" if the event contains a pre or post pause instruction (see Event Setting below). The dots above the icon are representative of pre and post. If this icon is lit along with the left dot, it indicates a pre-event pause.
- **Park Indicator (Telescope Icon)**: This indicator will be "lit" if the event contains a pre or post park instruction (see Event Setting below). The dots above the icon are representative of pre and post. If this icon is lit along with the left dot, it indicates a pre-event park.
- **Script indicator (Script Icons)**: This indicator will be "lit" if the event contains a pre or post script
instruction (see Event Setting below). The dots above the icon are representative of pre and post. If this icon is lit along with the left dot, it indicates a pre-event script.

- **Event Notifications (Exclamation Icon):** If the event contains any notifications, this icon will be "lit". These notifications normally contain some type of information indicative of an event error. See the section below labeled "Event Notifications" for more information.
- **Event Options (Gear Icon):** Clicking this button will show the event context menu (see section below for details).

![Event Options Context Menu]

**Tip:** Double-clicking an event header will copy the value of event 1 into all of the other events.

**Copying Event Data**

Using the context menu above, you can perform a variety of event copy operations:

- **Copy from:** Copy event settings from another event
- **Copy to:** Copy event settings from this event to one or more other events (place a check next to each target event and then select fields you want to omit from the copy operation):

![Event Selector]

- **Reset Progress:** This action will reset the progress of this event to zero.
- **Set As Current Event:** This action will set the selected event as the current event. This means that when you start or resume a sequence, you are forcing it to start on this event. After start, the sequence will continue to select work normally. Setting of the current event can only be performed when a sequence is not running.

**Event Settings**
Every event has a set of associated options that can modify sequence behavior both before and after the event is started or completed.

**Park Telescope:** If this option is checked, the telescope will be parked when the event starts (pre) or ends (post).

**Pause Sequence:** If this option is checked, the sequence will be paused when the event starts (pre) or ends (post). When paused, a dialog containing the "Message" text will be displayed.

  - **Run Auto Focus on resume:** If this option is checked, the sequence will force auto run when the user resumes.
  - **Manual Focus Reminder on Resume:** If this option is checked, the sequence will force a manual focus reminder dialog when the user resumes.

**Run Script:** This will allow you to run a user created VBS or EXE script when the event starts (pre) or ends (post). Keep in mind that the sequence will not continue until the script complete. SGPro uses the Windows "cscript" VB engine. This means that you cannot use wscript interface elements (i.e. windows and dialogs). Everything in your script must be designed to run on the command line. Please see Windows cscript documentation here. If your script hangs or never completes (closes), the sequence will hang with it...

**Reset Event:** This will reset the progress of the event (not its options or settings)

### Event Notifications

This section is used to convey critical information about the capture of frames in this sequence. The example above shows a "lit" exclamation point indicating there is at least one event notification. Clicking the exclamation icon open the event display window. This example shows that there was an frame restart at 22:29 due to a guiding error. Other general notifications may appear here as well.

### Adjusting Capture History

It's unavoidable that you will capture some bad frames from time to time. In these cases, you may wish that the captured fraction no longer reflect the bad capture. This will help you to understand how much "good" data you have captured. To do this manually, simply double click the "fraction" or "progress bar" for the event you wish to alter:
From here, you can alter the number of frames you have actually captured for this event.

There are currently four different event types you can use in sequences. Each is described in detail below.

**Light Events**

<table>
<thead>
<tr>
<th>Event</th>
<th>Run</th>
<th>Type</th>
<th>Filter</th>
<th>Suffix</th>
<th>Exposure</th>
<th>Bin</th>
<th>Repeat</th>
<th>Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Light</td>
<td>Lum</td>
<td>L</td>
<td>5.0</td>
<td>1x1</td>
<td>1</td>
<td>0/1</td>
</tr>
</tbody>
</table>

Light events are used to capture normal data representing your actual target.

**Dark Events**

<table>
<thead>
<tr>
<th>Event</th>
<th>Run</th>
<th>Type</th>
<th>Filter</th>
<th>Suffix</th>
<th>Exposure</th>
<th>Bin</th>
<th>Repeat</th>
<th>Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Dark</td>
<td>None</td>
<td>5m</td>
<td>1x1</td>
<td>1</td>
<td>0/1</td>
<td></td>
</tr>
</tbody>
</table>

Dark events are used to capture dark calibration frames. They don't require use of a filter, but need to be taken in an environment that does not allow light to hit the CCD (if you have light leaks, you can use foil to wrap around the nose). Furthermore, most dark frames are taken at the same exposure length and temperature as the corresponding light frames (some image processing applications can scale darks to any exposure length). It is acceptable to take these frames and build a library (such that you don't need to take them every imaging session).

**Bias Events**

<table>
<thead>
<tr>
<th>Event</th>
<th>Run</th>
<th>Type</th>
<th>Filter</th>
<th>Suffix</th>
<th>Exposure</th>
<th>Bin</th>
<th>Repeat</th>
<th>Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Bias</td>
<td>None</td>
<td>0.00</td>
<td>1x1</td>
<td>1</td>
<td>0/1</td>
<td></td>
</tr>
</tbody>
</table>

Bias events are used to capture bias calibration frames. They don't require use of a filter, but need to be taken in an environment that does not allow light to hit the CCD (if you have light leaks, you can use foil to wrap around the nose). Furthermore, most bias frames are taken with the minimum allowable exposure time (set exposure time at 0). Some cameras (like the QHY8L) will require longer bias frame times. It is acceptable to take these frames and build a library (such that you don't need to take them every imaging session).
Flat Events

Flat events are used to capture flat calibration frames. These frames should be taken during every imaging session because they depend on the alignment of the entire imaging train. Flat frames normally target a mean ADU of 22,000 to 25,000, but this will depend on camera and user preference. If your flats data is defined (per filter), selecting a flats event will automatically populate the saved exposure time (for the selected binning).

Automatic Camera Rotation

This topic is intended to convey the principles behind automatic camera rotation.

Camera rotation can occur either automatically with a mechanical rotator or manually using the "Manual Rotator". You can learn more about connecting and using rotators here.

If you so desire, you can have Sequence Generator Pro automatically move the camera to any particular angle prior to starting data acquisition on a target. To do this, open that target settings dialog.

Note: You must have a plate solver available in order to use automatic camera rotation.

In this dialog, on the left side near the bottom, you will see a check box labeled "On target start, rotate to":

If you check this box, the sequence will now require a rotator to be connected in order to run properly. When the sequence switches to this target, it will automatically invoke the rotator and move the camera to 15 degrees (Note that degrees in SGPPro are standardized on east of north / counter-clockwise of north.)
Because angle can be given from any relative orientation in other apps, we recommend that you use angles only from plate solves conducted in SGPro).

**Important note:** The rotation value entered here is a target value. The actual value that is defined to be acceptable is defined by the angle defined above plus or minus some tolerance. The tolerance is user defined in the plate solve settings dialog.

If you are familiar with the Auto Centering routine, Auto Rotating uses the same dialog to monitor status:

If you do not own a mechanical rotator, but you are interested in using Sequence Generator Pro to ensure that your camera is at the proper angle, you can still use the Manual Rotator. When this rotator is connected, you still use the same exact process (as defined above), but instead of a rotator responding automatically to move the camera, you will be prompted with a series of dialogs that will help you find the correct positional angle manually. When the rotator attempts to move, you should see a dialog similar to this:
Follow these instructions and the camera rotation process will take care of the rest.

**Automatic Target Centering**

This topic is intended to communicate how automatic centering is used within a sequence. For details on centering go here.

The automatic centering routine will run during sequence execution when:

1. The target is set to **automatically center** when it begins
2. An **automatic meridian flip** is invoked

**Auto Centering as Part of the Target's Settings**
As pictured above, when the "Center on" box is checked, the target will automatically invoke the center on the location data provided in the RA / DEC fields above.

**Auto Centering as Part of an Automatic Meridian Flip**

When the "Use Auto Meridian Flip" box is checked, the routine will automatically invoke auto center after the mount has flipped (in order to correct mechanical inaccuracy introduced during the long slew).

**Automatic Meridian Flip**

**Automatic Meridian Flip**

Automatic Meridian Flip allows your mount to automatically perform a meridian flip when set criteria are met. These criteria can be found in the Telescope Tab of the Control Panel. For more detailed information on how automatic meridian flips work, go here.

Automatic Meridian Flip requires the following equipment:

- Telescope
- Camera
- Plate Solver
- PHD2 Autoguider
To use Automatic Meridian Flip connect the equipment mentioned above and select the "Use Auto Meridian Flip" Option in the Telescope control panel.

You may also manually invoke a meridian flip by clicking the "Run" button.

Clicking the "Set" button will open up the Meridian Flip Options dialog which will allow you to set options for how and when the automatic meridian flip will be executed.

Starting, Pausing and Aborting

Starting a Sequence

Starting a sequence is as easy as clicking a button (or pressing "F5"). Once all of the events are created and the equipment selected just click the "Run Sequence" button on the bottom left of the sequencer dialog.

Pausing a Sequence

When a sequence is running, that same button changes to "Pause Sequence". Clicking this button will present the following dialog that asks you to determine what type of pause you are after.

Pause (no data loss):

This option will allow the current activity (exposure) to continue. Once it is finished and saved to disk, the sequence will exit gracefully. Pausing a sequence will not run end of sequence options such as "Park", "Warm up" and "Auto Guider Stop".
Abort (data loss):

This option will abort the current activity (exposure) and quit immediately. Aborting a sequence will not run end of sequence options such as "Park", "Warm up" and "Auto Guider Stop".

Resuming a Sequence

After pausing a sequence, resuming is as simple as clicking the "Resume Sequence" button (same button).

Automatic Frame Restart

Sequence Generator Pro allows for automatic (in-sequence) restart of event frames that have errors in auto-guiding.

To use this feature, you must be using PHD2 auto guider.

Settings for this option can be found in the control panel in the Auto Guider Tab.

If this option is checked, the frame will restart if the guider error is reported above the user defined value above. The frame will not restart until the guider error falls below the settling distance (also defined in the Auto Guider Tab).

When a frame restart occurs, an event notification will be generated that shows the relevant details (more information on event notifications here).
Opening and Saving

Opening

Sequences can be opened by going to the File Menu and selecting "Open Sequence".

You can also click the "Open Sequence" icon on the Shortcut Bar or press Ctrl + O.

Saving

Sequences can be saved by selecting "Save Sequence" or "Save Sequence As" from the File menu. A profile can also be created using the data from the Sequence. See Save Sequence as Profile.
You can also save a Sequence by clicking the save icon.

**Apply Profile to an Existing Sequence**

**Applying a Profile to an Existing Sequence**

In the case that you do not want to alter the actual event data and just want to apply a profile over the top of it, you can use the "Apply Profile to Sequence" option found in the "File" menu. This will not alter events, but will alter all other aspects of the sequence that are defined in the profile.

Note: When performing this action, SGPro will do its best to map the filters of one profile (defined in events) to those of the new profile you are attempting to overlay. If a problem with the mapping is encountered, SGPro will produce a warning dialog letting you know that certain events need to have the filter reset manually.

**Status Area**

In the bottom right hand corner of Sequence Generator Pro there is a status area that indicates what options are in use for a given sequence. When these are grayed out the options are inactive. For the most part, when you left click one of these icons it will enable or disable that feature. If you right click on it, it will open up settings for that particular feature.

| Focus: Star - Auto focus is in use

---

100 / 209
Sequence Generator Pro

- Window - **Focus reminder** pop-up
- Thermometer - **Temperature Compensation**

**Target:**
- Bulls Eye - **Auto Center**
- Clock - **Target start and end time**

**Scope:**
- Telescope - **Park when sequence is complete**
- Globe - **Automatic Meridian flip**
- Time - this field will depend if "Automatic Meridian Flip" has been selected
  - If "Automatic Meridian Flip" is on then this will display the estimated time until the meridian flip. Or if it has already passed will display NA.
  - If "Automatic Meridian Flip" is off then this will display the time until the meridian is reached or the time past the meridian.

**Guider:**
- Arrows - Indicates **Dither** is active
- Loop Arrow - **Restart current frame** if auto guiding goes out of range.
- Stop Sign - Stop auto guider on sequence end.

**Recovery:**
- When the recovery light is green it is in the "on" position. It is gray when it is off. Please see the automatic sequence recovery section for more details.

---

Created with the Standard Edition of HelpNDoc: **Full-featured EBook editor**

**Data Stored in the FITS Header**

Sequence Generator Pro will automatically record a variety of information in the FITS header (for sequence images). The text below is a comprehensive list of data that is conditionally stored in the FITS header. To view the FITS header for an image, see this section.

*This data is always included in the FITS header:*

- **SIMPLE**: True (Conforms to FITS standards)
- **BITPIX**: 16 (16-bit image)
- **NAXIS**: 2 (Number of data exes)
- **NAXIS1**: Length of the X axis
- **NAXIS2**: Length of the Y axis
- **BZERO**: 32768 (Offset and data range of unsigned short)
- **BSCALE**: 1 (Default scaling factor)
- **OBJECT**: The name of the object (target)
- **DATE-LOC**: Local observation date (time image was written to disk)
- **DATE-OBS**: UTC observation date
- **IMAGETYP**: Type of frame (LIGHT, DARK, FLAT, BIAS)
- **CREATOR**: Capture software (Sequence Generator Pro / Lite)
- **INSTRUME**: Camera name
- **EXPOSURE**: Exposure time in seconds
- **XBINNING**: Camera X bin (always 1 for Canon cameras)
- **CCDXBIN**: Camera X bin (always 1 for Canon cameras)
- **YBINNING**: Camera Y bin (always 1 for Canon cameras)
- **CCDYBIN**: Camera Y bin (always 1 for Canon cameras)
- **GAIN**: Camera gain value
- **EGAIN**: Camera gain in Electrons / ADU

*This data is included if you have a Canon camera connected:*

- **ISO**: The ISO level for this image

*This data is included if you have a temperature controlled camera attached:*

- **TEMPERAT**: Camera cooler temperature (recorded just prior to image download in case your camera turns off the cooler during this time)

*This data is included if you have a filter wheel attached (and the sequence is using it):*

- **FWHEEL**: Name of the connected filter wheel
- **FILTER**: Name of the current filter (the filter used to expose this image)

*This data is included if you have a focuser attached (and the sequence is using it):*

- **FOCUSER**: Name of the connected focuser
- **FOCPOS**: Absolute focuser position
- **TEMPCOMP**: Focuser temperature compensation (steps / deg) (only if you were using this option)
- **FOCTEMP**: Focuser temperature (not all focusers report temperature)

*This data is included if you have a telescope attached (and the sequence is using it):*

- **TELESCOP**: The name of the connected telescope
- **RA**: Object Right Ascension (as reported by the telescope at time of capture)
- **DEC**: Object Declination (as reported by the telescope at time of capture)
- **CRVAL1**: Object Right Ascension (as reported by the telescope at time of capture)
- **CRVAL2**: Object Declination (as reported by the telescope at time of capture)
- **OBJCTRA**: Object right ascension in HMS
- **OBJCTDEC**: Object declination in degrees
- **FOCALLEN**: The focal length of the current telescope
- **OBJCTALT**: The altitude of the object in degrees
- **AIRMASS**: The average airmass during the observation

*This data is included if you have performed a solve and sync prior to capturing the image:*

- **ANGLE**: The angle of the image (east of north)
- **SCALE**: The image's scale (arcsec / pixel)
- **PIXSCALE**: The image's scale (arcsec / pixel)

*This data is included if you have assigned a user profile to your sequence:*

- **OBSERVER**: Observer name
Sequence Generator Pro

- **SITENAME**: Observatory / site name
- **SITEELEV**: Observatory / site elevation in meters
- **SITELAT**: Latitude of imaging site in degrees
- **SITELONG**: Longitude of the imaging site in degrees

---

**Sequence Images**

A Sequence Generator Pro sequence can associate external JPG images with the current sequences. These images, once associated, will be saved with the sequence file and, whenever the sequence is opened, the sequence images will be opened with it. This feature is useful if you want to store a reference image (like somebody else's image) in order to ensure the images you are taking resemble the reference. That said, a reference image can really be anything you want.

To use reference images, go to the "Sequence" menu and select "Manage Sequence Images". You will be presented a dialog that looks like this:

![Sequence File Manager]

To add a sequence image, click "Add" and then select the appropriate JPG image. You will be required to give it a user friendly name. To remove this image from the sequence, simply click "Remove". Clicking open will allow you to re-open a sequence image if it was previously closed.

The feature integrates tightly with the Framing and Mosaic Wizard. When you create a sequence using this tool, you will be able to save the working canvas as a reference point. This will open up with your mosaic sequence so that you are able to remember what you were after when building it.

---

**Sequence Recovery**

Sometimes things go wrong...

In these cases, SGPro will attempt to be a bit more resilient, and, instead of simply aborting the sequence, it will try to recover itself. The failure might be due to loss of a guide star in PHD2 or passing clouds. This does not mean SGPro can magically repair catastrophic events like auto guider lockup or cable failure, but for situations where brute force repetition would work to manually repair a sequence's progress, the new recovery feature will also likely be helpful. Primarily, this recovery works well for things like passing clouds or loss of guide stars for any reason (like auto focus with an OAG). Here is a current set of events SGPro will now automatically attempt to recover from:

- Failure to settle the auto guider (PHD2) over a 5 minute period
- Failure in the centering routine on any step
- Failure on automatic meridian flip during solve and sync, auto center or resume guiding
If you have automatic sequence recovery enabled, you can ask SGPro to help you try and recover. This feature can be toggled on or off by going into the options dialog -> Sequence Options and then checking or un-checking the “Attempt to automatically recover the sequence” option. Alternatively, there is a “LED” light in the bottom right hand of the main SGPro window. If it is green, it indicates recovery is active. If it is gray, then recovery is not active. The options dialog will also allow you to set the frequency and duration of recovery attempts.

The recovery mechanism will try to repair the sequence for 90 minutes with attempts at 10 minute intervals (by default... this can be altered in the options dialog). If the sequence is not recovered after this time expires, it will abort. With this feature in place **it will be important to have tracking limits for your mount set that are external to SGPro** (like in your ASCOM driver). Auto recovery means that your end of sequence options like “park” may be delayed by up to 90 minutes. Alternatively, the recovery feature will honor your **target end times** and sequence end time so you can use those to protect your mount as well. As a final note, it is important to know that sequence recovery will also abort when the mount crosses the meridian (SGPro will do this for safety).

If you see this screen, recovery mode is active:

As mentioned above, SGPro will attempt to recover every 10 minutes for 90 minutes. If you want to bypass the 10 minute interval between attempts, simply click “Try Now”. If you want to exit from the recovery process and abort the sequence, click ”Abort”.

Note: The attempt to recover your sequence will end:
- After 90 minutes have elapsed...
- OR when the scope passes the meridian...
- OR when the "end time" for this target is reached

**Resetting the Sequence, Targets and Events**

SGPro will let you reset the progress and state of a sequence at almost any level. You can reset the entire sequence, reset a single target or reset only a single event in a target.
At the sequence level, you have two different options:

The first option will reset the sequence state and all of its progress. This is known as a full reset. Using this option clears any state the sequence was in:

- The sequence, when started will no longer be considered as "resuming", but rather starting. This can affect things like centering on the current target and auto focus.
- Elapsed sequence time
- The auto focus frame count (if using this as a trigger)
- The last focus temperature
- The last focus time
- Average focus positions for filters in this sequence
- If event pre / post event actions had been run, they will be cleared and marked as not run.
- All sequence and event progress

This option will reset the sequence's state (see above), but will not alter progress.
Profiles

Profiles are one of the most important pieces of using Sequence Generator Pro. The profile system allows you to characterize your entire imaging system and even allows you to setup different profiles for different sets of gear or different settings that are needed when a single piece is swapped out. This can be a huge time saver and can prevent the introduction of errors if you have complex equipment interaction.

Sequence Generator Pro allows for the creation of two different types of profile, specifically Equipment Profiles and User Profiles.

Equipment Profiles:

These profiles are used to store settings for various permutations of gear. For instance, if you have a 5-position filter wheel and 7-filters, you will likely have a narrowband profile and a broadband profile. This makes creating new sequences a breeze (since you don’t need to enter this information every time). Equipment profiles can be created in multiple ways but the most straightforward is to use the Profile Manager. You can also use a Sequence to Save the Sequence as a Profile.
**User Profiles:**

These profiles allow you to enter personal and location based data. When you select a user profile as part of a sequence, this data will be stored in the FITS headers of every image saved to disk.

![User Profile Manager](image)

**Description**

Profiles are one of the most important pieces of using Sequence Generator Pro. The profile system allows you to characterize your entire imaging system and even allows you to setup different profiles for different sets of gear or different settings that are needed when a single piece is swapped out. This can be a huge time saver and can prevent the introduction of errors if you have complex equipment interaction.

Sequence Generator Pro allows for the creation of two different types of profile, specifically **Equipment Profiles** and **User Profiles**.

**Equipment Profiles:**

These profiles are used to store settings for various permutations of gear. For instance, if you have a 5-position filter wheel and 7-filters, you will likely have a narrowband profile and a broadband profile. This makes creating new sequences a breeze (since you don't need to enter this information every time). Equipment profiles can be created in multiple ways but the most straightforward is to use the Profile Manager. You can also use a Sequence to Save the Sequence as a Profile.
User Profiles:

These profiles allow you to enter personal and location based data. When you select a user profile as part of a sequence, this data will be stored in the FITS headers of every image saved to disk.

Understanding Profiles / FAQ

Understanding Profiles
Sometimes the equipment profile system can present a conceptual challenge to new users. It is not immediately clear how profiles work or what happens when you change one. This section will attempt to explain how one should go about using equipment / user profiles.

First, conceptually, you should view the profile system like you would view a template document for Microsoft Word. If you are not familiar with this concept, it basically allows you to load a Word template (like a form). Then when you fill that form out it is saved as a separate Word document... it does not update the Word template. Also, when updating that Word template, it does not change the state of any documents that have been created using that template. So... to draw parallels, a profile in SGPro is like a Word Template. When you make a sequence with the profile (like making a Word document with a template), it will use all the profile's settings as a starting point. If you further modify settings on the sequence (change text in the Word template) and save it, this will have no effect whatsoever on the profile. Likewise if you alter a profile, it will have no effect on any sequences that were created using that profile as a starting point. Profiles and targets are loosely related, but are in no way connected to each other after the initial sequence is created from it.

Profile FAQ

If I have a sequence ready and I open the PM, change some setting, and save them (e.g. auto-focus settings) how does this affect the Sequence settings and the settings found on the Control Panel?

At that point the PM does not change the sequence AT ALL. Think of the PM like a Word template. When you create a new Word document based on a template, that new document stands on it's own and will not be changed if you change the Word template. In the same way, when you create a new sequence based on a profile, the new sequence will stand on it's own. Changes made to the profile will not affect current sequences. Only NEW sequences based on a profile will include changes to the profile.

If I change settings in the Control Panel (e.g. auto-focus settings), how does this affect the Equipment Profile settings and the Sequence settings?

Changing something in the control panel only affects things in THAT sequence, it does not change anything in a profile.

I have tried changing the settings (and saving them) in the Equipment Profile Manager, but these changes were not reflected in the Control Panel. Why? Are these changes taken into account by the Sequence?

See answer to the first question. Also, if you make changes to an equipment profile, you can go to the file menu and choose to apply (or re-apply) a profile to the current sequence.

In the end, what manages/directs the Sequence? The settings in the Control Panel or the Equipment Profile Manager?

A profile will never run a sequence... it just delivers settings to a sequence. Once a sequence has been created (from a profile), at that point it is just the settings in the control panel that matter.

---

Created with the Standard Edition of HelpNDoc: Full-featured multi-format Help generator

**Equipment Profile Manager**

*Description:* The Profile Manager is used to create, edit, delete and save profiles. A profile contains a description of hardware and settings that will later be used to create sequences. A sequence created with a profile will automatically populate it with all the hardware and settings that were saved. The only reason Profiles exist is to create sequences with a set of equipment and options that are specific to your gear. Profiles without sequences are useless, with the exception of the default profile, which technically creates a new sequence when Sequence Generator Pro is first loaded (and when you create a "New" sequence).
The Profile manager is divided into 2 main parts. On the left is the Profile Selection area. On the right is the equipment area. Here the AT106LE+Narrowband is the active profile and any settings made on the equipment side will be saved to that profile when the save button is clicked.

You might create a new profile if (two simple examples):

- You have more than one imaging camera (like a CCD and a Canon)
- You have a single camera, but different filter sets (like broadband and narrowband)

Creating a New Profile

1. Using the provided tabs, select the options relevant to your setup.
2. When complete type a new profile name into the textbox below "Select or name a profile".
3. Click "Save"

Deleting a Profile

To delete a profile, simply highlight the profile and click the “Delete” button

File naming pattern

You can override the default file naming pattern for a particular profile by entering one here. If you just want to use the default naming pattern as specified in the options dialog, you can leave this blank.

Each equipment tab (Camera, Filters, Focus...etc) in the Profile Manager is a near direct copy of the hardware options in the Control Panel. For this reason please see the sections in the control panel for a more detailed explanation of how these settings are used.

- Camera
- Filters
- Focus
- Telescope
- Plate Solve
If you generally use the same equipment over and over again then you should select this profile and select to *Use this profile as the default for new sequences*. Each time you open Sequence Generator Pro your default profile data will be loaded into the Sequencing and Control Panel Windows.

**Profile notes**

If you'd like, you may add a set of notes to a profile... for instance if you have two very similar profiles and you can't quite remember when to use which, this might be very helpful. If a profile ends with a asterisk (*) character, then that profile has a note you can view / edit by clicking the "Profile Note" button. Similarly, adding a new note to an existing profile can be created using the same button.

![New Sequence from Profile](image)

**New Sequence from Profile**

*Description:* Once a profile has been created and saved you'll want to use that profile to create a Sequence. You can use your saved profiles by selecting "New Sequence with Profile" from the file menu or by pressing Ctrl+Shift+N.

Select the profile you would like to use and click OK. Note that the "Preserve the existing sequence" option is not checked. This means that the new sequence will contain on the default target and one event.
Doing so will create a new unsaved Sequence with all your equipment data and settings populated. From here fill in the sequence specific information (such as events), connect your gear and you're ready to start imaging!

It is recommended to save your Sequences (especially if you have auto save turned off).

Apply a Profile to an Existing Sequence

Applying a profile to an existing sequence (preserves target data and events) is very similar to creating a new sequence from a profile...

Description: Using an existing sequence (one with defined targets, events and frames), select "Apply Profile to Sequence" from the "File" menu.
This will bring up the Equipment Profile Chooser Menu:

Select the profile you would like to use and click OK.

Doing so will alter the equipment profile attributes of a sequence, but will not alter targets, events or frames. Keep in mind that the application of a new profile to an existing sequence could create some issues with filter settings. Because sequence events are not altered during this process, it is possible that it could be trying to use a filter that simply does not exist in the new profile. If this happens, SGPro will display a warning that you need to fix this event before running the sequence.

Save Sequence as Profile

Description: In addition to creating profiles in the Profile Manager you can also create profiles from a sequence. You can also use this method to update a profile which the sequence was made from.

To save a sequence as a profile select "Save Sequence As Profile" from the file menu:
If the sequence you're saving as a profile was created with a profile then that profile name will be pre-populated like below. Otherwise this field will be blank:

If you save over an existing profile all data in that profile will be replaced with the data in your sequence. This is useful if you created the profile when no equipment was hooked up and entered some incorrect information in the fields. If you don't want to override the profile you can enter a new name.

Once you’ve saved the profile it will show up in the Profile Manager and can be used to create sequences.

User Profile Manager

User Profiles store site specific information. This is information is then stored in the FITs header of your saved images. In general, this information is useful for astrometry measurement (or even for personal organization).
Selecting a profile as "default" means that all new sequences will automatically use this profile.

Auto Populate: If you have an Internet connection, you can attempt to auto locate your position. Please be careful with this... sometime internet geolocation is not so great.

Additionally, if you have a telescope (mount) connected, you can either:

- Create a new user profile by clicking "Import to Scope" (this will query the scope for it's current latitude, longitude and elevation... must have been set by you in the past).
- Use an existing profile to set the current location of the telescope (this is very useful if you set up in different locations). Proper latitude and longitude are import for determining time until meridian flip.

Focusing

Focusing is very important and sometimes frustrating part of astrophotography. Sequence Generator Pro allows you to focus manually or automatically with multiple options and triggers for each type.
Frame and Focus

Description: Frame and Focus can be run from the Focus tab in the Control Panel or the Focus Module. It allows for images to be taken in quick succession when using a Bahtinov mask or other focusing aid (for manual focus).
To focus manually, connect your camera to Sequence Generator Pro:

- Find a bright star.
- Set your bin and Exposure settings to a reasonable value for the target you're focusing on (for broadband filters, typically 1 or 2 seconds is sufficient).
- Start a continuous capture loop by pressing "Start" on the Frame and Focus Module or on the Focus Control Panel (for EOS cameras you can also use Live View).
- Move your focuser towards the focus position by turning the focus knob or by controller the stepper motor through the Focus Control Panel.
- Continue moving the focuser until you are in focus.

This procedure can be enhanced by setting up a Target and Focus Position in the telescope tab.

Using Subframes

1. Take a full image at any supported binning (with "Take One"). Make sure "Use subframe" in the frame and focus module is not checked.
2. Now, Check "Use subframe" in the frame and focus module.
3. Draw a rectangle onto the image you just took. This rectangle is now saved as the subframe area.
4. Now clicking "Take One" or "Start" (with "Use subframe" checked) will use the subframe. Unchecking "Use subframe" will begin full frame exposures again. While capturing subframes you can switch between binning modes without losing track of the area you selected.

Notes:
1. Taking a new frame and focus frame at a binning level different from the one at which the subframe area was selected, it will be removed. You will need to reselect the area using the new frame.
2. You are free to rotate images when using the subframe option.
3. When "use subframe" is checked, you will only be able to draw subframe selection areas on "frame and focus" type frames (i.e. not on your light frame or others).

Setting Focus and Target Positions

Description: Setting Focus and Target Positions helps to quickly slew to a focusing star and then get back on target quickly. If you're using automated focusing there is no need to setup the target and focus frames as Sequence Generator Pro will use your target position for computing focus.
To set the Focus and Target Positions you can use either the Control Panel or the Focus Target Module.

**Focus Target**

<table>
<thead>
<tr>
<th>Focus RA</th>
<th>Unknown</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus Dec</td>
<td>Unknown</td>
</tr>
<tr>
<td>Target RA</td>
<td>Unknown</td>
</tr>
<tr>
<td>Target Dec</td>
<td>Unknown</td>
</tr>
</tbody>
</table>

- Click the "Set Focus Position" (if using the module click "Focus Position")
- Click the "Set Target Position" (if using the module click "Focus Position")

**Above: Focus Control Panel**

To setup the Focus and Target Positions first connect a telescope/mount to Sequence Generator Pro:
- Slew to the Focus Position
- Click the "Set Focus Position" (if using the module click "Focus Position")
- Slew to the Target Position
- Click the "Set Target Position" (if using the module click "Focus Position")

To use these settings:
- When you need to focus click "Goto Focus"
- Once you've finished focusing click "Goto Target"

When using this method, it can often be helpful to set **manual focus reminders**. These will allow you to set triggers that pause the sequence and allow you to refocus prior to continuing.

**Manual Focusing Reminders**

*Description:* Manual focus reminders will pause the sequence and alert you when it's time to focus. You can find these options in the **Focus Control Panel** as well as the focus tab of the **Profile Manager**.
Sequence Generator Pro

To enable manual focus reminders click the "Focus reminder" check box. To set these options click the "Set" button which will bring up the following dialog where you can define when you want to be reminded to run focus:

Options:

- **Focus reminder every X frames**: This will remind you to focus after X frames have been taken.
- **Focus reminder every X degree change**: This will remind you to focus after the temperature has changed by X degrees from the start of the sequence or from the last focus time. This requires that you have a focus controller that reports temperature.
- **Focus reminder every X minutes**: This will remind you to focus after the elapsed time has passed from either the start of the sequence or since the last focus time.
- **Force focus reminder on filter change**: When checked this will prompt you to focus when the filter is changed even if the criterion for the selected trigger has not been met.
- **Force reminder before first frame**: When checked this will prompt you to focus before the sequence starts (not applicable to "resuming a sequence"). The idea is that resuming a sequence will still depend on factors set previous to the pause and resume interval (like time or temperature).

**Auto Focus**

*Description*: Auto focus is an excellent step towards automated imaging. If setup correctly you can complete an entire imaging run with little to no interaction with your equipment once the "Run Sequence" button is clicked. Auto focus assumes that you're already well focused with a Bahtinov Mask or some other focusing aide. The intent of auto focus is not to take you from completely out of focus to in focus, but to keep you in focus throughout the entire night. For more information on how auto focus works and how to best tune your setup to get the most out of auto focus please see [Understanding Auto Focus](#).

Auto focus can be invoked by using the Focus Control Panel or the Focus Module:
The majority of the auto focus options can be found in the Profile Manager under the Focus Tab, these options are also available at a sequence level in the Control Panel. The illustrations below are from the Control Panel. Clicking the "Set" button next to the "Use auto focus" option will bring up the Focus Options Window.

The text below will describe what each fields represents, but will probably not leave you with a great feeling in terms of how to tune these setting for you rig. For that we have devised this section which, we hope, will help get you up and running with AF pretty quickly.

To use Auto Focus you will need to have a camera and a focuser which can return its absolute position.
**Options:**

- **Auto Focus Metric:** Specifies the provider of the focus metric.
  - *Half Flux Radius:* Uses the Sequence Generator Pro "whole image" HFR (Half Flux Radius) metric for auto focus. Generally HFR is considered to be a more robust metric than FWHM.
  - *Full Width Half Max:* Uses the "whole image" FWHM (Full Width Half Maximum) focus metric. **This metric requires that Pinpoint is installed!**

- **Auto Focus Frequency:** Specifies when Sequence Generator Pro should trigger an auto focus run
  - *Auto focus every X frames:* This will trigger auto focus after every X frames.
  - *Auto focus every X degree change:* This will trigger auto focus after every X change in degrees Celsius. This is probably one of the better methods to use as it best reflects why focus needs to happen (other than filter changes).
  - *Auto focus every X minutes:* This will trigger auto focus every X minutes during a sequence. It will not interrupt frames, but rather will wait until the current frame completes to run the auto focus routine.
  - *Force auto focus on filter change:* When checked, auto focus will run when the filter is changed even if the criterion for the selected trigger has not been met.
  - *Auto focus before first frame:* When checked this will auto focus before the sequence starts (not applicable to "resuming a sequence"). The idea is that resuming a sequence will still depend on factors set previous to the pause and resume interval (like time or temperature).
  - *Auto focus on resume:* will initiate Auto Focus if the sequence is paused and then resumed.
  - *Auto focus after automatic centering action:* Will initiate Auto Focus after performing an automatic meridian flip or an automatic centering. This is useful if you are imaging with a mirror and the centering action causes an undesirable shift in the mirror due to gravity.

- **Star Detection**
  - *Minimum Pixel Size (at 1x1 binning):* This is used to remove false stars from the HFR measurement. You can tell if you need to adjust this by visually inspecting the "AF boxes" overlay (tip: it is easier to adjust this from the focus floating module... adjusting it changes star detection in real time so you can quickly see how your results are affected). It is important to note that this setting is adjustable "per-target" and self-adjusts for binning. This means that if your 1x1 minimum diameter is 8 pixels, then 2x2 binning will have a minimum diameter of 4 pixels. This will prevent you from needing to adjust this if you change your auto focus binning mode.
Important note for this field with respect to targets and equipment profiles! This field is unique in that it is the only one in auto focus that can vary by target. In its current form it is not super-intuitive, so we will do our best to explain it here:

- The value that shows up in this field when you open the auto focus setting dialog will be based on which target you have selected in the sequencing window.
- For equipment profiles, the value saved in the profile will be used for the creation of any new target. If you change that value (in the sequence file) for a target, it will have no effect on other targets in the sequence.

- Other options: These generally deal with the auto focus sampling (parameters used to complete an auto focus run). A more thorough explanation of these specific options can be found in Understanding Auto Focus.

  - Exposure times:
    - For Filters: This button will take you to your filter setup (Filter Setup Dialog). From this dialog you can define the auto focus exposure time per filter.
    - OSC: This exposure time is meant to be used when you are using a Once Shot Color camera and have no filters (of course, it would be used for monochrome cameras with no filter as well, but this is a less common setup).

  - Bin: Specifies the binning at which auto focus should run.

  - Auto Focus Data Points: Specifies how many data points are used for auto focus. The minimum is 3, the **recommended value is 9**. A "data point" is used in conjunction with step size. For instance, if you set 7 data points with a step size of 10, auto focus will begin by moving the focuser out 30 steps, take a single exposure, calculate its focus metric, and then repeat this 6 more times, moving in by 10 steps each time.

  - Step Size: specifies the number of focus steps between the data points above. For example if you specify 3 data points, a step size of 10 and your current focuser position is at 1000 then the auto focus routine will take an exposure and calculate the focus metric at 990, 1000, and 1010 steps.

  - Auto Focus dialog auto-close delay: When auto focus is running the Auto Focus Dialog will appear. If auto focus is called during a sequence then this value specifies how long after auto focus completes that this dialog should be shown (prior to closing and continuing the sequence). It's important to note that while this dialog is on the screen that your sequence will not run. Set this to a non-zero value to leave the auto focus dialog up for a specified amount of time. If you're not interested in looking over the auto focus run then leave this value at 0.

  - Disable smart focus: Check this if you want to disable smart focus behavior (automatic continuation and expansion of the focus range in order to try and get adequate data). If your scope has a central obstruction you should most likely disable smart focus. If at all possible you should avoid using this option by using the tuning method found here.

  - Auto focus with filter: Allows you to specify a filter to use for auto focus. This is generally not the best way to use auto focus as you will get better results performing auto focus on the filter that you intend to image with. However if you do decide to use this option it is highly recommended to use the "Auto adjust focus per filter" option as well as setting up your filter positions.

  - Auto Focus Crop: This is designed to help those who image with severe field curvature at the edges of the image and will prevent the auto focus algorithm from using "bad" edge stars to determine focus. This feature is specified as a percentage of the CCD's dimensions. For instance, if you specify a crop value of 5% and your CCD dimensions are 800x600, auto focus frames will not consider any stars within 20 pixels of the left and right edges (40 pixels total) and within 15 pixels of the top and bottom edges (30 total pixels).

  - Apply dark subtraction: Check this option to perform dark subtraction on your auto focus frames prior to analysis. This can be useful if your auto focus frames are noisy enough to produce false positives during star matching. The chosen directory must have dark frame in it for every variant of exposure (+/- 2 seconds). For instance, if you are taking 15s frames for one filter and 18s frames for another, you must have 15s (+/- 2s) and 18s (+/- 2s) dark frames in this directory. The naming convention for darks is as follows: `<NNN>_<name>.fit` where NNN is the exposure length in sec (i.e. 15_mydark.fit or 15_mydark.cr2). If multiple images in your darks directory meet this criteria, the image closest to your exposure will be chosen.

  - Save Auto Focus packages to: Checking this option and setting the path will allow you to save your auto focus runs for further evaluation. In general this should not be needed unless you find...
issues when running auto focus and need to submit an issue or ask for assistance on the Yahoo! Group.

Note: While not on this dialog, the auto focus routine can run using fast download speeds (assuming your camera supports it). This option can be found on the Camera tab of the control panel. There is no harm in trying it... just a word of caution, that for some cameras, this might introduce enough noise or other unfortunate artifacts that the AF metrics are less than optimal.

**Manually Running:**

You can manually invoke the Auto Focus routine either through the Focus Module or from the Focus Control Panel by clicking the "Run" button. This will bring up a window that resembles the window below:

![Auto Focus Running](image)

- Red Xs indicate points not used to compute focus
- Green lines indicate best fit for each side of the V (focus is the intersection of these lines)
  - Red lines indicate that a best fit was NOT found and focus will be computed by finding the lowest local average (this is the pre 2.3 method)

If you are unhappy with the auto focus results (ie you don't get a good V curve or the V seems shifted dramatically to one side) you can invoke Auto Focus again by clicking "Run Again". This will center the Auto Focus run around the point that was last determined to have the best focus.

**The Validation Frame**

After auto focus is complete and SGPro has determined the new focus position, it will move the focuser here and take a validation frame. Because of the way in which SGPro achieves auto focus, it has a pretty good idea what your ending HFR should be if you truly arrived the focus position. If the validation frame's HFR is not within 15% of the low HFR, a temporary warning dialog will appear and let you know (if you purchased the notification add-on, a notification will also be sent). If this happens often, it might be due to backlash issues in the focus motor, underpowered focuser motor (heavy imaging chain fighting gravity near meridian)
or some sort of binding.

If you cancel the auto focus run after it has completed the focuser will be returned to the last focus position. For example:
- Auto focus starts and the focuser is at 2000
- Auto focus determines the focus position to be 1900
- Cancel is pressed
- Focuser is returned to 2000

However if "Run Again" has been used this will reset the start position. For example:
- Auto focus starts and the focuser is at 2000
- Auto focus determines the focus position to be 1900
- Run Again is pressed (1900 is now stored as the last focus position)
- Focus is determined to be at 1890
- Cancel is pressed
- The focuser is returned to 1900, not 2000.

Understanding Auto Focus

Description: Auto focus is highly useful for keeping you in focus through the night; however, auto focus can often be difficult to understand what's going on "under the covers". This should help to demystify those issues. The purpose of the Auto Focus implementation in Sequence Generator Pro is to maintain focus through an imaging session. It is not designed to handle large focus swings. Because of this you will need to start out fairly well focused before you begin an imaging run with Auto Focus enabled.

How Auto Focus Works

SGPro auto focus works off a notion of "whole image HFR". Under normal circumstances, this will allow
you to focus where you are imaging and avoid a costly move to a bright star and then back to target. When auto focus is triggered, it will begin by moving the focuser "out" by \( ((\text{data points} \times \text{step size}) / 2) \) steps. It will then begin taking AF frames, averaging HFR and then moving in by "step size" until the focus point is recognized. While "Data Points" is user defined it really only defines the number of steps used in the initial outward movement of the AF routine. SGPro is smart enough to recognize trends and automatically extend the number of points you need in order to find proper focus (when "smart focus" is not disabled).

In order to find the focus point SGPro will perform trend analysis (best fit lines) and use the intersection of those lines as the focus position. When SGPro receives data that cannot provide best fit lines, it will default to using the weighted average of the lowest 3 points (this will issue a warning if you are using the notification system).

**Auto Focus Variables**

Unfortunately, SGPro does not have a "one size fits all" approach to auto focus and some targets will need to be tuned a bit before they can be let loose. Fortunately, SGPro's AF routine only requires a few settings to get working properly. The values that define auto focus are seen above and defined here. The process by which one actually uses them to achieve focus is better described below.

**So... How do you set it up for your rig?**

Setup and tuning of Auto Focus should not take a long time and, fortunately, once you are able to capture a few key parameters, future adjustments can come quickly. The first time, you use auto focus, however, all these things may seem a bit overwhelming. This small guide should add some clarity to the process and get you going.

The general process for starting out requires the following:

- About 20 minutes
- A camera (CCD or DSLR)
- For users of filter wheels, ensure that your filter list is set.
- A motorized focuser and controller
- A Bahtinov mask (or other means of finding focus without relying on SGPro)
- A little patience

Once you are setup and have your scope point at a bunch of stars, you are ready to go:

- Go ahead and open the Auto Focus Settings Dialog now and you can set a few parameters...
This tutorial does not focus on auto focus triggers. Definition and use of these triggers can be found here. For what you are doing, stay on the right side of the settings dialog.

Set the auto focus exposure time. **If you are not sure what to use, go ahead with eight seconds.**

- If you use an OSC camera, just fill in the exposure length value right on this dialog.

- If you use a filter wheel, you must set the auto focus exposure time per-filter. Go ahead and click the "For Filters" button and make the exposure length entries for the filters you will focus with. For this tutorial, you should pick a luminance or clear filter (you will likely always focus with this filter anyhow).
Set the binning to use for auto focus frames. Unless you have a specific reason not to, use **2x2 binning** (DSLR users can set their auto focus binning levels in the DSLR's setting dialog).

Set the "Auto Focus Data Points" field to represent the number of samples you want auto focus to take during the run. If you choose a value of 9, perfect focus would show a "V" curve with four point outside of focus and four points inside of focus. If you don't have a specific value in mind for your rig, choose nine points here.
If you are using a filter wheel, go ahead and check the "Auto focus with filter" option and choose your luminance or clear filter.

Go ahead and close the auto focus settings dialog for now by clicking "OK".

If you are using a filter wheel, change filters to the filter you will use for focus (normally Luminance).

Use SGPro's "Frame and Focus" module and a Bahtinov mask (or other) to achieve focus. Exacting focus is not critical here.
Now, use SGPro's "Frame and Focus" module to "Take One" image at the same exposure length and binning as an auto focus frame (the settings you just used above).

Click on the "star" icon to start an HFR calculation of your test image.

You will probably see some stars with green circles around them when you click this button... if you don't, no need to panic... just needs a little adjustment.

Using the "Focus" docking module, adjust the "Minimum Star Size" field. This number is representative of the minimum diameter required in order to qualify as a star. If it's too low, you might pick up non-star objects... to high, you will miss a lot of valuable star data and also start picking up large parts of nebulae as false stars. Adjusting this value will adjust the number of stars detected in real time. Keep in mind that this value is representative of the minimum diameter (in pixels) at 1x1 binning and will auto-adjust when you use a binning that is not 1x1. For example, if you set this value to 10 pixels and take your AF frames at 2x2 binning, your minimum star size is automatically adjusted to be 5 pixels. Adjust this value as low as you can without reducing the minimum diameter to less than 2 pixels after binning division occurs. For instance, if you set this value to 2 pixels, the 2x2 value will be 1 pixel and will just be auto adjusted to back up to 2 pixels to avoid inclusion of noise and hot pixels. If lots of diameters look good, go head and choose a "Minimum star size" (diameter) of six pixels.
- Using the "Image Statistics" module, note your test frame's current "Half Flux Radius" value. Jot this down.

- Using the focus module, note the focuser's current absolute position.
Using the "Frame and Focus" module, click on "Start" to begin capturing frames using the same auto focus setting you used for "Take One". The "star icon" should still be active and you should continue to see stars circled in green.

While this is happening (looping frames are captured) begin to move your focuser outward until the HFR reading is ~3-5x greater than your "at-focus" HFR that you noted earlier.

Subtract the "in-focus" focuser position from the new (current) focuser position. Multiply this number by 2, divide it by the number of "Auto Focus Data Points" minus 1 and you now have a good "Step Size".
\[
StepSize = \frac{\left((Pos_{afr} - Pos_{afc}) \times 2\right)}{Steps - 1}
\]

- Open the auto focus settings dialog and enter this value into the "Step Size" field.

- That's it! Let's kick the tires. Using the "Focus" module, go ahead and click the "Run" button. You should see a "V" and a focus point chosen that is very close to both the HFR and focuser position you noted above.
Don't forget to save your hard work to both the sequence you are working on and to an equipment profile for later use... the idea is that you only need to perform this once per equipment profile.

Auto Adjust Focus Per Filter

Using this option will attempt to adjust the position of the (motorized) focuser based on information of the newly requested filter position (and possibly the previous filter position). The observed behavior will vary in one of three ways depending on frame type.

- **Auto adjust focus per filter** can be turned on via the Focus Control Panel, it can also be set within a profile using the Profile Manager.

To use **Auto adjust focus per filter** you will need:

- A **camera**, **focuser** and **filter wheel** connected to Sequence Generator Pro
**Light Frame Behavior**

When operating on light frames, checking this option will auto-adjust focus per filter using the difference in pre-recorded (absolute) positions.

In addition to the above requirements, you will need:

- Filters setup with their correct focus positions in the Filter Setup Dialog

**Explanation:**

Focus tends to shift throughout the night so there's no possible way that the "Focus Pt", as specified in the Filter Setup Dialog, will be correct 100% of the time. These values have two purposes:

1. To give you a rough starting point of where your focus point lies.
2. To give you offsets relative to the other filters.

The Auto adjust focus per filter relies on the offsets relative to the other filters to adjust focus. To do this accurately the "Focus Pt" values all need to be setup around the same relative time span when the temperature is fairly constant. Ideally when setting these up you would run auto focus for each filter and set these values using the Focus Point Settings (then save the sequence as a profile or translate the values over to a profile). This will give you the most accurate offset positions relative to your filters. Alternatively, you can use a Bahtinov (or similar) mask and determine the focus point for each filter this way.

When a filter is changed, the "Focus pt" of your current filter is subtracted from the "Focus pt" of the target filter. This offset is then subtracted from your current position and the focuser is moved to that location before running an auto focus routine. Assuming that the "Focus pts" were setup correctly this should get the focus extremely close, if not dead on.

**Example:**
Assume you have a focus point for a Red filter set to 7010 and a focus point for a Green filter set to 7030. You are imaging at a temperature much colder than the one used to set these focus points. You are currently at focus with your Red filter at 6940. If you are using this option and switch to your Green filter, your focuser will move out to 6960 (not 7030) to obtain focus. This is because, at the same temperature, the filters differ in focus position by 20 steps.

**Flat Frame Behavior**

When operating on flat frames, checking this option will auto-adjust focus per filter using the mean focus position of that filter (focus position is recorded throughout the life of the sequence (after successful auto focus... over days or however long it takes to run the sequence). If insufficient data exists to set the flat focus position, the focuser will not be adjusted. Critical focus is not necessary when collecting flat-frames and this method will get you close enough to capture useful calibration data.

In addition to the above requirements, you will need:

- To periodically focus using SGPro's auto focus methodology. This is how focus data is collected for each of your filters.

**Note:**
Resetting the sequence will clear a filter's focus data (the data collected during auto focus).

**Other Frame-Type Behavior**

When operating on dark or bias frames, checking this option will do nothing.

---

**Temperature Compensation**
**Description:** Temperature compensation allows you to train and adjust your focuser to react to temperature changes (between frames). If you're using auto focus triggers on the temp change this is not needed.

Temperature compensation can be turned on in the **Focus Control Panel** as seen below:

Before temperature compensation can be used it must first be trained. If you happen to know your temperature coefficient in Steps per Degrees Celsius, then you can enter this value directly into the Focus Control Panel. See **Temperature Compensation Trainer** for more information.

**Note:** Negative temperature compensation ratios indicate that your focuser will move INWARD as temperature drops.

---

**Limiting Range**

**Description:** Sequence Generator Pro has the ability to Override the maximum step value for a focuser with a smaller step value. This is useful if you use more than one focuser with the same focus controller and they have different ranges or if the range of your focus controller exceeds the physical range of the actual focuser. For example, if your controller has a range of 50,000 units and at step 10,000 your focuser is fully racked out, setting the override value to 10,000 will give you a better visual representation of the focuser's position.

Override maximum step cannot increase the maximum steps of your focuser driver. For instance if your focuser driver is setup to allow a maximum range of 1000 steps Sequence Generator Pro cannot override this value with 2000 steps, it can however make this value less.

---

**Framing**

Sequence Generator Pro supports multiple methods to get your image framed quickly and repeatibly. The
options range from manual framing to automated framing with multiple choices inbetween.

Frame and Focus with Nudge

*Description:* Running a Frame and Focus loop while manually moving the telescope via the Telescope module or control panel is the most manual method of framing your target.

To manually center your target you will need a camera and a telescope connected to Sequence Generator Pro.

- Start a Frame and Focus loop.
- Move the telescope using the direction pad on the Telescope Control Panel or Module (you can also move the telescope with its ASCOM driver or using the hand paddle).
- Once centered, stop moving the telescope and stop the Frame and Focus loop (if you intend on moving from this position in order to periodically obtain focus, it is recommended that you set this as the Target Position).

Manual framing is the most basic of framing routines. Sequence Generator Pro contains many advanced features that can make this process considerably faster when a Plate Solver is setup. Center Here and Auto Center are considerably faster than manually moving the mount and can ease the burden of multi-night imaging and meridian flips a great deal.

Auto Center

*Description:* Once a target's location has been set (solved) you can then quickly center on that image using the Auto Center routine.

Auto Center Setup

To run auto center you will need to have the following setup an connected to Sequence Generator Pro:

- **Plate Solver**
- **Camera**
- **Telescope**

Setting Up the Plate Solver

Setting for proper plate solving of the scope are located in two areas. First, you must tell SGPro a few things about your current setup. This is done in the Control Panel in the camera tab. Here you must specify the camera's angle (for Elbrus only) and your gear's scale (for all plate solvers). While it is useful to fill out the remaining information, it is not necessary for plate solving.
After this is complete, you will need to fill out a few things in the Control Panel in the Plate Solve tab. This assumes your plate solver of choice is installed, setup and ready to go. If not, please do this first (Elbrus, Pinpoint). In this tab, you will need to:

- Choose your plate solver from the dropdown
- Choose your search method:
  - Elbrus should almost always use "5x5 dual angle" (use 2x2 at any angle if the camera angle is not known)
  - Pinpoint should almost always "Use up to magnitude 20 stars" (wide field imaging may require less)
- Choose the binning for the plate solve frames. A binning of 2x2 or less is recommended (more sensitivity and less download time)
- Choose an exposure time that is sufficient to capture solvable data (this will vary by filter, a good value for broadband filters is about 7-8 sec)

Scope Centering Options

Use these options to ensure that SGPro centers your target according to acceptable tolerances. More detail on this is here.

The Bin, Angle and Scale for the Scope Frame & Center Here options must be populated before attempting to use Auto Center. Refer to the Plate Solve area of the control panel for more information. You should save this information in a profile so you don't have to continually re-enter it.
Running Auto Center

There are three ways to invoke the center here functionality (they all do the same thing... just conveniences depending on where you are operating). You can invoke auto center from:

The Target Settings dialog:

The Target List context menu:
Automatically during sequence execution:

Using the control panel will automatically center on the currently selected target. You can see the currently selected target in the sequencing dialog.

**Number of Attempts and Error Threshold**

Anytime Auto Center is invoked, it will attempt to center itself in an iterative fashion. For instance in the screenshot above, the routine will attempt to center itself up to 3 times until the total error is less than 50 pixels. If after the 3rd attempt the error is still greater than 50 pixels, it will quit.

**Auto Center Filter**

Because it takes much less time to expose a luminance frame (or any other broadband filter), it can be useful to specify a particular filter to use when running auto center. For instance, if you are imaging with an Ha filter and the sequence automatically invokes a centering routine, it will temporarily change to the luminance filter (or whatever you selected) and then switch back to Ha when the sequence resumes.

Once you have the equipment above connected and your plate solver successfully solving images open up the Plate Solve Control panel:

**What you will see during Auto Center**
Once everything has been setup and is connected you're ready to begin the Auto Center process. Simply invoke Auto Center and Sequence Generator Pro will begin the process of Auto Centering on your reference frame; this is also accessible via the **Scope Centering Module**.

You will see the following dialog:

This process is completely automated. The following steps are performed:

1. The reference data is solved (if it hasn't been previously solved... this will almost always be pre-solved).
2. The telescope is slewed to the reference frame's location.
3. An image is taken and then plate solved. The coordinates of this solve are used to compute the difference between the expected location and the actual location. The amount of error (in pixels and Degrees:Minutes:Seconds) is then shown.

If the error is too high (above your defined threshold; see above), then the routine will automatically attempt to re-center until either the error is under the defined threshold or the maximum number of attempts has been exceeded.

Depending on your imaging setup and scale, different values are more or less permissive for the error amount and it will take some trial and error to find what you feel is acceptable. In general any error below 100 pixels is usually sufficient depending on focal length, target size and framing. The error is calculated along the hypotenuse of the RA and DEC error (which is why the total error does not add up to the sum of the two errors).
Center Here

Description: Center Here is somewhat of a very advanced "Nudge". It allows you to click anywhere on a captured image and center the scope at the location the mouse was clicked.

To use Center Here you will need the following connected and setup within Sequence Generator Pro:
- Plate Solver
- Camera
- Telescope

Center Here is available on any image that Sequence Generator Pro captures (with the exception of Auto Focus images).

Once the above equipment is connected and the plate solver is ready, capture a single image (for instance with, Frame and Focus).

Right click on the image and choose "Center Here"

The following confirmation dialog will appear:
Click "Yes" to center the scope where you right clicked on the image.

You will then see the following "Center Scope on Reference" Dialog:

This process is completely automated. The following steps are performed:

1. The reference data is loaded from your mouse click location.
2. An image is taken and then plate solved. The coordinates of this solve are then used to sync the telescope.
3. The telescope is slewed to the reference frame
4. Another image is taken and then plate solved. The coordinates of this solve are used to compute the difference between the expected location and the actual location. The amount of error in pixels and Degrees:Minutes:Seconds is then shown.
You cannot "Run Again" when using "Center Here", instead close this dialog and rerun the "Center Here" procedure by right clicking and selecting "Center Here".

Depending on your imaging setup and scale, different values are more or less permissive for the error amount and it will take some trial and error to find what you feel is acceptable. In general any error below 100 pixels is usually sufficient depending on focal length, target size and framing. The error is calculated along the hypotenuse of the RA and DEC error (which is why the total error does not add up to the sum of the two errors).

**Using Goto Target**

*Description:* Goto Target allows you to manually specify a target so that you can quickly get back to that target. It is highly recommended that you use the Auto Center with Reference Data rather than Goto Target as Auto center provides feedback and information about the error of your slew.

See [Setting Focus and Target Positions](#) for information on setting and using this feature.

**Images**

The display of images in Sequence Generator Pro is handled through "Image Containers". An "Image Container" is really just a window that can be docked (tabbed), nested in other windows or popped out to float above other windows.

The idea is to provide a highly flexible and useful environment in which to display and view images. For example, you can keep all of your windows tabbed or you can display two images side by side for comparison.

We call these windows "Image Containers" because they retain their own set of properties (like stretching values, inversion crosshairs, etc). If a new image is swapped out in the same container it will inherit all of the container's properties.

**Opening and Moving**

**Opening Images**

Images can be opened from the File Menu by selecting "Open Image":

---
Images can also be opened by clicking the drop down button on the Open button and selecting "Open Image"

You can also open images by dragging them into the Sequence Generator Pro window.

**Moving**

Like **Modules**, image windows can be manipulated and docked within the Sequence Generator Pro interface.
There are 3 kinds of image displays:

- **Opened images**: These are images that you have manually opened in Sequence Generator Pro, these image displays will never be reused by any running sequence.

- **Sequence Images**: These are images captured as part of a sequence (flats, darks, bias, etc), this image display will potentially be reused by new images of the same type depending on how you have your View Options setup.

- **Temporary Images**: These are images captured as part of a process (plate solving, auto focus, frame and focus), this image display will always be reused for new temporary images.

Any type of image display can interact with the other 2 types. The only thing that makes the image displays unique is the type of frame they hold.

Image displays can have 3 states:

- **Docked**: The image display is docked to the top, bottom or center of the main Sequence Generator Pro window and will move with that window.

- **Floating**: The image display is not locked to the Sequence Generator Pro window and can move freely around the desktop.

- **Nested**: Windows can be nested within one another. Simply drag a window over another open window and, using the nesting grid, select the desired position.

Image display windows can also be nested with one another (top, bottom, left, right, tabbed).
Menu Bar

Every image in SGPro will have this menu bar attached to it. From it you can perform a variety of options. The bar has several distinct groupings in it... specifically from left to right:

- Image browsing tools
- Image zooming tools
- Image rotation tools
- Miscellaneous tools

Image Browsing

The image browsing functionality works much in the same way as an Internet browser. If you want to see images taken in the recent past (without going to the file menu), simply click the back button (green arrow buttons on the far left). In addition to this you can right click either arrow button to show a list of recent images. The arrow in the left margin shows which image is currently displayed. Clicking on one of these images will open it in the current image window.
Marking an Image Bad

To mark an image bad, simply click the red "X" button. Marking an image bad will rename the image by prepending "BAD" to the front of the image (easily separated from your other images).

When you mark an image as bad, you may wish for it to be removed from the total number of frames you have already captured (so that this number reflects only "good" data). To perform this operation, simply ensure that the "Decrement" check box is selected:

Calculating HFR

Description: HFR (Half Flux Radius) is a useful metric for determining your telescope's focus. It's important to note that HFR is only relative to other images of the same object through the same imaging train.

To calculate HFR, Right Click on an image within the Sequence Generator Pro display and select "Calculate HFR" (alternatively you can click on the "star" icon in the toolbar).
The image will then have an overlay of some of the stars used for the HFR calculation.
To view the HFR of the entire image use the **Image Statistics Module**:

**Inverting**

The black and white point of the image can be inverted by clicking the Invert Image button (black and white circle). This can be useful for detecting very faint objects in your image.
Crosshairs

Crosshairs can be toggled by Right Clicking on the image and selecting "Show Crosshairs" or by clicking the "Show Crosshairs" icon (reticle). Clicking the "Show crosshairs" checkbox for frame and focus will not toggle crosshairs for the current image (it is only used to decide whether or not to apply crosshairs to new frame and focus images).
Viewing FITS Headers

FITS Headers can be displayed by clicking the "FITS Headers" icon (black document with white lines) on the image display:

This will bring up the following dialog:

For multi-plane images you will see additional tabs for each pane (i.e. HDU2, HDU3, etc.).

You can see FITS header data stored in SGPro images here.

Saving Temporary Images

You can save temporary images (plate solve frames, auto focus frames and frame and focus frames) by right clicking on the image and selecting "Save As Mono FITS..."
Zooming and Panning

Zooming

The zooming tool group is the second group from the left:

- Images can be zoomed in and out by using the Zoom In and Zoom Out buttons on the Image display (magnifying glasses with + and - symbols), you may also zoom in and out by using the Up and Down directional arrows on the keyboard.
- You can quickly zoom the image so it matches the size of the display window by clicking the "Fit To Screen" Button (Magnifying glass with dashed square).
- You can also select an area in which to zoom. In order to do this, click the "dashed rectangle" button and then select a rectangle around the area you want to zoom (Note: when the "zoom on selection" button is clicked, the mouse no longer pans the image when dragging (see below). Simply click this button again to return to "panning mode".

Panning

To pan, click and hold on an image and then drag the image to where you would like to view. Note that this feature is not functional when the "zoom on selection" mode is active (see above).
Rotating

Images can be rotated by clicking the "Rotate -90 Degree", "Rotate 90 Degree" or the "Rotate 180 degrees" buttons on the image display. The rotation group is located third from the left:

Stretching

Stretching can be accomplished manually though the Histogram Module or automatically through the preset stretches.

To use one of the preset stretches right click on the image and select the "Auto Stretch" to be applied to the image. From the menu bar, simply click the "black and white gradient button".

To manually stretch the image drag the black and white points in the histogram module. The lower histogram displays the stretch as it is applied to the image.
You can also select "Auto Stretch" which will apply a low stretch to any newly captured images.

Stretching images can be accomplished in a variety of ways at different precision:

- **Baseline**: Use auto stretch as described above. The aggressiveness of auto stretch can be set in the [general options dialog](#).
- **Coarse Movement**: Use the mouse to drag the black and white point on the histogram.
- **Fine Movement**: Use the mouse wheel or track pad scroll. This will move the black or white point by 100 ADU for each increment. You must set your mouse to control stretching [here](#).
- **Precision Movement**: Use the [left and right arrow keys](#) to make precise movements (10 ADU per click).

---

**Plate Solving**

Almost any image displayed in SGPro can be plate solved by right clicking it and selecting the "Plate Solve" option:
This will show you a small dialog box that prompts you for the hints required to solve. If possible, SGPro will auto-populate these boxes for you. Also, if your blind solver is set up, you can skip all of the hints and click the "Blind Solve" button:

To solve with a "non-blind" solver you must enter some hints. Both Pinpoint and Elbrus require RA, DEC and scale hints. Only Elbrus requires an angle hint (assuming that you are not using the 2x2 at any angle search option). The RA and DEC fields are "free text" and will accept quite a large variety of formats (e.g. "20h58m54s +43°51'46" or "20:58:54 -43:51:46" or even decimal forms like 20.92). You can also paste text containing both RA and DEC into the RA field and it will properly populate both fields (most of the time). If you do not want to supply RA and DEC location information, you can simply supply the object catalog name closest to the center of the image. This will auto-populate the RA and DEC for you.

Long Running Plate Solves

Some plate solves, depending on a variety of parameters, can take a long time to solve. Because they try many, many methodologies to solve the image, they can also take a long time to fail. If after some period of time, you come to the realization that your solve will never succeed and want to terminate it early, you can do so from the image tool bar:
Center Here Action

"Center Here" allows the mount to be pointed where the mouse was right clicked in the image. For more information see Center Here in the framing section.

Slew Here Action

This will use data about a previous solve to provide rapid, low overhead movements (without the need for a full centering process). This means that, unless some type of action that performs a plate solve of the scope's current position (solve and sync, auto centering or center here) has been performed, this option will not be available. Once it becomes available, you can use it in a much more expedient manner because it
does not require the full centering process with solving and subsequence verification. The validity of this action is highly dependent on your mount's polar alignment and ability to slew in a precise manner.

**Modules**

Sequence Generator Pro has a highly customizable user interface. At the heart of this flexibility are the Modules and the *Image Display* Windows.

The following modules are available for use:

- Temperature Control (Camera TEC)
- Filter Wheel
- Focus Control
- Focus Target
- Frame and Focus
- Histograms
- Image Statistics
- Pan and Zoom
- PHD2 Graph
- Sequence
- Scope Centering
- Telescope
- View Options
- Image History
Camera Temperature Control (TEC)

*Description:* Allows setting and controlling the CCD cooler for cameras that are equipped with a TEC. All values are in degrees Celsius. For more information see the [camera](#).

*Note:* If your camera has a cooler but it is not regulated then the only options available will be "On" and "Off". If your camera does not have a cooler at all all these options will not be available.

**Controls:**
- **Temperature Display:** Displays the following information:
  - Current CCD Temperature / Current Set Temperature (Current Power Level of TEC)
- **Cooler:** Allows for turning the cooler on and off.
- **Set To X in Y:** Allows setting the regulated temperature to X degrees Celsius. The CCD will be cooled to that temperature in Y minutes. If the time is set to 0 then the TEC will attempt to reach the set temperature in the shortest time span possible. Cooling down and warming up over a larger window of time allows for less thermal shock on the CCD and can help to increase the life of your camera.
- **Cool Down:** Will start the camera cool down process as defined in the control panel.
- **Warm Up:** Will start the camera warm up process as defined in the control panel. (*Note:* The camera is not able to warm above ambient so this value should be fairly representative of the ambient temperature).
- **Abort:** Stops the current Cool Down or Warm Up process.

Environment Data

The Environment Data module provides the user with a variety of information about the local environment. Lots of different data types are supported, but it is doubtful any one device (as of the time of the writing) supports all of them. To access this module, simply connect an "Environment Device", and then click on the "cloud" icon on the tool bar.

In this module, you have access to:

- Temperature (°C)
- Humidity (%)
- Dew Point (°C)
- Pressure (hPa)
- Cloud Cover (%)
- Seeing (FWHM)
- Sky Quality (mag"^2)
- Sky Temperature (C)
- Sky Brightness (lux)
- Wind Speed (meters/sec)
- Wind Gusts (meters/sec)
- Wind Direction (compass degrees)
- Rain Rate (mm/hr)

You will also have access to the period of time this data is averaged on the device before it is reported to SGPro. This is identified as the "Average Period". If the average period is 30 seconds, then all of the data presented is representative of the device's reading of that data over a 30 second period.

In addition to this data, given enough time, SGPro will also start to report on trends for available metrics. A trend is identified simply by an "up arrow", "down arrow" or "right arrow". Respectively, this means that SGPro believes this metric is increasing, decreasing or stabilized. The longer SGPro is able to collect this data, the more accurate the trend prediction will be.

**Filter Wheel**

*Description:* Allows direct access to setting filters without going through the Filter Wheel Tab.

The active (set) filter is displayed with bold text (and has a corresponding image of that filter for rapid identification).

**Controls:**
- *Set filter position:* selects the filter to be set. Also see Filter Setup Dialog.
- *Set:* Moves the filter wheel to the selected position (filter).

(Note: If the filter list is empty, it means that your filter list for this sequence has not been defined. Please see this page for help with that).

**Flat Box**

*Description:* Allows direct access to flat box actions without going through the Flat Box Tab.

**Controls:**
- *Brightness:* Manually sets the flat box's brightness level. The position on the left will be equivalent to off and the position on the right will be the max brightness for the connected flat box.
- *Shutter:* Opens (not in use) or closes (in use) the flat box shutter (if your flat box supports this).

**Focus Control**

*Description:* Displays current information about the focuser as well as allowing control of the focuser.

*Note:* Currently Sequence Generator only supports absolute positioning focusers.
Controls:

- **Current position**: displays the current position, generally in steps, of the focuser.
- **Temperature**: displays the current temperature of the focuser (if available).
- **Last Focus Temp**: displays the temperature at which the last focus run occurred.
- **Last Focus Time**: displays the time at which the last focus run occurred.
- **Focus Control**: Allows control of the focuser without going to the Control Panel. See Focusers for more information.
- **Minimum Star Size**: Adjust the minimum diameter of a star (pixels). More information about this in the section detailing Auto Focus. Keep in mind that this is a per-target setting.
- **Run**: Initializes an auto focus run.
- **Settings**: Opens auto focus settings.

Also See:
- Manual Focus
- Focus Reminders

Target Markers

**Description**: Useful for manual focus with a Bahtinov mask or other focusing aid. Allows you to set a focus target as well as an imaging target. This is generally useful for Manual Focusing but not needed for Auto Focus.

Controls:

- **Focus Target / Image Target**: Displays the coordinates of the Focus or Image target
- **Set Focus / Target Position**: Sets the current telescope coordinates as the position for the focus or the target
- **Goto Focus / Target**: Slews to the defined coordinates (as set above).
- **Abort Slew**: Stops the current slew.

Frame and Focus
Description: Allows you to take temporary frames to manually adjust your focus or to verify framing.

CCD Frame and Focus Module:

- **Bin:** Changes the binning of the image.
- **Exposure:** Sets the exposure time of the image in seconds.
- **Start:** Starts a continuous frame and focus loop. Changes to the Bin, Exposure and Crosshairs options will be present upon the completion of the next frame (these options do not alter the appearance of the currently displayed frame). When looping the "Start" button will be changed to "Stop".
- **Take One:** Takes a single frame using the current Bin, Exposure and Crosshairs settings.
- **Use Subframe:** Toggles sub frames on and off. When selected you can use the mouse to create a subframe on a non-subframed image.
- **Crosshairs:** Toggles whether or not new images will show crosshairs. Crosshairs can also be toggled for a single image via the image context menu.
- **Save to disk:** Allows for images to be saved to disk (for third party applications that perform directory monitoring). You are currently responsible for toggling this during the execution of SGPro (it can consume lots of disk space). It will never be checked on SGPro start (this is not a bug... it will never be saved in the checked state). Images will be saved to the sequences's data directory into a sub-folder named "FrameAndFocus". This is where you should point any application interested in this data. At least for now, you will also be responsible for the cleanliness of this temporary data (we might try and auto delete it sometime in the future).

DSLR Frame and Focus Module:

- **ISO:** Changes the ISO setting of the camera.
- **Exposure:** Sets the exposure time of the image in seconds.
- **Start:** Starts a continuous frame and focus loop. Changes to the ISO, Exposure and Crosshairs options will be present upon the completion of the next frame (these options do not alter the appearance of the currently displayed frame). When looping the "Start" button will be changed to "Stop".
- **Take One:** Takes a single frame using the current ISO, Exposure and Crosshairs settings.
- **Crosshairs:** Toggles whether or not new images will show crosshairs. Crosshairs can also be toggled for a single image via the image context menu.
- **Live View:** When enabled, will use the Live View on the camera when "Start" is clicked. Live View has a
much faster image rate, but sacrifices some sensitivity.

- **Save to disk**: Allows for images to be saved to disk (for third party applications that perform directory monitoring). You are currently responsible for toggling this during the execution of SGPro (it can consume lots of disk space). It will never be checked on SGPro start (this is not a bug... it will never be saved in the checked state). Images will be saved to the sequence's data directory into a sub-folder named "FrameAndFocus". This is where you should point any application interested in this data. At least for now, you will also be responsible for the cleanliness of this temporary data (we might try and auto delete it sometime in the future).

---

### Histograms

**Description:**
The histogram module visually displays the pixel intensity information for the selected image. The top histogram shows the un-stretched image data from 0 - 65535. The bottom histogram displays the image data based upon the black and white point sliders. By adjusting the black and white arrows, the stretch on the selected image is changed. This is displayed on the Stretched Histogram as well stretching the on screen display of the image. It's important to note that performing a histogram stretch in this fashion does not alter the original image in any way. This is only for display purposes.

**Options:**
- **Auto Stretch**: Checking this option will automatically perform a stretch on all newly opened images (does not affect the stretch value of the currently displayed image). For more information about stretching please see [Stretching](#). Auto stretch can be set to low, medium and high levels by clicking the small down arrow next to the "Auto Stretch" label.
- **Lock Range**: Checking this option will apply the current stretch to all new images.

---

### Image Statistics

**Description:** The Image Statistics Module displays pixel statistics for the selected image.
Image

This area displays information about the entire image

- **Mean**: Displays the mean value (average) of all the pixel values within the image (ADU).
- **Median**: Displays the median (middle) pixel value of the entire range. The median is halfway between the brightest and darkest pixel (ADU).
- **Minimum**: Displays the minimum pixel value (ADU).
- **Maximum**: Displays the maximum pixel value (ADU).
- **Std Deviation**: Displays the value of one standard deviation of the image (ADU).
- **Total Pixels**: Displays the total number of pixels in the image.
- **Dimensions**: Displays the pixel dimensions of the image (Width x Height)
- **Binning**: If appropriate data is available, the binning of the image will be displayed here
- **Stars Found**: Displays the total number of stars used for the Half Flux Radius calculation. If the frame is not an **Auto Focus** frame or “Calculate HFR” has not been run on this image then “N/A” will be displayed.
- **Half Flux Radius**: Displays the Half Flux Radius of the entire image. The Half Flux Radius is a way to measure the relative size of a star. This metric is useful for determining when an image is focused, the lower the value of this metric the better the focus.
- **Ideal Exp Time**: This metric is designed to display ideal exposure time for your current environment (camera and other atmospheric conditions). In order to calculate this metric, you are required to enter data describing gain and readout characteristics of your camera. This metric is based on the following study ([http://www.hiddenloft.com/notes/SubExposures.pdf](http://www.hiddenloft.com/notes/SubExposures.pdf)).

Notes on Ideal Exposure Time:

This value will be provided only for images that come directly off of the camera (it will not work for images opened off the disk) and requires 5 parameters to be of any use:

- Integration time (automatic input from SGPro for the current camera image)
- Mean background ADU (automatic input from SGPro for the current camera image)
- Gain for the binning used in e-/ADU (user input from the camera tab in the control panel)
- Readout noise in e- (user input from the camera tab in the control panel)
- Percent contribution of read noise to total noise (assumed no more than 5%)

Sampling(21x21)

This area displays information about a 21x21 pixel sample centered at the cursor location

- **Mean**: Displays the mean value (average) of all the pixel values within the sample (ADU).
- **Median**: Displays the median (middle) pixel value of the sample. The median is halfway between the brightest and darkest pixel (ADU).
- **Minimum**: Displays the minimum pixel value (ADU) of the sample.
- **Maximum**: Displays the maximum pixel value (ADU) of the sample.
- **Std Deviation**: Displays the value of one standard deviation of the sample area (ADU).
Observatory

Description: Allows direct access to observatory actions without needing to go through the observatory controls located in the control panel.

The observatory's azimuth and shutter status are displayed at the top for convenience.

Controls:

- **Move left**: Rotates the observatory to the left by the number of degrees in the field directly between the arrow buttons.
- **Move right**: Rotates the observatory to the right by the number of degrees in the field directly between the arrow buttons.
- **Close**: Closes the observatory shutter.
- **Open**: Opens the observatory shutter.
- **Stop**: Stops all movement in the observatory.
- **Goto**: Summons a dialog asking for an absolute position (in degrees) in which to slew.
- **Sync**: Sync the dome azimuth to a specific angle.
- **Home**: Slew the observatory to user defined home position.

Also see observatory settings in the control panel.

Pan and Zoom

Description: Displays the current zoom level percentage as allows you to change the currently displayed portion of the selected image.

Controls:

- **Image Zoom Window**: Displays a thumbnail of the entire image. Clicking on the image will allow you to quickly pan to a specific area of the image. The red highlighted area shows the currently displayed area of the selected image.
- **Zoom Slider**: Moving this slider to the left will decrease the zoom level, moving the slider to the right will increase the zoom of the selected image. The percentage of the zoom is displayed below the slider. This slider allows a zoom range between 25 and 400%.

PHD2 Graph
Description: Displays information from the PHD2 log in order to visualize guiding accuracy.

Note: Logging must be ENABLED in PHD2 Guiding for the PHD2 Graph display to work. If logging is not enabled a Red box will display over the graph. To enable logging in PHD2 go to the “Tools” menu and verify that “Enable Logging” is checked.

Controls:
- **RA/Dec**: Changes the current display of the graph between RA/Dec and dXdY.
- **100**: Changes the number of sample points displayed on the graph. Options are 50, 100, 250, 500.
- **Clear**: Removes all the points from the current graph. New sample points will be displayed starting on the left hand side as they arrive from PHD2.
- **Left Clicking the Graph**: Changes the Y axis range. The displayed above shows a range of -4 to 4 pixels. The options are -4 to 4, -2 to 2 and -1 to 1.

Graph color customization: All of the graph colors can be changed by using the color change dialog seen here.

- To change the background color Right Click on the Graph
- To change the RA/dX Color, left click on the Ra or dX label on the top left of the graph.
- To change the Dec/dY Color, left click on the Dec or dY label on the top left of the graph.

Connecting / Disconnecting Guider Equipment
Clicking the "Connect" or "Disconnect" buttons will connect / disconnect PHD2 gear as defined by the sequence's chosen PHD2 profile. For more details on how to set your sequence's PHD2 profile, go here.

### Sequence

**Description:** Displays real time information about the state of the sequence as allows the sequence to be started and paused.

This module operates differently depending on whether or not the sequence is running.

If no sequence is running, the module displays information about the currently selected target. If a sequence is running, it will always display information about the currently running target.

The first (top) line of this module displays the name of the currently selected or currently running target. Below that are two donut progress graphs that represent the sequence and target progress (respectively). At the bottom of the graph on the left side, the number of completed targets, events and frames for the sequence are displayed. On the right side, the number of events and frames for the selected or currently running target are displayed.

**Run Sequence/Pause Sequence:** Allows the sequence to be started or paused (aborted) depending on the current state of the sequence.

### Scope Centering

**Description:** Allows direct access to the Solve and Sync and Auto Center options in the Plate Solve Tab.

**Controls:**

- **Solve and Sync:** Captures an image and then syncs the telescope to that location.
- **Blind Sync:** Performs a Solve and Sync using the Astrometry.NET blind web solver (Internet connection required).
- **Abort:** Stops the Solve and Sync or Blind Sync process.

Note: The buttons are only to provide a convenient way to access these actions. The actual settings are only available in the control panel. These will need to be checked and set prior to using this module.

### Telescope

**Description:** Displays the current position of the telescope and allows the scope to be nudged (to aid in
Sequence Generator Pro

Controls:

Current Position: Displays the current position of the telescope in RA and Dec.

Time to Meridian/Pier Flip: Displays the time to the meridian or the time until a pier flip will be invoked if Auto Meridian Flip is in use. Negative values will be displayed if the meridian has been passed or the Pier Flip has already occurred.

Park: Runs the Park command for the telescope (mount) and dome (if a dome is connected).

Set Park: Sets the park position for the telescope to its current position (also gives you the option to set the dome park position to its current position).

View Options

Description: With respect to the currently active image, determines how the mouse wheel functions and changes options that govern how new images behave.

Controls:

- Sequence images use new windows: When checked, new images (taken as part of a sequence) will use new display windows rather than reusing the current image display window. Note that this option does not apply to temporary frames (auto focus, frame and focus, plate solve) which always use the same window for display. If this option is not selected, sequence images will replace one another in the same window frame.

- Use mouse wheel to:
  - Stretch Image: Selecting this option, the mouse wheel will stretch the currently selected image's white point (holding the ALT key while moving the mouse wheel will move the black point).
  - Zoom Image: Selecting this option, the mouse wheel will zoom the currently selected image.

Image History

Description: This module will record and show a history of HFR and Star count data for all camera images. This will help you understand, at a glance, if recent images are likely bad (poor guiding, clouds, etc.). Both the HFR and Star count series should be representative of fairly straight lines. If you see a deviation in these lines where HFR increases and star value decreases, then you will want to inspect the image to verify if it is bad. To inspect the image, simply hover the mouse over either of the bad points (on the graph) and click. The image in question will open for inspection. If you want even more details, right click on a point (or click the down arrow on the title bar) and select “Show series details”. This will open a larger representation of the module that includes a text based table used to display HFR and star count for all images. More information on the expanded version can be found here.

A more detailed description (including how data is grouped) of this data can be found by reviewing the documentation for the Image History Tool.
- Enable image history: Checking this will start the collection of data
- Right click to:
  - Open an image for inspection
  - Clear all image history data
  - Clear just a single series
  - Mark an image as bad
  - View details for a particular series
- Click the HFR and STARS labels to change colors

**Helpers / Wizards**

Here you will find information about the various wizards and helpers that Sequence Generator Pro offers.

**Flats Calibration Wizard**

*Description:* The Flats Calibration Wizard is used to automatically find the exposure time needed when taking flats. In general this wizard only needs to be ran once for each equipment configuration. Once the Flats Calibration Wizard is complete the exposure lengths are stored in the "Flats" section of the Filter Setup.
Running The Flats Calibration Wizard:

Before you run the Flats Calibration Wizard you should ensure that:

- Your Flat Box or flat source is setup and ready to use
- Your camera is connected
- If needed your filter wheel is connected.
- If using a Flat Box with controllable brightness you have setup the brightness values to be used for the filters using the Filter Setup dialog.

Once the above are ready you can begin the wizard by selecting the profile that you would like to run calibration for by clicking the Choose button. The following dialog will appear:
If you select "Current Sequence" the equipment and data from the current sequence will be used. However if you fail to save the sequence or you do not save the sequence as a profile then all the flats data will be lost. The preferred method is to run the Flats Calibration Wizard against a profile so that the profile gets updated with the flat exposure information.

Select the Profile you would like to use and click "OK".

If you're using a CCD with a filter wheel then your "Modes" window should look something like the following:

However if you're using a DSLR the binning values will be replaced with ISO Values. Also if you're not using a filter wheel then you will just see the options to set the binning or ISO values.

Select the Binning or ISO values for which you would like to run the calibration.

Next you'll need to enter some parameters to characterize your flats in the Parameter Selection.

- **Target mean**: This indicates the ADU that you would like to obtain for your flats. For CCDs this value is generally between 20,000 and 40,000. Ideally you want your flat data to fall in the area where your CCD behaves in a linear manner. You may need to consult your CCD manufacturer to obtain this information, but typically CCDs behave linearly under 40,000 ADU.

- **Tolerance**: How close must the Flats Calibration Wizard come to your Target mean ADU value before calling the exposure time good. Generally for CCDs this value can be a couple hundred ADU. However
for DSLRs this value generally needs to be higher because they are not temperature regulated and don't have as linear as a response as a CCD.

- **Minimum exposure:** The minimum exposure time that is acceptable for your flats. Again this will depend on your camera. If you have a non-uniform shutter (Qhy9) this value will likely need to be higher than if you have a uniform shutter (SBIG 8300).

- **Maximum exposure:** The maximum exposure time that is acceptable for your flats. This will depend on your light source and the filter you're using. This is mainly just to give Sequence Generator Pro a stopping point when finding the exposure time so that it doesn't continuously adjust the exposure. Setting this to 0 does indicate no maximum, so use accordingly.

Once you have the above values filled in with reasonable values click the "Start" button to run the wizard. The "Modes" will then display what binning/ISO is currently being calibrated and the status of any previously attempted runs. Refer to the "Key" section of the Filter and Mode Selection for information about what specific symbols mean.

### Saving and Using the Calibration Data

When the calibration routine completes, you will need to save the data for future use. If your calibration source (step 1) was a profile, this data will be saved to the profile. If your source data was the current sequence, this data will be saved as part of the sequence.

Once saved, this data can be used in one of two ways:

1. From the flats wizard: Using this tool, you can use existing light sequences to automatically create a variety of flats events (that use this data).
2. By selecting an event type of "flat": Selecting this type will automatically populate events with the appropriate exposure length (as determined by the calibration routine) and count.

### Flats Wizard

Sequence Generator Pro has the ability to easily create a "flats" sequence using only your "lights" sequence as input. Taking the time to collect information about how your equipment needs to capture flats can be a big time saver when capturing flats in the field. The following is a step by step tutorial on using this tool:

1. Make sure that your filter data is set up correctly and that each filter has valid flats data specified. Click here for more information about how to create and use a filter set.
2. Open a "lights" sequence (that uses filters). This might already be open if you take flats after capturing your lights data.
3. Go to the "Tools" menu and click "Flats Wizard". You will be prompted with the dialog below. The flats data will also use the "Auto adjust focus per filter" option. This means that the focuser, prior to capturing flats data, will move to the focus position defined for that filter.
4. You will need to specify some options about how your flats will get created such as:
   1. Flat Event Options
   2. Pause Event Options

5. Once you've selected the options from above click "OK" and the events will be added to your current target or to a new target depending on your selections.

This tool will, in the end, create a sequence that resembles the following ("Horsehead flats" was created from "Horsehead" using the option to "Add flat events to a new target"):

The data it used to populate "Exposure" and "Repeat" are pulled from the filter set data you defined. All other fields are essentially a direct copy of those values found in the "lights" sequence.

Image Grader

The FITS Image Grader is a handy utility designed to perform a focus quality analysis and assign relative grading metrics to your sub-frames. Simply select the FITS files you want to grade, click "Grade" and FITS
Image Grader will calculate "whole-image" Half Flux Radius (HFR) in order to determine the image's relative focus (lower values are better), Number of Stars found and finally a proprietary "Score" that takes both HFR and Number of Stars into account to provide a single metric (higher is better).

What FITS Image Grader is not...

The image grader tool is not an absolute measure of the quality of your images... it grades images relative to one another. This means that if all of your images are consistently and badly out of focus then your images will all likely have around the same HFR and bad images will have good scores (which is less than helpful). You will need at least one image that is of decent quality in order for images of lesser quality to stand out.

Why use star count?

HFR is a fairly resilient metric and as a result, it is normally capable of providing accurate measurement in poor seeing and even through a thin film of clouds. Using star count gives you another point of reference in terms of image quality. While an image with thin cloud cover might have a very similar HFR to a "good" image, the star count is likely to be reduced.

How the final score is calculated

The final score is nothing complex. It is a number between 0-100 (higher is better) that reflects the average of an image's HFR and Star Count scores. The score is RELATIVE and will often give a value of "0" to PERFECTLY GOOD IMAGES. A very low score indicates that an image was of lesser quality than similar images in the set... and that's all. You should always visually inspect low score images.

How images are grouped

When you add images to the grader (use either "Add Files" or "Add Folders"), it will automatically attempt
to categorize the images by filter type and binning mode. It will first inspect the file name for certain patterns and then if that fails, it will open the FITS file and inspect the headers for this information. Only images of similar type are scored against one another (e.g. HA images at 1x1 binning).

Note: Checking include sub-folders will add all files in the selected directory and all files found in its sub-directories.

Renaming images

FITS Image Grader provides several options to rename images as they are graded (see options below). You can choose from several patterns and select from using score, HFR or both as part of the new file names. Additionally, you can copy the file before renaming (see options below).

Reporting and Marking

After a grading session is complete, you can choose to mark images as good or bad (renames files). Either right click on individual images or select them using the check boxes on the left and click either "Mark Checked Good" or "Mark Checked Bad". Additionally, you can create a CSV (for Excel or Google docs) report of the grading run for later viewing.

Notes

FITS Image grader will currently operate on all known variants of the 16-bit FITS format (mono and color). It is optimized to run analysis on well integrated sub-frames from about 2 minutes to 30 minutes in length.

Options

These options control how images are renamed during the grading process.

- **Rename images**: Check this to rename images (in-place) during the grading process. See the rename using section below for more details.
- **Copy and then Rename Images**: Check this to copy the image and then rename images during the grading process. Images will be copied to the selected directory (browse button). See the rename using section below for more details.
- **Rename using**: Rename the files using the calculated HFR, final score or both.
- **Rename location**: Add the data selected in "rename using" to the beginning or end of the file name.
- **Overwrite existing**: Check this to allow overwrite of existing files during the grading process.
Temperature Compensation Trainer
Training Temperature Compensation

Temperature compensation can help to keep you close to focus as the ambient temperature drops. Checking this option in the control panel will allow the focuser to automatically move by an amount relative to the temperature change between successive frames. In order to do this though, you will need to determine your gear's temperature compensation ratio (steps / degree change).

Follow the steps outlined below to find your temperature compensation ratio:

Access the Temperature Compensation Trainer through the "Tools" menu. Ensure that both a camera and focuser are connected.

1.) Using the camera, enter the frame and focus routine and come to focus (using a bahtinov mask is helpful here).
2.) Click "Start" and let the trainer run until you have around a 5 degree drop in temperature.
3.) Again, use the camera's frame and focus routine to regain focus.
4.) Click the "Stop" button.
5.) Click OK to save your temperature compensation coefficient to the sequence.

Note: A negative coefficient (steps / degree) indicates that your focuser will move IN as temperature drops.

Meridian Flips

Sequence Generator Pro, when used with PHD2 or better can provide you the ability to perform an automated meridian flip. This function can be run manually, by clicking a single button or you can let the sequence decide if it needs to run a flip based on settings you provide.
A Brief Summary of Automatic Meridian Flips

1. Stop auto guiding: Simply sends a command to PHD2 requesting a stop.
2. Flip the mount: Send a signal to the mount to flip sides. This is based on input that provides the number of degrees past or before (negative values) the meridian to invoke a meridian flip during a sequence. Not all telescopes allow for setting of SideOfPier. For these telescopes it is best to always use a positive value. For details take a look at the telescope control panel page.
3. Perform auto centering (optionally): Performs a precision centering to ensure that your target is still centered on the other side of the mount.
4. Restart guiding: Send a command to PHD2 to automatically select a guide star and resume guiding.

The Meridian Flip Status Window

---

**Framing and Mosaic Wizard**

Instructions for use:

- Select “Framing and Mosaic Wizard” from the tools menu
- You will be presented with a “longish” dialog with 4 distinct steps.
- In order to fetch your "canvas" (area of the sky to capture), you must be connected to the Internet

Menu options:

- Profile: Using this option will present a list of equipment profiles. Selecting one will overwrite Scale and Camera Dimensions with those in your profile.
- Other
  - Fetch location from mount: While you can provide data in the form of object name, another image or custom RA and Dec in order to fetch your working canvas, you can also choose to
have the RA and DEC locations populated using your telescope's current location (by clicking this option). This will fetch RA and DEC and then populate those boxes on the form. You will still need to click "Fetch" when ready.

The steps below, in general correspond to the black circular numbers found on the mosaic dialog:

- **Step 1**: Choose the area of the sky that you want to capture. This area should contain more data than you want to actually capture. To get your "mosaic canvas", identify a name (like M42 or NGC6144) and define a field of view in degrees. Clicking fetch will resolve the name into J2000 RA and DEC coordinates and then download the canvas from the DSS. Keep in mind that asking for very large fields might take a bit of time (typically 8 degrees takes about 30 seconds and this will scale almost linearly). Fear not though, once you download an image we will cache it so you can refine your mosaics later without re-downloading.

  Optionally, you can bypass the name lookup completely, click the "RA/DEC" radio button and enter the J2000 location manually. Note: You can also specify URLs from DSO-Browser, Astrobin or Flickr images that have been solved. Some plates have different background levels than others and you will need to use normal stretching routines to make the image more clearly visible (finding nebulosity, etc)

  - You can also use an existing FITS image (taken from SGPro). This will create an image canvas centered on the image you provide. A blue rectangle will be drawn around the area captured in the image your provide. In this way you can extend existing images by drawing frames that overlap your existing frame.
Here the blue rectangle represents the area that your existing image occupies. You can then figure out how you would like to extend it by drawing the normal red rectangles over this area. Here are a couple examples:
Or more complex...
In this case, you would likely delete target 5 after the mosaic sequence was created.

- **Step 2**: Define your camera data. This is pretty straightforward... define your image scale at 1x1 binning and the number of physical pixels on your CCD. These values are part of equipment profiles and will be automatically populated using that data. Finally define the desired overlap between tiles here. If you are unsure of your scale, a calculator has been provided (click the "*" button next to scale).

The mosaics and framing wizard will allow you to populate the scale and camera pixel values from any equipment profile you have available. To switch profiles (if you want to draw a mosaic with a different set of gear), find the "Profiles" menu at the top of the tool and select the profile you want to use.

- **Step 3**: Define the area you want to capture. Using the mouse, drag a rectangle over the area you are interested in capturing. The wizard will automatically calculate the number of tiles in your mosaic and number them according to capture order. You can toggle the tile grid on and off using the "Show tiles" checkbox. You may notice that the size of your capture area will expand after it is defined. This is
because the wizard will snap to the minimum number of camera tiles required to cover the area of interest. After drawing the capture box, you can then use the mouse to move it around (by dragging). Finally, rotate the canvas to either match your camera angle or to find the angle your camera will need to be at when you start capture. **The rotation angle is indicative of the angle your camera needs to be at to capture your target!**

- **Note:** After drawing the initial rectangle on the canvas, you can adjust the number of horizontal and vertical tiles by hand simply by entering them into the step 4 area. This will automatically adjust the size of the capture area without having to continually redraw in order to achieve the desired size.
- **Tip:** Camera angle is extremely important when capturing mosaic tiles! If you don’t have a mechanical camera rotator, you can use the *[SGPro manual rotator tool]* to make sure you are all set before capturing.

- **Step 4:** Create the sequence. After all of this is defined to your satisfaction, simply click the "Create Sequence" button. You will be presented with a small dialog that asks you for the mosaic name, whether or not you want to append targets or replace targets and finally whether or not you want to save the working canvas with the new mosaic sequence (as a reference... see Sequence Images below).

  - **Name:** This is the base name of the target set that will be created. If you use "M42" and have 4 mosaic tiles, your sequence will contain targets M42-1, M42-2, M42-3 and M42-4.
  - **Targets:** Append to or replace the current target set.
  - **Auto rotate:** Check this box if
    - You have a [*rotator*] and would like the sequence to automatically rotate to the required angle
    - You would like to use the [*manual rotator*] (which will verify your camera’s angle and
When you complete step 4, you will have a sequence that contains a target for each mosaic tile. Each mosaic will have the "Center On" checkbox marked and the appropriate centering location populated. None of these targets will have any events populated. The best way to populate events (since most of the panels will have the same or similar event composition) is to create events for the first target and then using the new "Copy event to..." function (right click target), copy the events to all the other targets.

**Sample Canvas:**

![Sample Canvas](image)

*Note:* You can easily refine the center position of your mosaic canvas by right clicking on an existing canvas and choosing "Center Here". This will download a new canvas with the specified field of view where you clicked.

---

**Target Imports**

Sequence Generator Pro can import target sets (lists of targets) from both AstroPlanner and Starry Nights. When a target is imported into Sequence Generator Pro it will appear in the "Target List" box of the sequencer. Inspecting its properties will show that it also imports the location specific to that target.

To do this, click in the File menu, then on the "Import Targets" menu. Finally, select the application from which you would like to import:
After selecting a file for import, you will be presented with a dialog that will allow for imported targets to be created with centering or slewing options checked by default (otherwise SGPro will assume that will do this manually). Obviously, these options should only be used if you are importing location data (in J2000).

AstroPlanner

If you are using AstroPlanner 2.2 or earlier:

1. Have your plan document open and at the front.
2. File > Export > Generic Text, Excel, XML, or JSON file…
3. Click the Clear All button under the Field Definitions list.
4. Select XML as the Text Format.
5. Make sure the Use localised formatting checkbox is OFF
6. Click the "+" button under the Field Definitions list.
7. Using the Value popup, select Object: ID
8. Click the "+" button under the Field Definitions list.
9. Using the Value popup, select Object: RA
10. Click the "+" button under the Field Definitions list.
11. Using the Value popup, select Object: Dec
12. Choose what plan objects you want to export in Objects to export.
13. Click Export… to export the XML file. Note that you might have to edit the exported file's name to have an .xml extension afterwards.

If you are using AstroPlanner 2.3 or later:

Simply select File > Export > Sequence Generator Pro Target List…

Starry Nights
Starry Nights requires that you create an "Observing List" and then export this as a simple text file. To do this, first click on the "Lists" tab (on the left side). Once this tab is open you either need to select or create a new Observing list:

Finally, after selecting the list of interest, there will be an "Export" button at the bottom of the tab pane (below all the targets in that list):

Click export and save the file to disk. This is the file you will want to import into SGPro.

**DSO-Browser**

Unlike the other types of imports, this option does not require ingestion of a file. Instead, you will use the website address of your DSO-Browser observing list.

When you arrive at the DSO-Browser website and log in using your DSO-Browser account, you will see a navigation bar at the top. Choose the "My Observing List" option.

When you click this menu item, you will be presented with your DSO-Browser observing list. If it's your first time here, it will be empty. Follow local instructions to populate your list. What SGPro needs in order to produce viable targets from your list is the URL. At this point, you can just copy it from your browser's address bar:
Then in SGPro, simply paste it into the target import dialog:

![DSO-Browser List Importer](image)

Click OK and you're done!

Note: The DSO-Browser list import will populate **suggested** start and end-times based on visibility at your location. You will need to review these times before running the sequence.

---

**Image History**

The Image History tool will give you insight, at a glance, as to which recently captured images might be bad. Each series is defined by the target, binning and filter and contains data for HFR and Star Count. Regardless of the originating event, a history item will be grouped together if all three of these items are identical. Using the drop down box at the top, you can select any series and view a chronological display of HFR and Star count data. In an ideal world, both HFR and Star Count would remain relatively flat. In reality, there are many environmental factors out there that aim to destroy your images... temperature drop, clouds, guiding, differential flexure, etc. If you see a significant deviation from a typical straight line, this might be an indication of a bad image. To inspect an image, simply double click on the list view or click on the graph point representing the image you would like to inspect. If you decide it's bad, simply click the "X" icon on the image or right click the image in question and choose "Mark as Bad". This will prepend the image with "BAD".

Notes:

- The collection of image history data is disabled by default. To enable it, check the "Enable image history" checkbox below.
- To change the color of either the HFR or Star Count series, click the corresponding label and choose a new color.
To clear all image history, right click almost anywhere and select "Clear image history". You can also clear just the current series by clicking "Clear current series".

Thus tool has a **dockable module counterpart** for convenient viewing:

*Possible example of bad image from temperature drop (loss of focus):*
Notice the drop in star count with a simultaneous rise in HFR.

*Possible example of bad guiding on a single frame:*

![Graph showing star count and HFR](image1)

Notice the star count was relatively constant, but HFR increased. The next frame returns to normal.

When you are imaging in a star rich area, the number of stars that can be detected is capped at 300. In this case, the graph will appear as such:

![Graph showing star count and HFR](image2)

Notice the star count is constant, but bad images are still easily detectable by referencing the HFR data. In this case images 7, 8 and 10 are bad (this graph is from real data).

---

**Notification System**

The Notification System on SGPro is an *optional addon*, but can be quite valuable if you don't sit outside to monitor the sequence and equipment responsible for its execution. With it, you can register for all sorts of sequence driven events and receive them via email, SMS (text message) or GNS (*Good Night System*).

In order to start configuring the way you receive notifications, open SGPro and click the "Tools->Notification" menu items. Upon doing so, you will be greeted with a settings window like this:
On the left, you will see "Endpoints". An Endpoint is meant to be the final destination of any notification. In its current form, SGPro supports the GNS and Email endpoints (most cell carriers allow you to specify an email for SMS relay as well).

On the right side you will see a list of notification categories. There are far too many notifications to list individually so we have divided all notifications in SGPro into six different categories:

- **Status**: These notifications are normal and pretty closely mimic the types of messages you would see in SGPro’s own notification area (on the bottom left corner of the main window).
- **Alerts**: These notifications mean that SGPro is waiting on you to do something and will not continue until you provide some sort of input. Examples include pausing for manual focus, pause after meridian flip and use of the Manual Camera Rotator.
- **Warnings**: These notifications indicate something may be wrong, but that the sequence is still running. An example of a warning would be failure to achieve an auto focus value the way we intend to (best fit line intersection). Receiving a warning in this way, means that we defaulted capture of this value to an older method because the intended method did not function properly. When you receive a warning, it is probably a good idea to go check on things.
- **Errors**: These notifications mean something bad has happened and the sequence has stopped. An example of this would be failure to reacquire the target after a meridian flip. If you use recovery mode an error message will not be sent until recovery has also failed.
- **Timed Errors**: These notification errors are designed to alarm if certain events don’t complete within a specified time period. An example of this is with sequence image capture... if SGPro is not in possession of an image within exposure time plus three minutes, this type of error notification will be sent. This can help to identify camera communication problems.
- **Heartbeat**: These notifications are for folks that want a great deal of visibility into the sequence. Sometimes SGPro can go long periods of time without any notifications... especially when taking long duration images. If you select this option, you will receive a notification once every 2 minutes indicating that SGPro is healthy. Failure to receive this message might indicate that SGPro or the Operating system has failed in some way.

### Endpoints

Each endpoint will require some amount of setup in order to be used. You can access an Endpoint’s setting
by highlighting it and then clicking the "Settings" button at the bottom.

**Good Night System Settings**

To use GNS, you **must** complete set up on the iOS or Android application using your mobile device. This endpoint also requires a GNS client for Windows. There is no need to download or install this as it is distributed with SGPro 2.4 and higher. Once you have downloaded the mobile application, go to the Windows Command Line (terminal) and type "ipconfig". Find the IP address under the heading **IPv4 Address** and enter this into the GNS mobile app "Host" setting. That should really be it... the rest of the settings are probably OK.

By default, the GNS endpoint will only sound an alarm on error messages (those that stop an event). If you would like the GNS alarm to sound when SGPro issues a warning notification (something might be wrong), make sure this option is checked.

**Email Settings**

There are three different email endpoints. Each is identical to the next in terms of functionality, but you may wish to have different sets of filters for different addresses (for instance, you may want all events to go to your email account, but only warnings and errors to go to your SMS account).

Use this settings dialog to prepare for email and text based notifications. This is a one time setup used
across all sequences.

**Outgoing Email Information:** This area contains information about the address the notifications are going **TO.** Enter the address you wish to receive your notifications at... you can enter multiple addresses if you'd like (one at a time though). The example above shows one normal email address and one Verizon based SMS email. Checking the "Send notifications immediately" button will send an email every time a notification is registered in SGPro. While sometimes useful, this may result in a lot of emails and, depending on your provider, you might be flagged as a spammer and shut down. Clearing this option will allow SGPro to aggregate notifications and send them out in 5 minute increments.

**SMTP Server Settings:** This area contains information that SGPro uses to send your notifications out. Normally it is permissible to use the same account you used in the Outgoing Email Information section. SGPro does its best to auto enter data for many ISPs (bases on the domain of the SMTP user field). If we know what it is, we will auto-populate the fields, if not, they will remain blank and you will need to find them.

- SMTP User:  The account you will use to log into the SMTP server (mail server)
- SMTP Password:  The password for the SMTP user account
- SMTP Server:  The address of the SMTP server
- SMTP Port:  The port used by the SMTP server
- Use SSL:  Check this is your SMTP server requires SSL communication (most do)

When done, click the "Add" button and then click the "Test" button to ensure the settings are correct. You should receive a test email from the SMTP user (be sure to check your SPAM folder if SGPro indicates success but you still don't see a message).

In order to update these settings, highlight the address you want to change, make changes in the fields provided and then click the "Update" button.

**Note for GMail users:** SGPro can sometimes be flagged as a "less secure application". In order to use gmail with SGPro, you might need to go here and allow less secure applications access to your address: https://www.google.com/settings/security/lesssecureapps

**Text File Settings**

There are three different text file endpoints. Each is identical to the next in terms of functionality, but you may wish to have different sets of filters for different files (for instance, you may want all events to go to one file, but only warnings and errors to go to another).

- **Text File Path:** The absolute path of the file to use (write to). It must be either a txt or csv file.
- Create a new text file every time a sequence runs: This will create a new (unique file) based on the file name you supplied. A new file will be created every time a new sequence is started.
- Truncate (erase) file contents every time a sequence runs: Use this option to truncate the contents of the file every time you start a sequence.
Write out a CSV file: Use this option if you prefer to view these files as a spreadsheet (better filtering, etc).

SGPro 2.5 Sequence Migration

SGPro 2.5 was introduced with some fairly substantial changes to the way in which it stores sequence and equipment profile data. The most prominent change (to the user) is the movement of settings that used to be global into individual settings and profiles. As an example, the setting to use Astrometry.NET remotely or locally (ANSVR) used to be global (meaning, the same for all sequences and profiles). Now, in 2.5 this setting belongs uniquely to each sequence or profile.

Affected settings (these are global in SGPro 2.4 and are now part of sequences and profiles in SGPro 2.5) are as follows:

- Astrometry.NET settings
- Pinpoint settings
- Alnitak flatbox settings
- All Canon camera settings
- All Nikon camera settings
- All SBIG camera settings
- All SBIG CFW settings
- All FLI Camera settings
- Some QSI camera settings

In order to alleviate support issues and general confusion, SGPro 2.5 provides a sequence and profile migration tool (Tools->Sequence & Profile Migration (v2.5)) that will handle all this stuff for you (if you want to have it automated):
The introductory paragraph has pretty concise instructions, but to summarize, you can:

- Migrate a folder of sequences only
- Migrate your sequence profiles only
- Migrate both at one time

Migrations modify and save your files in place. This means that some of their settings will be overwritten during the process. If this makes you nervous, make sure the “Backup data prior to migrating” option is selected.

*Note: If you migrate your equipment profiles, you will need to restart SGPro!*

*Note: If you migrate a sequence that is currently open, you will need to reload it in order to see the newly migrated settings.*

**Environment Options**

In addition to **Sequences** and **Profiles**, Sequence Generator Pro also has some options that are set at an application level.
General Options

Description: The General Options tab can be accessed by using the "Tools" menu and selecting "Options"

General Options:
- Show tooltip help when hovering over controls: Specifies if tooltips should be shown when running Sequence Generator Pro. These can provide quick help and information about what specific button/fields to but they do not augment this document.
- Auto save the sequence: When checked the sequence will be saved every 30 seconds. This is useful if something hangs or you make changes to your sequence and forget to save them. For this to function you must create and save the sequence initially.
- Prompt to import filter wheel data: Some filter wheels allow for SGPro to import positional filter data from the driver itself. If SGPro detects the filter wheel can do this and the filter list is not defined, the user can optionally import the driver's filter data into the SGPro filter list.
- Display this reminder message prior to commencing sequence: Allows you to enter a message that will be shown whenever the "Run Sequence" button is pressed.

Default File System Settings:
- Profile Directory: SGPro stores equipment profiles as *.sgp files and user profiles as *.sgu files. When you create new profiles they will be saved to this directory. By the same token, if you navigate to this directory, you can copy, backup or transport all of your profiles (possibly to a new machine).
- Default Directory: Allows you to specify a default directory for saving images in. Whenever you create a new sequence this directory will be set as the save directory.
• **Custom file name pattern**: Allows you to specify a default file naming pattern that will be used on all new sequences.

**Interface Elements**

• **Auto stretch level**: By default, new images will use this level for auto stretch. The "high" setting uses the most aggressive stretch. See [image stretching](#) for form information.

• **Find stars method**: This option defines how stars are found for "Image History" events. This setting does not affect how Auto Focus stars are found. It is highly recommended that this setting be left at "Normal". Alternatively, if you have a camera with very large dimensions (like a DSLR) and a slow computer, finding stars with the normal method may be very slow. If this is the case, it is permissible to use the fast star finding method (less accurate).

---

**Sequence Settings**

**Description**: The Sequence Settings dialog can be opened from the Tools menu under Options. These options relate to global sequence settings.

**Default Sequence Settings**

- **Number of events for new sequences**: Sets the initial number of events that new sequences will be created with. The default is 5. Additional events can be added or deleted at a sequence level.

- **Delay Options**:
  - **Delay First**: Sets a delay in seconds before the first frame is taken after "Run Sequence" is pressed.
  - **Delay between**: Sets a delay in seconds between each frame.

- **Sequence order**:
  - **Rotate through events**: This will run one frame from each event and then move onto the next frame.
  - **Finish entire events first**: Completes the entire sequence before moving onto the next.

- **Sequence actions**:
  - **Capture calibration frames even if the sequence fails to complete**: Ensures calibration frames are captured even if the sequence fails.

- **Sequence sound options**:
  - **Completed**: A sound can be played when the sequence is completed.

**Controls**

- **Number of events for new sequences**: Sets the initial number of events that new sequences will be created with. The default is 5. Additional events can be added or deleted at a sequence level.

- **Delay Options**:
  - **Delay First**: Sets a delay in seconds before the first frame is taken after "Run Sequence" is pressed.
  - **Delay between**: Sets a delay in seconds between each frame.

- **Sequence order**: These options change how events are ran when the sequence is running.
  - **Rotate through events**: This will run one frame from each event and then move onto the next frame.
event.
  o *Finish entire events first:* This will complete all of the frames in an event before moving onto the next event. This is generally the recommended method.

- **Sequence recovery:** This option will allow you to turn sequence recovery on or off. Additionally, you can define how often and for how long the sequence will try to recover. This is great for people that are imaging with intermittent clouds and will allow the sequence to continue if the weather turns cloudy for a few minutes. More on sequence recovery can be found here.

- **Sequence actions:**
  o *Capture calibration frames even if the sequence fails to complete:* Use this option to force the capture of flats, darks and bias frames even if capture of "light" images fails due to weather or other reasons. Checking this option will cause all end of sequence options to run (except camera warm up) and will then proceed to capture calibration frames. This means that, if you have it checked, the mount will park (possibly point to a flats light panel). When calibration frames are complete, camera warm-up will start (assuming you have that option selected).

- **Sequence sound options:** Allows a sound file to be played to get your attention when the sequence completes or when it needs your attention.
  o *Completed:* Sound that will be played when all events in the sequence have been completed.
  o *Attention:* Sound that will be played when Sequence Generator Pro needs you attention, such as manual focus and pause events.

- **Attempt to automatically recover the sequence:** This option allows SGPro, in the event of certain types of fatal sequence errors, to try and automatically recover the sequence. More details on this can be found here.

---

**Other Equipment Options**

Currently, this tab is only used for TEMPerHUM devices. It is off by default because looking for these devices can sometimes interfere with the detection of other USB HID devices. If you would like to use a TEMPerHUM device, check this box and then open the TEMPerHUM graph display [here](#).

If you would like to use your TEMPerHUM device as input to control temperature based focus triggers and temperature compensation, you can select this option [here](#) (at the bottom of the page).
Sequence Generator Pro has many keyboard shortcuts available. A good deal of them can be found by inspecting the menus. Here is a comprehensive list of current shortcut commands:

### Windows

- Control+W: View the sequencer
- Control+E: View the equipment control panel
- Control+B: View the "Big Status" window
- Control+P: View the equipment profile manager
- Control+U: View the user profile manager

### Opening / Saving / New

- Control+S: Save the sequence
- Control+Shift+S: Save the sequence as...
- Control+O: Open a sequence
- Control+I: Open an image
- Control+N: Create a new sequence
- Control+Shift+N: Create a new sequence using a profile
- Control+R: Reset the progress of the sequence
- Control+Shift+R: Restart the current frame
Equipment

- Disconnect all Equipment: Ctrl+Shift+D
- Connect all Equipment: Ctrl+Shift+C

Sequence

- F5: Start a sequence

Image Display Manipulation

- Left / Right Arrows: Adjust white point (Screen Transfer Function). See image stretching for form information.
- Alt+Left / Right Arrows: Adjust black point (Screen Transfer Function). See image stretching for form information.
- Up / Down Arrows: Adjust image zoom

Other

- Up, Up, Down, Down, Left, Right, Left, Right, B, A, B, A, Start: Explodes your equipment

License Management

When you purchase a retail license of Sequence Generator Pro you reserve the right to install it on up three personally owned machines. These licenses are self managed through a combination of the website (http://www.mainsequencesoftware.com/AccountManagement) and the actual SGPro application.

When you purchase SGPro, an account will be created automatically and sent to your email address. This is the account you will use to log in to the Main Sequence Software site and also to register machines for use of Sequence Generator Pro.

Management

When you purchase a retail license of Sequence Generator Pro you reserve the right to install it on up three personally owned machines. These licenses are self managed through a combination of the website (http://www.mainsequencesoftware.com/AccountManagement) and the actual SGPro application.

When you purchase SGPro, an account will be created automatically and sent to your email address. This is the account you will use to log in to the Main Sequence Software site and also to register machines for use of Sequence Generator Pro.

To Register Sequence Generator Pro

Open SGPro and navigate to the "Help" menu:
Choose "Register this Machine":

In this dialog, enter your username / PayPal email address and then the password that was sent to you when you purchased SGPro. Click Register and this machine will be set up for retail use of Sequence Generator Pro until you remove it.

**Managing Your Licenses**

If you need to re-arrange your licenses (add or remove authorized machines), navigate to [http://www.mainsequencesoftware.com/AccountManagement](http://www.mainsequencesoftware.com/AccountManagement) (from SGPro you can also choose "Manage Licenses" from the "Help" menu) and perform a log in.
After a successful login, you will be directed to a screen showing your purchases and active machines:

On the left, this screen shows a purchase of SGPro on 7/16/2013 and that there are 2 licenses remaining for other install on other machines. The right side allows you to manage licenses. To remove a machine, simply click the red trashcan icon. This will reclaim one of your machine licenses and allow you to go through the process above with a new machine.

**Checking Your License Status and Add-on Trials**

When running SGPro, you can check the current status of your licenses (SGPro and any available add-ons) by navigating to the "Help" menu and selection "License Information":

---

**Local account**

User name: ken@mainsequencesoftware.com
Password: ********

[Image of login screen]

Forgot your password?

---

[Image of purchase screen]

<table>
<thead>
<tr>
<th>Product</th>
<th>Purchase Date</th>
<th>Remaining Licenses</th>
<th>Sequence Generator Pro Machines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence Generator Pro</td>
<td>7/16/2013</td>
<td>2</td>
<td>BUZZKILL-PC</td>
</tr>
</tbody>
</table>

---

[Image of Help menu]

---
This dialog shows that SGPro is a retail license and that the user has started a trial for the "Framing and Mosaic Wizard". Clicking "Refresh Licenses" will do exactly that (you should almost never need to use this). If you own SGPro and would like to start a trial for an addon, come to this dialog, select the add-on you are interested in and then click "Start Trial". After confirming, you will have 45 start an unrestricted 45 day trial for that add-on.

Trouble Registering SGPro

This troubleshooting guide assumes that you are using a personal machine that has an active Internet connection. Initial registration of SGPro requires an Internet connection. After initial registration, you can be out of range of the Internet and SGPro will start just fine.

If you have followed this guide and still cannot register SGPro, it is time to reset your password.

1. Navigate here to begin the password recovery process. Remember that you must use the email address associated with the PayPal account you used to purchase SGPro!

2. An email will be sent to the email account you entered in step 1 (check your Spam folder if you do not receive an email within 5 minutes). Complete the password recovery process by following the instruction in the email.

3. Next, using your new password, make sure you can successfully login to the MSS website.
4. Once logged in you will see a "Manage" button on the right side of the navigation bar, hover over this and click "Product Licenses"

5. Make sure that you have at least one of your three licenses remaining in order to register the new machine.

6. If you need to, click on the "Trashcan" icon to free up licenses.

7. Follow the normal registration procedure now. Keep in mind that you register SGPro with the same exact credentials you just used to login to the MSS website.

API Documentation

This section of the documentation is meant for other developers who are attempting to interface with Sequence Generator Pro in a programmatic way. If you are not a developer, you can skip this section.

Sequence Generator Pro offers a modest API to external applications that want to use it in order to capture image data (for external analysis) or to manipulate other equipment connected in SGPro. In an effort to be device and protocol agnostic, SGPro uses an HTTP based API. This means that you can make calls using SOAP, JSON, XML, JSV or CSV. Whatever your comfortable with... Almost every platform you use has a client library to help you use API calls using one of these. In terms of non-SOAP calls you can think of the API calls at REST if it makes it easier for you. That said, the SgPro API does not operate around data models and is not technically RESTful, but it does use the same basic set of protocols for communication.
To get more information about the API:

1. Start Sequence Generator Pro (version 2.3 or higher)
2. Using your favorite browser, navigate to http://localhost:59590/metadata

When you do so, you will see an API documentation page that looks similar to:

**Operations:**

<table>
<thead>
<tr>
<th>Function</th>
<th>XML</th>
<th>JSON</th>
<th>JSV</th>
<th>CSV</th>
<th>SOAP 1.1</th>
<th>SOAP 1.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>SgAbortImage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgCaptureGuiderImage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgCaptureImage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgGetDeviceStatus</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgGetFilterPosition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgGetFocuserPosition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgGetGuiderImage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgGetGuiderInfo</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgGetImagePath</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgGetTelescopePosition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgSetFilterPosition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgSetFocuserPosition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SgSlewTelescope</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This page outlines API calls available in SGPro. Here we will go through an example of how to interpret docs for a JSON call (others are similar).

First, go ahead and click the "JSON" link for one of the simpler calls "SgGetDeviceStatus". You should see something similar to:
**SgGetDeviceStatus**

Query a device to get its status. Possible states are "IDLE", "CAPTURING", "BUSY", "MOVING", "DISCONNECTED", "PARKED".

The following routes are available for this service:

<table>
<thead>
<tr>
<th>Verb</th>
<th>URI</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Verbs</td>
<td>/devicestatus/{Device}</td>
</tr>
<tr>
<td>POST</td>
<td>/devicestatus/</td>
</tr>
</tbody>
</table>

**Parameters:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Parameter</th>
<th>Data Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>path</td>
<td>string</td>
<td>Yes</td>
<td>The device type to query. Values are &quot;Camera&quot;, &quot;FilterWheel&quot;, &quot;Focuser&quot;, and &quot;Telescope&quot;. Will query the selected device for status. States are &quot;IDLE&quot;, &quot;CAPTURING&quot;, &quot;BUSY&quot;, &quot;MOVING&quot;, &quot;DISCONNECTED&quot;, &quot;PARKED&quot;.</td>
</tr>
</tbody>
</table>

To override the Content-type in your client's HTTP Accept Header, append ?format=json
To embed the response in a jsonp callback, append ?callback=myCallback

**HTTP + JSON**

The following are sample HTTP requests and responses. The placeholders shown need to be replaced with actual values.

```
POST /json/reply/SgGetDeviceStatus HTTP/1.1
Host: localhost
Content-Type: application/json
Content-Length: length

{"Device":"Camera"}

HTTP/1.1 200 OK
Content-Type: application/json
Content-Length: length

{"State":"IDLE","Success":false,"Message":"String"}
```

At the top, you will see a brief description of what the call does... It is important to note that this is the area that will describe the meaning of return / response values. Below it you will see a set of supported HTTP verbs. Some calls support all HTTP verbs and some, if they are more complex, use only "Post". For instance, the call to capture an image looks like:

**SgCaptureImage**

Ask SGPro to capture an image. This is an asynchronous operation and will return immediately. The return type (SgCaptureImageResponse) will contain a GUID and this can be used to retrieve the image when it is complete (using /imagepath/{Receipt}).

The following routes are available for this service:

<table>
<thead>
<tr>
<th>Verb</th>
<th>URI</th>
</tr>
</thead>
<tbody>
<tr>
<td>POST</td>
<td>/image</td>
</tr>
</tbody>
</table>

Below that you will see an input parameter listing. This one has only one value named "Device". As you can see in the "verb" section, there is a URI labeled /devicestatus/(Device). This is meant to indicate that you substitute (Device) with the name of a real device like "Camera". For instance, the URI /devicestatus/Camera will return the status of the camera.
The very bottom block shows the structure of the response type (of course JSON in this case). Keep in mind that this is not RESTful. You can receive a response code of "200 OK" and still have a failure. Of course, if you do receive a response code other than 200, it does indicate a failure as well. The type of response object for various calls is dependent on the call itself. That said, all response object will return a boolean value for "Success" and an associated "Message" (string). Specific to this call you will see an additional "State" property. As indicated in the call's description, this can contain "IDLE", "CAPTURING", "BUSY", "MOVING", "DISCONNECTED" or "PARKED" (assuming Success is True).

**Further Help**

In order to get further help please feel free to join our forum here [http://forum.mainsequencesoftware.com](http://forum.mainsequencesoftware.com) or contact our "info" address located on the website support page. Lastly, we have provided an example of taking an image with the camera [here](#). This example happens to be from a C# console application and uses the RestSharp and the Newtonsoft JSON helper libraries.

---

**JSON Example**

This example happens to be from a C# console application and uses the RestSharp and the Newtonsoft JSON helper libraries. There are literally hundreds of ways to write this in almost any language or operating system available.

```csharp
// Let's take an image! This code snippet is from Main or some other control location
// Take a 1x1 image for 15 sec with the shutter open
SgImage img = new SgImage() { BinningMode = 1, ExposureLength = 15, FrameType = "Light", Path = @"Z:\temp\myImage.fit" }; Guid imgReceipt;
if (!TakeImage(img, out imgReceipt))
    return;
Console.WriteLine("Camera image started!");
Console.WriteLine("Checking for image done with receipt " + imgReceipt);

string path = "NA";
// Check every second or so to see if the image is ready
while (!File.Exists(path))
{
    GetImagePath(imgReceipt, out path);
    System.Threading.Thread.Sleep(1000);
}
if (path == "abort")
    Console.WriteLine("Exposure aborted by user from SGPro...");
else
    Console.WriteLine("Image found at: " + path);

// The guts of TakeImage
private static bool TakeImage(SgImage img, out Guid receipt)
{
    RestSharp.IRestClient client = new RestClient();
    var request = new RestRequest(Method.POST);
    request.Resource = uriBase + "image";
    // ...
request.RequestFormat = DataFormat.Json;
request.AddHeader("Accept", "application/json");
request.AddBody(img);

IRestResponse response = client.Execute(request);
SgImageResponse good = JsonConvert.DeserializeObject<SgImageResponse>(response.Content);
if (!good.Success)
{
    Console.WriteLine(good.Message);
    receipt = Guid.Empty;
    return false;
}
receipt = good.Receipt;
return true;

private static bool GetImagePath(Guid receipt, out string path)
{
    RestSharp.IRestClient client = new RestClient();
    var request = new RestRequest(Method.GET);
    request.Resource = uriBase + "imagepath/" + receipt;
    request.RequestFormat = DataFormat.Json;
    request.AddHeader("Accept", "application/json");

    IRestResponse response = client.Execute(request);
    SgGenericResponse good = JsonConvert.DeserializeObject<SgGenericResponse>(response.Content);
    if (!good.Success)
    {
        Console.WriteLine(good.Message);
        path = "NA";
        return false;
    }
    // When successful, Message will contain the path to the image (this might not be
    // the same path you passed in)
    path = good.Message;
    return true;
}

// DTOs
public class SgGenericResponse
{
    public bool Success { get; set; }
    public string Message { get; set; }
}

public class SgImage
{
    public int BinningMode { get; set; }
    public int IsoMode { get; set; }
    public int ExposureLength { get; set; }
    public string Gain { get; set; }
    public string Speed { get; set; }
    public string FrameType { get; set; }
    public string Path { get; set; }
}
Troubleshooting

SGPro Won't Start

In rare cases SGPro has been known to simply not start. This is not intended as a solution if SGPro has never started, but if it had been working properly and then suddenly stopped starting, it is likely that the SGPro settings repository has been corrupted.

In this case, it is possible to start SGPro in a recovery mode that take special actions in order to repair the corruption (saving as many of your settings as possible):

Open a Windows command prompt:
Then, navigate to the install directory for SGPro (typically here):
Then, start SGPro in recovery mode via:

> "Sequence Generator.exe" /recover

If that does not start SGPro successfully, you might need to resort to resetting all SGPro settings:

> "Sequence Generator.exe" /reset
c:\Program Files (x86)\Sequence Generator>"Sequence Generator.exe" /reset